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Preface
This Preface provides supporting information for the Oracle Financial Services ALM Pack
Installation Guide and includes the following topics:


Summary



Audience



Documentation Accessibility



Related Documents



Conventions

Summary
You can find the latest copy of this document in OTN library which includes all the recent
additions/revisions (if any) done till date.
Before you begin the installation, ensure that you have an access to the Oracle Support Portal
with the required login credentials to quickly notify us of any issues at any stage. You can obtain
the login credentials by contacting Oracle Support.

Audience
The Oracle Financial Services ALM pack Installation and Configuration Guide is intended for
Administrators, Business User, Strategists, and Data Analyst, who are responsible for installing
and maintaining the application pack components.
The document assumes you have experience in installing Enterprise components. Basic
knowledge about the OFS ALM pack components, OFSAA Architecture, UNIX commands,
Database concepts and Web Server/ Web Application Server is recommended.
Following are the expected preparations from the administrator before starting the actual
installation:


Awareness of the OFSAA Tier Architecture. For more information, see the Application Tiers
section.



9

Decision on the appropriate OFSAA Deployment Option. For more information, refer the
Recommended Deployment Options section.

Related Documents
This section identifies additional documents related to OFS ALM Infrastructure. You can access
Oracle documentation online from Documentation Library (OTN).


Oracle Financial Services Asset Liability Management User Guide



Oracle Financial Services Asset Liability Management Analytics User Guide

Conventions and Acronyms
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Conventions

Description

AIX

Advanced Interactive executive

DEFQ

Data Entry Forms and Queries

DML

Data Manipulation Language

EAR

Enterprise Archive

EJB

Enterprise JavaBean

ERM

Enterprise Resource Management

FTP

File Transfer Protocol

GUI

Graphical User Interface

HTTPS

Hypertext Transfer Protocol Secure

J2C

J2EE Connector

J2EE

Java 2 Enterprise Edition

JDBC

Java Database Connectivity

JDK

Java Development Kit

JNDI

Java Naming and Directory Interface

JRE

Java Runtime Environment

JVM

Java Virtual Machine

1 About OFSAA and OFSAA Application Packs
This chapter includes the following topics:

1.1



About Oracle Financial Services Analytical Applications (OFSAA)



About Oracle Financial Services Analytical Applications (OFSAA) Application Pack



About Oracle Financial Services Asset Liability Management 8.0.0.0.0 Applications Pack



About Oracle Financial Services Analytical Applications Infrastructure (OFSAAI)

About Oracle Financial Services Analytical Applications (OFSAA)
In today's turbulent markets, financial institutions require a better understanding of their riskreturn, while strengthening competitive advantage and enhancing long-term customer value.
Oracle Financial Services Analytical Applications (OFSAA) enable financial institutions to
measure and meet risk adjusted performance objectives, cultivate a risk management culture
through transparency, lower the costs of compliance and regulation, and improve insight into
customer behavior.
OFSAA uses industry-leading analytical methods, shared data model and applications
architecture to enable integrated risk management, performance management, customer insight,
and compliance management. OFSAA actively incorporates risk into decision making, enables to
achieve a consistent view of performance, promote a transparent risk management culture, and
provide pervasive intelligence.
Oracle Financial Services Analytical Applications delivers a comprehensive, integrated suite of
financial services analytical applications for both banking and insurance domain.

1.2

About Oracle Financial Services Analytical Applications (OFSAA) Pack
OFSAA applications are packaged, and released as Application Packs starting from 8.0 release.
An Application Pack is a group of OFSAA products packaged together in a single installer and
addresses specific functional area via its products that are grouped together. Packaging
applications in a group ensures simplified installation, maintenance, development and integration
in an integrated deployment.
The following figure depicts the various application packs that are available across the OFSAA
Banking and Insurance domains:
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Figure 1: OFSAA Application Pack

1.3

About Oracle Financial Services Asset Liability Management 8.0.0.0.0
Applications Pack
OFS ALM 8.0.0.0.0 Pack includes the following applications:


Oracle Financial Services Analytical Applications Infrastructure: Oracle Financial
Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle Financial
Services Analytical Applications family of products to perform the processing,
categorizing, selection and manipulation of data and information needed to analyze,

12

understand and report on specific performance, risk, compliance and customer insight
issues by providing a strong foundation for the entire family of Oracle Financial Services
Analytical Applications across the domains of Risk, Performance, Compliance and
Customer Insight.


Oracle Financial Services Asset Liability Management: Oracle Financial Services
Asset Liability Management (OFS ALM) helps financial services institutions measure and
monitor interest rate risk, liquidity risk, and foreign currency risk. This solution measures
and models every loan, deposit, investment, and portfolio individually, using both
deterministic and stochastic methods. Oracle Financial Services ALM is a nextgeneration solution fully integrated with Oracle’s Financial Services Analytical
Applications and shares a common account level relational data model.



Oracle Financial Services Asset Liability Management Analytics: This application
provides timely and actionable insight for managing interest rate and liquidity risk and
provides transparency into critical issues.

1.4

About Oracle Financial Services Analytical Applications Infrastructure (OFS
AAI)
Oracle Financial Services Analytical Applications Infrastructure (OFS AAI) powers the Oracle
Financial Services Analytical Applications family of products to perform the processing,
categorizing, selection and manipulation of data and information needed to analyze, understand
and report on specific performance, risk, compliance and customer insight issues by providing a
strong foundation for the entire family of Oracle Financial Services Analytical Applications across
the domains of Risk, Performance, Compliance and Customer Insight.
Components of OFSAAI
The OFSAA Infrastructure is comprised of a set of frameworks that operates on and with the
Oracle Financial Services Analytical Applications Data Model and form the array of components
within the Infrastructure.
The OFSAA Infrastructure components/ frameworks are installed in two layers; primarily the
metadata server and Infrastructure services run on one layer, and the UI and presentation logic
runs on the other. The UI and presentation layer is deployed on any of the supported J2EE
Servers.
The following figure depicts the various frameworks and capabilities that make up the OFSAA
Infrastructure:
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OFSAA Infrastructure High Availability
The current release of the OFSAA Infrastructure supports only "Single Instance" installation for
the Infrastructure components. However, the High Availability (HA) for the Database Server and/
or the Web Application Server clustering and deployment are supported in this release.
This release supports Active-Passive model of implementation for OFSAAI components. For
more information, refer Configuration for High Availability- Best Practices Guide.
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2

Understanding OFS ALM Applications Pack Installation
This chapter includes the following topics:

15



Installation Overview



Deployment Topology



Hardware and Software Requirements



Verifying the System Environment



Understanding Installation Modes

2.1

Installation Overview

This section gives an overview of the OFS ALM Applications Pack Installation. Following figure shows the
order of procedures you need to follow:
.

Table 1: OFS ALM Applications Pack Installation Tasks and Descriptions
Tasks

Verify Systems Environment

Details and Documentation

To verify that your system meets the minimum necessary requirements
for installing and hosting the OFS ALM Application Pack, see. Verifying
System Environment.

Obtain the software

To access and download the OFS ALM Application Pack, See
Obtaining the software.

Configure and Execute the

For instructions on creating the database schemas, See Configuring

Schema Creator Utility

and Executing the Schema Creator Utility .
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Tasks

Details and Documentation

Install OFS ALM Application

For instructions on Installing OFS ALM Application Pack, See Installing

Pack

the OFS ALM Pack Installer.

Configure OFS ALM Setup

See Post Installation Configuration.

2.2

Deployment Topology
The following figure depicts the typical deployment topology implemented for OFSAA
Applications.
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2.3

Hardware and Software Requirements
This section describes the various Operating Systems, Database, Web Server, and Web
Application Server versions, and other variant details on which this release of the Oracle Financial
Services ALM Application Pack has been qualified.

Note: OFS ALM Application Pack installation can be performed on both Virtual and Physical servers.

2.3.1 Configurations supported for Java 7
The following table shows the minimum hardware and software requirements for installing OFS
ALM Application Pack (for Java 7).
Table 2: Configurations supported for Java 7

Requirement

Sub-Category

Value

Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux / Red Hat Enterprise
Linux (x86-64)

Oracle Linux Server release 6.0 and above - 64 bit
Note: Same versions of RHEL is supported

Operating
System

Oracle Solaris (SPARC)/ Solaris

Oracle Solaris v5.10 Update 11 and above - 64 bit

x86

Oracle Solaris v5.11 update 1 and above – 64 bit

IBM AIX (POWERPC)

AIX 6.1 (TL 09 and above) - 64 bit

Shell

KORN Shell (KSH)

Note:
If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, configure the size
parameter setting for "Large File Support". Follow these steps:
Change the file size limit for the user that initiates the transfer on the AIX system. To change the file size limit for a
particular user, add or edit the fsize attribute for the user in the /etc/security/limits file on the AIX system. Change the
file size limit to unlimited (fsize = -1) or to a size equal to the size of the file being transferred. This may require a
restart of the AIX server to pick up the new configuration. For more information refer IBM Support.

If the operating system is RHEL, install the package lsb_release using one of the following commands by logging in
as root user:

yum install redhat-lsb-core
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Requirement

Sub-Category

Value


yum install redhat-lsb
The above is required as during the installation process, the following command is executed to get the OS version
and release:
lsb_release -r
Based on the returned information, the installer copies the appropriate binary and library files into the
$FIC_DB_HOME/bin and $FIC_DB_HOME/lib folders.

Oracle Linux / Red Hat Enterprise

Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

Linux
Java Runtime

Oracle Solaris

Environment
IBM AIX

IBM AIX Runtime, Java Technology JRE 1.7.x - 64 bit

Oracle

Oracle Database Server Enterprise Edition 11g Release 2

Database

(11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ without

Server and

partitioning option

Client

Oracle Database Server Enterprise Edition 12c Release 1
(12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/ without
partitioning option
Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit
Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit
Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin
driver)
Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin
driver)
Oracle Distribution of R version 2.15.1, 2.15.2 or
2.15.3.(Optional)
Oracle R Enterprise (Server) version 1.4. (Optional)

Note: Ensure that the following patches are applied:



Oracle Server 12c, v12.1.0.1 – 17082699



Oracle Server 12c, v12.1.0.2 - 20698050



Also for latest information, refer http://support.oracle.com/ , 12.1.0.2 Bundle Patches
for Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID
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Requirement

Sub-Category

Value

1937782.1)



Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/
11.2.0.4/ 12.1.0.1

Oracle Hyperion Essbase

V 11.1.2.1+ (Server and Client) with Oracle 11g Database
V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP

V 11.2.0.3+ with Oracle 11g Database
V 12.1.0.1+ with Oracle 12c Database

OLAP

Note:
Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP feature of
OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle Database server with
OLAP option.

Oracle Linux / Red Hat Enterprise

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/

Linux/ IBM AIX

IBM HTTP Server

Oracle Solaris
Web Server/



Oracle WebLogic Server 12.1.2+ (64 bit)



IBM WebSphere Application Server 8.5+ with

Web

bundled IBM Java Runtime (64 bit)

Application


Server

Apache Tomcat 8.0.x (64 bit)

Note:
OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit
is not supported.

Operating System

MS Windows 7/ Windows 8/ Windows 8.1

Browser

MS Internet Explorer 9 , 10 (Compatibility Mode) and 11

Desktop
Requirements

(Compatibility Mode)
Oracle Java plug-in 1.7.0+* (64- bit)
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Requirement

Sub-Category

Value

Turn off Pop-up blocker settings. For more information, refer
Internet Explorer Settings.

Office Tools

MS Office 2007/ 2010/2013
Adobe Acrobat Reader 8 and above

Screen Resolution

1024*768 or 1280*1024

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and
Directory Services

Oracle Internet Directory v 11.1.1.3.0. However, it can be
integrated with other directory services software like MS
Active Directory.

Other Software
Note:
Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see Infrastructure LDAP Configuration. Open LDAP needs to be
installed on MS Windows Server machine only.

2.3.2 Configurations supported for Java 8
The following table shows the minimum hardware and software requirements for installing OFS
ALM Application Pack (for Java 8).
Table 3: Configurations supported for Java 8

Requirement

Sub-Category

Value

Oracle Linux Server release 5.3 up to 5.10 - 64 bit
Oracle Linux / Red Hat Enterprise
Operating

Linux (x86-64)

Oracle Linux Server release 6.0 and above - 64 bit
Note: Same versions of RHEL is supported

System

Oracle Solaris v5.10 Update 11 and above - 64 bit
Oracle Solaris (SPARC)/ Solaris x86

21

Oracle Solaris v5.11 update 1 and above – 64 bit

Requirement

Sub-Category

Value

IBM AIX (POWERPC)

AIX 6.1 (TL 09 and above) - 64 bit

Shell

KORN Shell (KSH)

Note:
If the OS is IBM AIX 6.1 and the file size limit for the AIX user on the target server is too small, configure the size
parameter setting for "Large File Support". Follow these steps:
Change the file size limit for the user that initiates the transfer on the AIX system. To change the file size limit for a
particular user, add or edit the fsize attribute for the user in the /etc/security/limits file on the AIX system. Change the
file size limit to unlimited (fsize = -1) or to a size equal to the size of the file being transferred. This may require a
restart of the AIX server to pick up the new configuration. For more information refer IBM Support.

If the operating system is RHEL, install the package lsb_release using one of the following commands by logging in
as root user:

yum install redhat-lsb-core

yum install redhat-lsb
The above is required as during the installation process, the following command is executed to get the OS version
and release:
lsb_release -r
Based on the returned information, the installer copies the appropriate binary and library files into the
$FIC_DB_HOME/bin and $FIC_DB_HOME/lib folders.

Oracle Linux / Red Hat Enterprise

Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

Linux
Java Runtime

Oracle Solaris

Environment
IBM AIX

IBM AIX Runtime, Java Technology JRE 1.8.x - 64 bit

Oracle

Oracle Database Server Enterprise Edition 11g Release

Database

2 (11.2.0.3.0 +) - 64 bit RAC/ Non-RAC with/ without

Server and

partitioning option

Client

Oracle Database Server Enterprise Edition 12c Release
1 (12.1.0.1.0 +)- 64 bit RAC/ Non-RAC with/ without
partitioning option
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Requirement

Sub-Category

Value

Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit
Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit
Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle
thin driver)
Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle
thin driver)
Oracle Distribution of R version 2.15.1, 2.15.2 or
2.15.3.(Optional)
Oracle R Enterprise (Server) version 1.4. (Optional)

Note: Ensure that the following patches are applied:



Oracle Server 12c, v12.1.0.1 – 17082699



Oracle Server 12c, v12.1.0.2 - 20698050



Also for latest information, refer http://support.oracle.com/ , 12.1.0.2 Bundle Patches
for Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID
1937782.1)



Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/
11.2.0.4/ 12.1.0.1

Oracle Hyperion Essbase

V 11.1.2.1+ (Server and Client) with Oracle 11g
Database
V 11.1.2.3+ (Server and Client) with Oracle 12c
Database

Oracle OLAP

V 11.2.0.3+ with Oracle 11g Database

OLAP
V 12.1.0.1+ with Oracle 12c Database

Note:
Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP feature of
OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle Database server with
OLAP option.
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Requirement

Sub-Category

Value

Oracle Linux / Red Hat Enterprise Linux

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server

/IBM AIX/

2.2.x/ IBM HTTP Server

Oracle Solaris

Oracle 11g and 12c Database:

Web Server/
Web



Application



Oracle WebLogic Server 12.1.3+ (64 bit)



Apache Tomcat 8.0.x (64 bit)

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is
not available.

Server

Note:
OFSAA Infrastructure web component deployment on Oracle WebLogic Server with Oracle JRockit
is not supported.
For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install
patch 18729264 from http://support.oracle.com/

Operating System

MS Windows 7/ Windows 8/ Windows 8.1

Browser

MS Internet Explorer 9 , 10 (Compatibility Mode) and 11
(Compatibility Mode)
Oracle Java plug-in 1.7.0+* (64- bit)

Desktop

Turn off Pop-up blocker settings. For more information,

Requirements

refer Internet Explorer Settings

Office Tools

MS Office 2007/ 2010/2013
Adobe Acrobat Reader 8 and above

Screen Resolution

1024*768 or 1280*1024

OFSAAI is qualified on both OPEN LDAP 2.2.29+ and
Other Software

Directory Services

Oracle Internet Directory v 11.1.1.3.0. However, it can be
integrated with other directory services software like MS
Active Directory.
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Requirement

Sub-Category

Value

Note:
Configuration of Directory services software for OFSAAI installation is optional. For more
information on configuration, see Infrastructure LDAP Configuration.
Open LDAP needs to be installed on MS Windows Server machine only.

Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, refer Appendix Q.
OFS ALM Application Pack recommends the following software combinations for deployment:
Table 4: Recommended software combinations
Operating System

Database

Oracle Linux 5.3 up to
5.8/ 6.0 and above

Oracle
Database

Web Application Server

Oracle WebLogic Server/

Web Server
Oracle HTTP Server/
Apache HTTP Server

Apache Tomcat Server

2.4

Oracle Solaris 5.10/
5.11

Oracle
Database

IBM AIX 5.3/ 6.1

Oracle
Database

Oracle WebLogic Server/
Apache Tomcat Server

Oracle HTTP Server/
Apache HTTP Server

IBM WebSphere
IBM HTTP Server/
Application Server/ Apache Apache HTTP Server
Tomcat Server

Verifying the System Environment
To verify if your system environment meets the minimum requirements for the installation, a PreInstall Check utility (Environment Check) is available within the Install Kit archive file. This utility
can also be obtained separately by contacting Oracle Support.
Though the system environment verification is an integral and automated part of the installation of
this software product, Oracle strongly recommends running this utility prior to beginning the
installation as part of your organization’s "Installation Readiness Verification Process".

NOTE:

For more details on download and usage of this utility, see Oracle Financial Services
Analytical Applications Infrastructure Environment Check Utility Guide given in the Related
Documents section.
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2.5

Understanding Installation Modes
The following modes of installation are available for the OFS ALM Application Pack.

2.5.1 GUI Mode
This mode launches the product installation in a Graphical User Interface (GUI) Mode. You
need to enter the required information on various panels within the UI in a user interaction format
at various stages.

2.5.2 Silent Mode
This mode mandates updating the installation configuration files with required details and
performs installation in a “Silent” non user interactive format.
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3

Preparing for Installation
This chapter provides necessary information to review before installing the OFS ALM Pack
v8.0.0.0.0.
This chapter includes the following topics:

3.1



Installer and Installation Prerequisites



Obtaining the Software



Common Installation Activities

Installer and Installation Prerequisites
The following table mentions the list of prerequisites required before beginning the installation for
OFS ALM Application Pack. The Installer/ Environment Check utility notifies you if any
requirements are not met.
Installer and Installation Prerequisites

Requirement

Sub-Category
Java Settings

Expected Value
PATH in .profile to be set to include the Java
Runtime Environment absolute path. The path should
include java version (java 7 or java 8) based on the
configuration.
Note: Ensure the absolute path to JRE/bin is set at the
beginning of PATH variable.
For example,
PATH=/usr/java/jre1.7/bin:$ORACLE_HOME/b
in:$PATH

Environment Settings

Ensure no SYMBOLIC links to JAVA installation is
being set in the PATH variable.
Oracle
Settings

Database

TNS_ADMIN to be set in .profile pointing to
appropriate tnsnames.ora file
ORACLE_HOME to be set in .profile pointing to
appropriate Oracle Client installation
PATH in .profile to be set to include appropriate
$ORACLE_HOME/bin path.
Ensure to add an entry (with SID/ SERVICE NAME) in
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Requirement

Sub-Category

Expected Value
the tnsnames.ora file on the OFSAA server.

Oracle

Essbase

Settings

ARBORPATH, ESSBASEPATH, HYPERION_HOME
to be set in the .profile pointing to an appropriate
Oracle Essbase Client installation.
Note: These settings are required only if you want to
use Oracle Hyperion Essbase OLAP features.

File Descriptor
Settings

Greater than 15000
Note: The value specified here is the minimum value
to be set for the Installation process to go forward. For
other modules, this value may depend on the available
resources and the number of processes.

Total Number of
Process Settings

Greater than 4096
Note: The value specified here is the minimum value
to be set for the Installation process to go forward. For
other modules, this value may depend on the available
resources and the number of processes executed in
parallel.

OS/ File System

Port Settings

Default port numbers to be enabled on the system are
6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, and

Settings

10101.
.profile

User to have 755 permission on the .profile file.

permissions
Installation

A directory where the product files will be installed/

Directory

copied.
Set 755 permission on this directory.
This directory needs to be set as FIC_HOME.

Temporary

Default temporary directory where installation files are

Directory

stored for a short period of time to support faster
installation.


For

installation

on

UNIX

OS,

your

UNIX

administrator must give you the required read-
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Requirement

Sub-Category

Expected Value
write permissions for the Orac directory and
disable the NOEXEC option


Configure adequate space on the /tmp directory.
It is recommended that you allocate more than 10
GB of space.

Note: If NOEXEC is enabled, the extraction of files by
the installer into the /tmp directory is prevented and
the binaries will not execute in the directory, which will
fail the installation.
Staging Area/

A directory to hold the application metadata artifacts

Metadata

and additionally act as staging area for flat files.

Repository

The directory should exist on the same system as the
OFSAA Installation. This directory can be configured
on different mount or under a different user profile.
Set 777 permission on this directory.

Download

A directory where the product installer files will be

Directory

downloaded/ copied.
Set 755 permission on this director.

OS Locale



Linux: en_US.utf8



AIX: EN_US.UTF-8



Solaris: en_US.UTF-8

To check the locale installed, execute the following
command:
locale -a | grep -i 'en_US.utf'
Database Settings

Database Instance
Settings

NLS_CHARACTERSET to be AL32UTF8
NLS_LENGTH_SEMANTICS to be BYTE
OPEN CURSORS limit to be greater than 1000
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Requirement
Web Application Server

Sub-Category

Expected Value

WebSphere/

Web Application Server should be installed and profile

WebLogic/

/domain created.

Tomcat

You will be prompted to enter the WebSphere Profile
path or WebLogic Domain path or Tomcat Deployment
path during OFSAAI installation.
Note: Refer Appendix A for WebSphere Profile
Creation and WebLogic Domain Creation.
For deployment on Oracle WebLogic Server 12.1.3+
(64 bit) with Java 8, download and install patch
18729264 from http://support.oracle.com/

Web Server

Apache HTTP

This is an optional requirement.

Server/

HTTP Server Installation to be present.

Oracle HTTP

You will be required to enter the Web Server IP/

Server/

Hostname and Port details during installation.

IBM HTTP Server
Others

Note: Refer Appendix A for Web Server installation.

Oracle R/ Oracle

This is an optional requirement.

R Enterprise

Refer section Installation of Oracle R distribution and
Oracle R Enterprise (ORE) for more details.

OFSAA

OFSAAI

One-off



For installation on Java 8, login to
http://support.oracle.com/ and search for
21160684 under the Patches & Updates tab. This
is applicable only when you have installed
8.0.0.0.0 OFSAAI pack and not required for
8.0.0.1.0.
 For installation of this release on an existing
OFSAA instance where the underlying OFSAA
Infrastructure (OFS AAI) version is upgraded to
version 8.0.1.0.0, login to
http://support.oracle.com/ and search for
21133780 under the Patches and Updates tab.
 For installation of this release on an existing
OFSAA instance where the underlying OFSAA
Infrastructure (OFS AAI) version is upgraded to
version 8.0.2.0.0, login to
http://support.oracle.com/ and search for
21657319 under the Patches and Updates tab.
Download the consolidated one-off patch 25777667
from https://support.oracle.com/.

NOTE: Ensure that the tablespace(s) used for the database user(s) is set to AUTOEXTEND ON.
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3.2

Obtaining the Software
This release of OFS ALM Application Pack v8.0.0.0.0 can be downloaded from the Oracle
Software Delivery Cloud (https://edelivery.oracle.com). You need to have a valid
Oracle account in order to download the software.

3.3

Common Installation Tasks
The following are the common pre-installation activities that you need to carry out before installing
the OFS ALM Application Pack.
This section includes the following topics:


Configuration for GUI Mode Installation



Identifying the Installation, Download and Metadata Repository Directories



Download and copy the OFS ALM Application Pack Installer



Copying and Extracting the Software



Setting up the Web Server/ Web Application Server



Installation for Oracle R distribution and Oracle R Enterprise (ORE)

3.3.1 Configuration for GUI Mode Installation
To install OFS ALM Application Pack in GUI mode, you need to ensure the following software and
configurations are available:


Install and configure any PC X Server software such as Open Text Exceed (formerly
Hummingbird Exceed) on the user desktop system from which the installation is triggered.
Configure DISPLAY variable.



Ensure to set the DISPLAY variable on the system on which the OFSAA will be installed, to
point to the user desktop system where the PC X Server software has been installed.
Syntax:
export DISPLAY=hostname:n.n1
where hostname is the IP Address/ Host Name of the user desktop system and n is the
sequence number (usually 0).
For example, 10.11.12.13:0.0 or myhostname:0.0

3.3.2 Identifying the Installation, Download and Metadata Repository Directories
For installation of any OFSAA Application Pack, the following folders/ directories required to be
created.
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OFSAA Download Directory (Optional) - Create a download directory and copy the
OFSAA Application Pack Installer File (Archive).

This is the directory where the

downloaded installer/ patches can be copied.


OFSAA Installation Directory (Mandatory) – Create an installation directory. This is the
directory where the installer installs or copies the product files. FIC_HOME variable to be
set in the .profile pointing to this OFSAA Installation Directory.



OFSAA Staging/ Metadata Repository Directory (Mandatory) – Create a Staging/
Metadata Repository Directory. This is the directory where you should copy data loading
files, save data extracts and so on. Additionally, this folder also maintains the OFSAA
metadata artifacts. This is commonly referred as "FTPSHARE".

NOTE:

Ensure the user permission is set to 755 on the Installation and Download Directory.
Ensure the user permission is set to 777 on the Staging Directory.
Ensure the OFSAA staging directory is not set to the same path as the OFSAA installation
directory and is not a sub-folder inside the OFSAA installation directory.

3.3.3 Download and copy the OFS ALM Applications Pack Installer
To download and copy the OFS ALM Applications Pack Installer, follow these steps:


To download the OFS ALM Application Pack, you need to login to the Oracle Software
Delivery Cloud (https://edelivery.oracle.com). You need to have a valid Oracle account in
order to download the software.



Copy the downloaded installer archive to the Download Directory (in Binary Mode) on the
setup identified for OFSAA installation.

3.3.4 Copying and Extracting the Software
Once you obtain the installer, copy the installer (in BINARY mode) to the system on which the
OFSAA Infrastructure components will be installed.
NOTE:

You must be logged in to the UNIX operating system as a non-root user.
1. Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode to
the directory that is included in your PATH variable. If you already have the unzip
utility to extract the contents of the downloaded archive, skip to the next step.
2. Uncompress the unzip installer file using the command:
uncompress unzip_<os>.Z
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NOTE:

In case you notice an error message "uncompress: not found [No such file or directory]" when
the package is not installed, contact your UNIX administrator.
3. Give EXECUTE permission to the file using the command:
chmod 751 unzip_<os>
For example, chmod 751 unzip_sparc
4. Extract the contents of the Oracle Financial Services Advanced Analytical Applications
Infrastructure Application Pack 8.0.0.0.0 to Download Directory using the following
command:
unzip OFS_ALM_PACK.zip

NOTE:

DO NOT rename the Application Pack installer folder name on extraction from the archive.
5. Give following permission to the installer folder. Navigate to the Download Directory
and execute the command:
chmod –R 755 OFS_ALM_PACK

3.3.5 Setting up the Web Server/ Web Application Server
For setting up the environment based on your selected Web Server/ Web Application Server,
refer to Appendix A for more information.

3.3.6 Installation of Oracle R distribution and Oracle R Enterprise (ORE)
This is an optional step and required only if you intend to use Oracle R scripting in the Oracle
Financial Services Enterprise Modeling Application. Follow these steps:
Install Oracle R Distribution and Oracle R Enterprise (Server Components) on the Oracle
Database server. See Oracle® R Enterprise Installation and Administration Guide for
Windows, Linux, Solaris and AIX, Release 1.4 at Oracle R Enterprise Documentation
Library.

NOTE:



Oracle R Distribution versions supported- Oracle Distribution of R version 3.0.1.



ORE version supported- Oracle R Enterprise (Server) version 1.4.

Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/
12.1.0.1.

NOTE:

If you are using ORE 1.4.1 and Oracle R 3.1.1 with Oracle Financial Services Enterprise
Modeling, you need to set the session timezone in 'R_HOME/etc/Rprofile.site’ file on the
database server, where R_HOME is the home directory of the R instance on which ORE
server packages are installed. Alternatively, you may set session timezone in scripts
registered within OFS EM by using the 'Sys.env(TZ=<time zone>)’ R function.
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4

Installing OFS ALM Application Pack
This chapter describes the steps to be followed to install the OFS ALM pack.
This chapter includes the following sections:

4.1



Schema Creator Utility



Configuring and Executing the Schema Creator Utility



Installing the OFS ALM Applications Pack

Schema creator utility
Creating database users/ schemas is one of the primary steps in the complete OFSAA
installation. This release of OFSAA provides a utility to quickly get started with the OFSAA 8.0
installation by allowing easier and faster creation of database User(s)/ Schema(s), assign the
necessary GRANT(s) and so on. Additionally, it also creates the required database objects in
these schemas.
This section includes the following topics:


About Schema Creator utility



Execution Modes in Schema Creator Utility



Execution Options in Schema Creator Utility

4.1.1 About Schema Creator utility
The schema creator utility should be configured and executed mandatorily every time prior to
installation of any OFSAA Application Pack.
The following are the types of schemas that can be configured in the OFSAA:


CONFIG – Denotes the unique OFSAA setup configuration schema. It contains entities and
other objects required for OFSAA setup information.

NOTE: There can be only one CONFIG schema per OFSAA instance.


ATOMIC – Denotes the schema that contains the data model entities. One ATOMIC
schema is attached to one Information Domain.

NOTE: For some application packs there can be multiple ATOMIC schemas per OFSAA Instance, but
the ALM Application Pack supports only one atomic schema per OFSAA instance.


SANDBOX – Denotes the schema that contains the data for all Sandbox executions. One
SANDBOX schema is attached to one Sandbox Information Domain.
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NOTE: This Schema type is not applicable for OFS ALM Application Pack. There can be multiple
SANDBOX schemas per OFSAA Instance and a Sandbox Information Domain can have only one
SANDBOX schema.


ADDON – Denotes any additional schema used by the OFSAA Applications.

NOTE: This Schema type is not applicable for OFS ALM Application Pack.

4.1.2 Execution Modes in Schema Creator Utility
The Schema Configuration Utility supports the following two modes of execution:


Online Mode: In the Online mode, the utility connects to the database and executes the
DDLs for Users, Objects and Grants. If you have the SYSDBA privileges you can
execute the Schema Creator Utility in Online mode and thereby create the Users,
Objects and Grants during the execution process.

NOTE: To execute the utility in Online mode, you need to connect as “<User> AS SYSDBA”.


Offline Mode: In the Offline mode, the utility generates SQL script with all the required
DDLs for Users, Objects and Grants. This script needs to be executed by the DBA on
the appropriate database identified for OFSAA usage. If you do not have the SYSDBA
privileges, you can execute the Schema Creator Utility in Offline mode and generate
the script file that contains the Schemas, Objects and Grants, information.
Subsequently, a SYSDBA user can execute the script file manually.

NOTE: To execute the utility in Offline mode, you need to connect as any user with following
grants(alternatively, you can also connect as a user with SYSDBA privileges):
SELECT ON DBA_ROLES
SELECT ON DBA_USERS
SELECT ON DBA_DIRECTORIES
SELECT ON DBA_TABLESPACES
CREATE SESSION
For more details refer, Executing the Schema Creator Utility in Offline Mode
If there are any errors during the script execution, reconfigure the OFS_ALM_SCHEMA_IN.XML
file and execute the utility. This regenerates the scripts with corrected information. For more
information, refer Configuring OFS_ALM_SCHEMA_IN.XML file.

NOTE: Do not modify the OFS_ALM_SCHEMA_OUT.XML file generated after the execution of this utility.
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4.1.3 Execution Options in Schema Creator Utility
Depending on the option you choose to run the OFSAA Application Pack Installer, you need to
choose the schema creator utility execution option. To run the OFSAA Application Pack installer
in SILENT mode, it is mandatory to execute the schema creator utility with –s option.
NOTE: If the schema creator utility is executed without the option –s, it is mandatory to run the OFSAA
Application Pack Installer in GUI mode.
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4.2

Configuring and Executing the Schema Creator Utility
This section includes the following topics:


Prerequisites



Configuring the Schema Creator Utility



Executing the Schema Creator Utility

4.2.1 Prerequisites
The following prerequisites must be ensured before configuring the Schema Creator Utility:


You must have the Oracle User ID/Password with SYSDBA privileges.



You must have the JDBC Connection URL for RAC/Non RAC database.



The HOSTNAME/IP of the server on which OFSAA is getting installed.



For Java 8, navigate to OFS_ALM_PACK/bin/ and modify the value for property
JAVA_VERSION to 1.8 in the VerInfo.txt file and save the changes.

Note:

If this release of the OFS ALM Application Pack version 8.0.0.0.0 is being installed on an OFSAA
setup where the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to version
8.0.1.x.x, download and install the patch for schema creator utility (Bug 21133780 ) by following
the instructions in the Readme.txt packaged in it prior to executing the utility.
If this release of the OFS ALM Application Pack version 8.0.0.0.0 is being installed on an OFSAA
setup where the underlying OFSAA Infrastructure (OFS AAI) version is upgraded to version
8.0.2.x.x, download and install the patch for schema creator utility (Bug 21657319) by following
the instructions in the Readme.txt packaged in it prior to executing the utility.


The following configuration is required only if you intend to use Oracle Linux/Red Hat
Enterprise Linux v7.x for OFSAAI 8.0.4.0.0 version.
For Oracle Linux/RHEL 7.x, navigate to OFS_ALM_PACK/bin/ and modify the value for
property Linux_VERSION to include 7 in the VerInfo.txt file and save the changes.
For example, Linux_VERSION=5,6,7



For IBM AIX 7.1, navigate to OFS_ALM_PACK/bin/ and modify the value for property
AIX_VERSION to include 7.1 in the VerInfo.txt file and save the changes.
For example, AIX_VERSION=6.1,7.1

4.2.2 Configuring the Schema Creator Utility
To configure the Schema Creator Utility, follow these steps:
1. Log in to the system as non-root user.
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2. Navigate to the following path: OFS_ALM_PACK/schema_creator/conf.
3. Edit the OFS_ALM_SCHEMA_IN.xml file in a text editor.
4. Configure the elements as described in the section Configuring
OFS_ALM_SCHEMA_IN.XML
5. Save the OFS_ALM_SCHEMA_IN.xml file.

4.2.3 Executing the Schema Creator Utility
This section includes the following topics:


Executing the Schema Creator Utility in Online Mode



Executing the Schema Creator Utility in Offline Mode



Executing the Schema Creator Utility with –s option

NOTE: If you intend to use Oracle OLAP feature, execute the following grant on all ATOMIC schema(s)
grant olap_user to &database_username

4.2.3.1

Executing the Schema Creator Utility in Online Mode
In Online Mode, the Schema Creator Utility will create all the Schemas, Schema Objects,
Tablespaces, Grants, and Roles in the database during the execution process.
To execute the Schema Creator Utility in Online Mode, follow these steps:
1. Log in to the system as non-root user.
2. Navigate to the following folder path: OFS_ALM_PACK/schema_creator/bin/
3. Execute the following command.
./osc.sh
4. The following message is displayed: You have chosen ONLINE mode. Triggering the
utility in ONLINE mode will execute the DDLs directly on the Database. Do you wish to
proceed? (Y/y or N/n).
5. Enter Y/y to proceed.
6. Enter the DB Username with SYSDBA Privileges.
For example: SYS as SYSDBA.
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7. Enter the User Password.

8. The console runs the initial validation checks and then displays the following message:
You have chosen to install this Application Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).
You have chosen to install this Application Pack on <Name of the Infodom>. Do you
want to proceed? (Y/N).

9. Enter Y/y to start the schema creation.
Or
Enter N/n if you want to quit executing the schema creation.
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NOTE:

On successful execution of schema creator utility, the console displays the following status
message:
Schema Creator executed successfully. Please proceed with the installation.
Refer log file in OFS_ALM_PACK/schema_creator/logs folder for execution status. In case
of any errors, contact Oracle Support.

4.2.3.2

Executing the Schema Creator Utility in Offline Mode
In Offline Mode, the Schema Creator Utility will create an output in SQL file format. This script has
to be executed manually by logging as database user with SYSDBA privileges. The SQL file will
contain the scripts for creation of Schemas, Schema Objects, Tablespaces, Grants, and Roles.
Prerequisites:


Database user with following privileges:


SELECT ON DBA_ROLES



SELECT ON DBA_USERS



SELECT ON DBA_DIRECTORIES



SELECT ON DBA_TABLESPACES



CREATE SESSION

NOTE: Explicit Grants to the user are required. Grants assigned through Roles are not
supported.
To execute the schema creator utility in the offline mode, follow these steps:
1. Log in to the system as non-root user.
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2. Navigate to the following path: OFS_ALM_PACK/schema_creator/bin
3. Execute the osc.sh file using the following command:
./osc.sh –o
4. The following message is displayed:
You have chosen OFFLINE mode. Triggering the utility in OFFLINE mode will generate
the script. Do you wish to proceed? (Y/y or N/n).
5. Enter Y/y to proceed.
6.

Enter the DB Username with SELECT privileges.

7. Enter the User Password.

8. The console runs the initial validation checks and displays the following message:
You have chosen to install this Application Pack on <Name of the Atomic
Schema>ATOMIC schema. Do you want to proceed? (Y/N).
You have chosen to install this Application Pack on <Name of the Infodom>. Do you
want to proceed? (Y/N).
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9. Enter Y/y to start the script generation.
Or
Enter N/n if you want to quit the script generation.

NOTE:

On successful execution of schema creator utility, the console displays the following status
message:
Schema Creator executed successfully. Please execute
scratch/ofsaaapp/OFS_ALM_PACK/schema_creator/sysdba_output_scripts.sq
l before proceeding with the installation.
10. Navigate to the directory: OFS_ALM_PACK/schema_creator.
11. Login to SQLPLUS with a user having SYSDBA Privileges.
12. Execute the sysdba_output_scripts.sql file using the following command:
SQL>@sysdba_output_scripts.sql
Alternatively, you can copy the sysdba_output_scripts.sql file and
SQLScripts folder to a remote server and execute sysdba_output_scripts.sql
file, after providing appropriate execute permissions.

NOTE:

Refer log sysdba_output_scripts.log file for execution status. In case of any errors,
contact Oracle Support. This log would be empty if there are no errors in the execution.

4.2.3.3

Executing the Schema Creator Utility with –s option
If you want to run the OFSAA Application Pack Installer in SILENT mode, it is mandatory to
execute the schema creator utility with –s option.
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To execute the utility with –s option, follow these steps:
1. Edit the file OFS_ALM_PACK/schema_creator/conf/OFS_ALM_SCHEMA_IN.xml in
text editor.
2. Set the value for attribute “INFODOM” of <SCHEMA> tag(s) to specify a specific
Information Domain name. By default, the value is empty and the utility will derive the
Information Domain name. If the attribute value is set, the utility/ installer will configure
the Information Domain against this <SCHEMA>.
3. Execute the utility with –s option.
For Example: ./osc.sh –s.
If the utility is executed without the –s option, it is mandatory to launch the OFSAA Application

NOTE:

Pack Installer in GUI mode.

NOTE:

4.3

To execute the utility in OFFLINE mode with SILENT option, enter following command:
/osc.sh –o –s.

Installing the OFS ALM Application Pack
Follow the instructions in this section to install the OFS ALM Application Pack depending on the
mode of installation.
This section includes the following topics:


GUI Mode Installation



SILENT Mode Installation



Verifying the Log File

4.3.1 GUI Mode Installation
Note: Ensure you have followed the steps as mentioned in the Configuration for GUI Mode Installation
section prior to proceeding with the next steps.
1. Log in to the system as non-root user.
2. Identify a directory for installation and set the same in the user .profile file as below:
ORACLE_HOME=<oracle_installed_dir>
TNS_ADMIN=$ORACLE_HOME/network/admin export TNS_ADMIN
FIC_HOME=<ofsaa_install_dir>
3. Execute the user .profile.
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4. Navigate to path: OFS_ALM_Pack.
5. Edit the OFS_ALM_PACK/schema_creator/conf/OFS_ALM_SCHEMA_IN.xml file to set
the appropriate attribute values.
Note: Refer Configuring <<APP Pack>>_SCHEMA_IN.XML file for details on configuring
this XML file.
6. Execute the schema creator utility.
Note: This step is mandatory and should be executed before every OFSAA Application
Pack installation.
Refer Executing the Schema Creator Utility for more details.

7. Navigate to the path: OFS_ALM_PACK/bin.
8. Execute ./setup.sh GUI in the console.

Figure 2 Validating the Installation
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Figure 3 Initialization Window

Figure 4 License Agreement

9. Select I accept the terms if the License Agreement option.
10. Click Next.
The Application Pack details are displayed:
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Figure 5 Application Pack Details

11. Select the product to enable for which you have already obtained license.
12. Click Next. The License Agreement page is displayed. Select I accept the terms if the
License Agreement option.

Figure 6 OFSALM License Agreement

13. The Pre Installation Summary window is displayed.
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14. Click Next.
The Manage Information Domain page is displayed.

Figure 7 Information Domain

15. Edit the Information Domain Name if it is a new Information domain and you wish to
change the name of the information domain name.
In case of subsequent Application Pack installation on the same Information Domain, the
Information Domain Name is not editable.
Permissible length is 10 characters and only alphanumeric characters allowed. No
special characters allowed.
16. Click Next.

49

17. Click Next. OFSAA Infrastructure details are displayed in the following figure.

Figure 8 OFSAA Infrastructure Server Details

18. Click Next to view the Web Application Server details.
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Figure 9 Web Application Server Type

19. Select the web application server type and Click Next.

Figure 10 Tomcat Path

20. Enter the Tomcat installation path and Click Next.
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Figure 11 OLAP Details

21. Enter the OLAP details and click Next.

Figure 12 Web Server Details

22. By default, ENABLE HTTPS is selected. If you want to install without HTTPS enabled,
click the checkbox to remove the selection and proceed with the installation. Enter the
Web Server (HTTP Server) Port, Context name for deployment, and Local path to any
folder on the Web Application Server (Tomcat/Websphere/Weblogic).
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Figure 13 Database Details

23. Enter Oracle SID/Service Name, JDBC URL, Configuration Schema User ID and
Password, and Absolute Driver Path.
Note: Absolute Driver Path can be the path where Oracle DB client is installed or JDBC driver is installed.
For example, /scratch/oracle/app/oracle/product/11.2.0/client_1/jdbc/lib
24. Click Next. The Ports Configuration window is displayed.

Figure 14 Ports Configuration
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25. Enter Java Port, Native Port, Agent Port, ICC Server Port, and ICC Native Port. You
can proceed with the default port values configured.
26. Click Next. The Ports Configuration window is displayed.

Figure 15 Ports Configuration_1

27. Enter OLAP Port, Message Server Port, Router Port, and AM Port.
28. Click Next. The Default Infrastructure Administrator and Authorizer User Password
window is displayed.

Figure 16 Administrator and Authorizer User Password
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29. Enter the passwords for default System Administrator and System Authorizer users.
30. Click Next. The SFTP Details window is displayed.

Figure 17 SFTP Details

31. Enter 1 to enable SFTP or 0 to enable FTP.
Note: Ensure the system on which the OFSAA Infrastructure is being installed, has either FTP/ SFTP
enabled.
32. Enter the port to be used for file transfer.
33. Click Next. The OFSAAI Post Install Details window is displayed.
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Figure 18 OFSAAI Post Install Details

34. Enter the path of the ftpshare directory and the User Id and password for OFSAAI
Server.
Note: The transfer of data (files) between the OFSAAI Server and the Web Application Server happens
over FTP/ SFTP. Ensure the necessary host configurations are made for a successful handshake.
35. Click Next. The Sample Application Installation window is displayed.

Figure 19 Pre Installation Summary

56

36. Click Install. The Installing OFSAA Infrastructure window is displayed.

Figure 20 Installing OFSAAI Infrastructure

Anytime during the installation you can click Cancel to stop the installation. Once
completed, the Installation Summary screen is displayed.

Figure 21 Installation Summary

The Summary screen displays the number of Fatal Errors, Errors, Debug Statements,
Information, and Warnings along with the location of log files.
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37. Click Next. The Installation Complete window is displayed.

Figure 22 Installation Completed with Warnings

Note: If the installation is successful with some warnings, you can navigate to the installation log for more
details and address them.
38. Click Done.

Upon invoking the installer, the Introduction screen is displayed with the prerequisites for
installation. Ensure that all the prerequisites are met before you proceed with the installation.
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Figure 23 Solution Setup Introduction

39. Click Next
Choose the log mode for this installer. If Debug is selected, the Passwords will be printed
in the log file.
40. Click Next to proceed.

Figure 24 Log Mode
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41. Click Next.

Figure 25 Pre-Setup Information

Create a new information domain by entering the Asset Liability Management Segment,
Tablespace, Application Server ftpshare log path and Database server ftpshare log path.
Permissible length for information domain is maximum 10 characters and only
alphanumeric characters allowed. No special characters allowed.
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Figure 26 Pre-Infodom Creation Summary

42. Click Next.

Figure 27 Please Wait

43. Enter the Tablespace name and click Next.

Figure 28 Model Upload Confirmation

Confirm whether you want to perform the Model upload.
44. Click Next.
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Figure 29 Customizing Data Model

If the option Customized Data Model was chosen, the following panel is displayed
prompting the user to select the customized data model located in the machine.Choose
the customized data model file from the server.

Note:

If you have installed an application pack (for example PFT) and performed the data model

customization, then you should merge the data model before installing another application pack (for
example ALM).
If the data model merge is not performed before installing second pack, then data model customization
changes will be lost.

45. Click Next.
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Figure 30 Please Wait

The following panel displays pre-model upload details.
Verify the details before proceeding to the next step.
46. Click Next.
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Figure 31 Pre-Model Upload Summary

47. Click Next to proceed for model upload.
This process will take some time depending on the size of the data model and available
physical memory in the environment. You will not be able to take any further action on the
screen, until the model upload is complete. Note that this process cannot be rolled back.
If the model upload fails, then a pop-up message with relevant error and the log file path
is displayed.
Review errors and take relevant action. Continue with this step until the model upload is
successful and the installer takes you to next step.
Few common errors during model upload are:
o

Insufficient heap memory on the client machine.

o

Possible reason/resolution: The java memory settings in “startofsaai.sh” located in
$FIC_APP_HOME/common/FICServer/bin directory should be increased.

o

Error while getting the Erwin File path.

o

Possible reason/resolution: Restart the FICServer.

o

Error in Upload Operation: “FAILED WHILE SUPER CATEGORY - SUB CATEGORY
RELATIONS HANDLINGDELETING”.

o

Possible reason/resolution: Incorrect Erwin.xsl file version in
$FIC_APP_HOME/common/FICServer/conf directory.

Note: Incremental/Sliced model upload might give errors if there are NOT NULL columns being added to
a table that already has rows or if the columns that are being dropped have values. Check the data model
changes excel file for any such cases. In such a case, take a backup of the table and truncate the table.
Insert records back into the table with a default value for the NOT NULL column.
Navigate to the previous screen and proceed with the steps mentioned above.
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Figure 32 Uploading Data Model

The data model is getting uploaded.
48. Click Next.

Figure 33 Oracle Business Intelligence Configuration
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The Pre Setup Information screen requests for setup information.
The following panel seeks input from the user on whether to create new ETL
application/source pair or use an existing one.
Choose a desired option.

49. Click Next to continue.

Figure 34 Selecting the Application

If the option New application/source pair was chosen then the following panel is
displayed seeking the application and source name for creation of the same.
Specify all the details required for application and source creation.
50. Click Next to proceed.
This will create application and source within OFSAAI. Source model will also be
generated. This process will take some time depending on the number of entities /
attributes in the atomic schema. This step cannot be rolled back.
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Figure 35 ETL Details

This panel displays all the pre-installation summary. Verify all details and proceed.
51. Click Install to proceed. A message-box is displayed. Click yes to continue.

Figure 36 Pre-Install Summary

This panel displays the installation process. Wait until it completes.
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Figure 37 Installation in Progress

The following screen displays the completion of installation of the Oracle Financial
Services Asset Liability Management Analytics Product Setup.
52. Click Done to exit.

Figure 38 Install Complete
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Figure 39 Installation Summary

Note: The installation process continues on the console. Do not close the console until the installation
process is complete.
Post Install Health checks are displayed:

Figure 40 Installation Complete

Note:
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Access Manager Component (am executable) creates Semaphore on AIX, so
whenever rmipc.sh script is run as a result, it would remove existing Semaphores
and Shared Memory which in turn results killing “am” due to inaccessibility of
Semaphores created by “am”. In such case, user should check and re-run “am” post
executing rmipc.sh script, if it is killed.

rmipc.sh is a Semaphore/Shared Memory cleanup memory that checks the existence
for Semaphore/Shared Memory and cleaning them, if it is there. It is mandatory NOT to
include this script as part of a batch execution.
53. Install the consolidated one-off patch 25777667. Refer to the Readme available with
the patch for further instructions on installing the patch.
54. Perform steps mentioned in the Post Installation Configuration section.
Note: Download and install patch for Bug 21160684 if installing this release of the OFS ALM Application
Pack version 8.0.0.0.0 on Java 8.

4.3.2 SILENT Mode Installation
In the SILENT Mode Installation you must configure the product xml files and follow the
instructions in command prompt.
Follow these steps for installing the OFS ALM Pack in SILENT mode.
1. Log in to the system as non-root user.
2. Identify a directory for installation and set the same in the user .profile file as
below:
FIC_HOME=< OFSAA Installation Directory >
export FIC_HOME
3. Execute the user .profile.
4. Navigate to OFS_ALM_PACK folder.
5. Edit the OFS_ALM_PACK/conf/OFS_ALM_PACK.xml to enable the product licenses.
Update the attribute ENABLE=YES/NO in OFS_ALM_pack.xml for licensing the App
in the pack.
NOTE:

Refer Configuring OFS_ALM_PACK.XML for details on configuring this XML file.

NOTE:

Update OFS_ALM_PACK.XML, set the attribute “ENABLE=YES” of <APP_ID> tag for
applications to be enabled during installation. If any application has mentioned OFS_ALM as
PREREQ in the <APP_ID> tag, set the attribute “ENABLE=YES” for OFS_ALM.
6. Edit the OFS_ALM_PACK/schema_creator/conf/OFS_ALM_SCHEMA_IN.xml file
to set the appropriate attribute values. Include INFODOM = “<Infodom Name>” in
OFS_ALM_SCHEMA_IN.xml file.

NOTE:

Refer Configuring OFS_ALM_SCHEMA_IN.XML for details on configuring this XML file.
7. Edit the OFS_ALM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml file to set
the appropriate infrastructure installation attribute values.
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NOTE:

This step can be ignored if an installation of OFSAA 8.0 already exists.
Refer Configuring OFSAAI_InstallConfig.xml for details on configuring this XML file.
8. Execute the schema creator utility.

NOTE:

This step is mandatory and should be executed before every additional OFSAA Application
Pack installation. Ensure the execute with –s option in Online/Offline mode.
Refer Executing the Schema Creator Utility for more details.

9. On successful execution of the schema creator utility, navigate to
OFS_ALM_PACK/bin/ and execute the application pack installer with SILENT option.
10. Execute ./setup.sh SILENT in the console.
11. Enter the Infrastructure FTP/SFTP password value, when prompted at the command
prompt.

Console Prompts

User Inputs

Please enter

In case the prompt reads as below, enter the username/

Infrastructure

password for accessing the product Staging/ Metadata

FTP/SFTP password

Repository
FTPSHARE
Kerberos username [user]
Kerberos password for user:

12. Enter Always, when prompted to add host key fingerprint.
13. The OFSAAI License Agreement is displayed.
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14. To accept the License Agreement, enter Y/y.
15. Enter the passwords for default Infrastructure administrator and authorizer users.
Console Prompts

Please enter password

User Inputs

Enter the password for the System Administrator.

for default Infrastructure
administrator user
SYSADMN
Please re-enter

Enter the same password again to confirm its validity.

password for default
Infrastructure
administrator user
SYSADMN
Please enter password

Enter the password for the System Authorizer.

for default Infrastructure
authorizer user
SYSAUTH
SYSAUTH
Please
enter password

Enter the same password again to confirm its validity.

for default Infrastructure
authorizer
SYSAUTHuser
SYSAUTH
NOTE:
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SYSADMN and SYSAUTH are the two defaults OFSAAI administrative users created.

NOTE:

The installation process continues on the console. Do not close the console until the
installation process is complete.
16. The following message is displayed in the console
Installation completed…
17. On completion of installation, refer the installation log files. For more information, refer
Verifying the Log Files.
18. Install the consolidated one-off patch 25777667. Refer to the Readme available with
the patch for further instructions on installing the patch.
19. Perform steps mentioned in the Post Installation Configuration section.

Note: Download and install patch for Bug 21160684 if installing this release of the OFS ALM Application
Pack version 8.0.0.0.0 on Java 8. For more information, refer Configurations for Java 8. This patch is not
required if an OFSAA instance already exists and is configured for Java 8.
Silent.props
SILENT installation is achieved via a properties file [Silent.props] that must be updated with proper
values, before attempting to install using the silent mode.

NOTE: Do not install the new applications in the same segment if the pre-installed applications
use run management.
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The following table lists all the properties that need to be specified:
Property Name

Description of Property

Permissible

Comments

values
LOG_MODE

SEGMENT_1_CODE

Mode for logging

0

Segment Code

=

Debug

Optional;

1= General

Default : 0

Not Applicable

MANDATORY
Note:

The

Segment

Code should be in upper
case.
APPFTP_LOG_PATH=

Infodom

Maintenance

log

Not Applicable

# Mandatory if this an

path(to be created) for the new

App

Layer

Installation

Infodom for applayer

and if you want to create
a new infodom
# i.e you have specified
INSTALL_APP=1

and

INFODOM_TYPE=0
DBFTP_LOG_PATH

Infodom

Maintenance

log

Not Applicable

# Mandatory if this an

path(to be created) for the new

App

Infodom for DBLayer

and if you want to create

Layer

Installation

a new infodom
# i.e you have specified
INSTALL_APP=1

and

INFODOM_TYPE=0
OBI_HOST

Host Name of the OBIEE

Not Applicable

Server
OBI_PORT

Port Number of the OBIEE

Not Applicable

MODEL_TYPE

Context Name of the OBIEE

Not Applicable

0

Model Upload

1 = yes

data

model

Customized data model
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if

Applicable

if

INSTALL_ADMIN_BI=1

whether you want to perform

Released

Applicable
INSTALL_ADMIN_BI=1

Server
UPLOAD_MODEL

if

INSTALL_ADMIN_BI=1

Server
OBI_CONTEXT

Applicable

or

0

=

=

No

Mandatory

if

INSTALL_APP=1
released

1 = customized

Mandatory
INSTALL_APP=1

if

DATAMODEL

the path

for the customized

Not Applicable

data model

# Mandatory only if you
want

to

upload

the

customized data model
# i.e you have specified
MODEL_TYPE=1
DM_DIRECTORY

the

file

name

for

the

Not Applicable

customized data model

# Mandatory only if you
want

to

upload

the

customized data model
# i.e you have specified
MODEL_TYPE=1
ETL_APPSRC_TYPE

Create new ETL App/Src pair

0

=

or use an existing one

1 = Existing

New

# Mandatory if this an
App Layer installation
# i.e you have specified
INSTALL_APP=1
# 0 = If you want to
create

a

new

ETL

app/src pair
# 1 = If you want to use
an existing pair
ETL_APP_1_DESC

Please give description for the

Not Applicable

ETL App

# Mandatory if you want
to

create

new

ETL

app/src pair
#i.e you have specified
ETL_APPSRC_TYPE=0
ETL_SRC_1_1_DESC

Please give description for the
ETL

Staging

Not Applicable

source

# Mandatory if you want
to

description

create

new

ETL

app/src pair
#i.e you have specified
ETL_APPSRC_TYPE=0

ETL_SRC_1_2_DESC

Please give description for the
ETL

Processing

Not Applicable

source

# Mandatory if you want
to

description

create

new

ETL

app/src pair
#i.e you have specified
ETL_APPSRC_TYPE=0

ETL_APP_1_NAME

The ETL application name

Not Applicable

This is for App Layer
installation
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ETL_SRC_1_1_NAME

ETL

Staging

source

Not Applicable

name

This

Source must be

mapped to the above
ETL Application

ETL_SRC_1_2_NAME

ETL

Processing

source

Not Applicable

name

This

Source must be

mapped to the above
ETL Application

4.3.3 Verifying the Log File
Refer the following logs files for more information:


Refer the Pack_Install.log located at OFS_ALM_PACK/logs/ folder for OFS ALM
Application Pack installation log file.



Refer the log file(s) located at OFS_ALM_PACK/OFS_AAI/logs/ folder for Infrastructure
installation log.



Refer the OFSAAInfrastucture_Install.log located at $FIC_HOME folder for
Infrastructure installation log.

Note:
For Pack on Pack installation (if OFS_DM_PACK, OFS_TR_PACK, and OFS_CRM_PACK are installed
before OFS_ALM_PACK), then following warnings might be logged in the installation log and these can
be ignored as this has no implication on the product.
Warning: Table already has a primary key
Warning: Table already has a referential constraint with same name
Warning: Object already exists
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5

Post Installation Steps
On successful installation of the Oracle Financial Services Advanced Analytical Applications
Infrastructure Application Pack, follow the post installation steps.
This chapter includes the following sections:

NOTE:



Configuring Resource Reference



Start OFSAA Infrastructure Services



Add TNS entries in TNSNAMES.ORA file



Configuration for Oracle R distribution and Oracle R Enterprise (ORE)



Configuration for Java 8



Create and Deploy the Application Pack Web Archive



Access the OFSAA Application



Perform Post Deployment Configurations
Ensure to clear the application cache prior to the deployment of Application Pack Web
Archive. This is applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). For more
information, refer Clearing Application Cache section.

5.1

Configure Resource Reference
Configure the resource reference in the Web Application Server configured for OFSAA
Applications. Refer Appendix B for details on configuring the resource reference in WebSphere,
WebLogic, and Tomcat Application Servers.

5.2

Start OFSAA Infrastructure Services
Start the OFSAA Infrastructure Services prior to deployment or accessing the OFSAA
Applications.
Refer to the Appendix D for details on Start/ Stop OFSAA Services.

5.3

Add TNS entries in TNSNAMES.ORA file
Add TNS entries in the tnsnames.ora file, for every schema created for the Application Pack
To find the tnsname for the entries, follow these steps:
1. Login to the application using System Administrator privileges.
2. Navigate to System Configuration & Identity Management tab.
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3. Click Administration and Configuration >> System Configuration >> Database Details.
4. Expand the dropdown list for Name to get the list of TNS entry names.
Alternatively, you can connect to the CONFIG schema and execute the following query:
select dbname from db_master where dbname !='CONFIG'

5.4

Configuration for Oracle R distribution and Oracle R Enterprise (ORE)
This is an optional step. Skip and proceed with the next steps if OFS Enterprise Modeling
Application with R scripting is not enabled during installation.
1. Install OFSAAIRunner Package. For more information, refer Installing OFS AAAI
Runner Package. If you have already installed OFSAAIRunner package (as part of a
previous installation), uninstall it (For more information, refer Uninstalling OFS AAAI
Runner Package section), and reinstall the latest available OFSAAIRunner package.
2. Log in to the database with dba privileges and provide the following privilege to
Configuration Schema:


RQADMIN by executing the command:
GRANT RQADMIN TO <config_schema>;

3. Log in to the database with dba privileges and provide the following privileges to Atomic
Schema:


CREATE UNLIMITED TABLESPACE privilege by executing the command:
GRANT CREATE UNLIMITED TABLESPACE TO <atomic_schema>;



CREATE

MINING

MODEL privilege (to execute the Data Mining models) by

executing the command:
GRANT CREATE MINING MODEL TO <atomic_schema>;

5.4.1 Installing OFS AAAI Runner Package
OFSAAIRunner is an R package built by the OFS Enterprise Modeling Application. It is a
prerequisite for executing models developed using R scripts. This package helps in:


Initializing inputs



Mapping framework variables to R objects



Configuring possible outputs of the script



Storing results back to the Database

OFSAAIRunner package (OFSAAIRunner_1.0.0.tar.gz) is available under $FIC_DB_HOME/lib.
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5.4.1.1

Prerequisite


Oracle R & ORE should be installed on the Oracle Database server before installing
OFSAAIRunner package.

Refer to the following instructions to install OFSAAIRunner package:
1. Log in to the OFSAA Server. Navigate to the folder $FIC_DB_HOME/lib.
2. Copy the file OFSAAIRunner_1.0.0.tar.gz in Binary mode to the Oracle Database
Server.
3. Log in to the Oracle Database Server with the user using which Oracle Database Server
installation is done.
4. Navigate to the directory where the file OFSAAIRunner_1.0.0.tar.gz is copied.
5. Install the package by executing the command:
ORE CMD INSTALL OFSAAIRunner_1.0.0.tar.gz
Successful installation is indicated in the installation log as:
* DONE (OFSAAIRunner)
Making packages.html ... done
NOTE:

The OFSAAIRunner package is installed in /usr/lib64/R/library.
6. Navigate to the directory $ORACLE_HOME/R/library and check whether
OFSAAIRunner package is listed there by executing the command:
>library(OFSAAIRunner)
>OFSAAIRunner:: and press TAB twice.
This lists out all the functions.

5.4.2 Uninstalling OFSAAAI Runner Package
Refer to the following instructions to uninstall the OFSAAIRunner package:
1. Log in to the Oracle Database Server with the same username, using which Oracle
Database Server installation is done.
2. Enter ORE in command prompt and execute the command:
#ORE
>remove.packages("OFSAAIRunner")
3. To save workspace image, enter the command:
>q()
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4. Enter y when prompted to save the workspace image.
Save workspace image? [y/n/c]: y
5. Navigate to the directory $ORACLE_HOME/R/library and verify the package is not listed
there by executing the command:
ls –l

5.5

Configuration for Java 8

Refer to the following instructions to extract and apply the patch.
1. Copy the downloaded patch file (21160684) to your OFSAA server in Binary mode.
For more information on downloading the patch files, refer to Prerequisite Information section>>
Category – Others>>Sub-Category-OFSAA.
2. Follow the instructions given in the Readme to apply the patch.
3. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_HOME/jdbc/lib to the
following locations:
 $FIC_HOME/utility/OFSAAGenerateRepository/lib/







$FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/
$FIC_HOME/ficdb/lib/
$FIC_HOME/ficapp/icc/lib/
$FIC_HOME/ficapp/common/FICServer/lib/
$FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/
$FIC_HOME/ficweb/webroot/WEB-INF/lib/



$FIC_HOME/ficdb/etl/classes/

Note: If ojdbc6.jar is already present in any of the aforementioned folders, you need to remove it.
4. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_HOME/jdbc/lib to the
following locations:
 $FIC_HOME/utility/OFSAAGenerateRepository/lib/
 $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/
 $FIC_HOME/ficdb/lib/

5.6






$FIC_HOME/ficapp/icc/lib/
$FIC_HOME/ficapp/common/FICServer/lib/
$FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/
$FIC_HOME/ficweb/webroot/WEB-INF/lib/



$FIC_HOME/ficdb/etl/classes/

Create and Deploy the Application Pack Web Archive
On successful installation of the OFSAA Application Pack, the web archive file is automatically
generated. However, you need to deploy the generated web archive file on the Web Application
Server.
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For identifying the location of the generated web archive file and for generating and deploying the
web archive file at any time later, refer Appendix C
NOTE: Refer the Oracle Financial Services Forms Manager User Guide for instructions on Creating and
Deploying the Forms Manager Web Archive.

5.7

Access the OFSAA Application
Prior to accessing the OFSAA application ensure the Internet Explorer Settings are configured.
Refer to Appendix E for details on accessing the OFSAA Application on successful deployment of
the application web archive.

5.8

Perform Post Deployment Configurations
Prior to using the OFSAA Application perform the Post Deployment Configuration steps detailed
in Appendix F.
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A

6

Appendix A - Configuring Web Server
This appendix includes the following sections:

6.1



Configuring Web Server



Configuring Web Application Server

Configuring Web Server
This step assumes an installation of a Web Server exists as per the prerequisites.
Refer the product specific Installation Guide/ Configuration Guide to install/ configure the Web
Server. If an installation already exists, skip and proceed to the next step.

NOTE:

Make a note of the IP Address/ Hostname and Port of the web server. This information is
required during the installation process.
Refer Oracle Financial Services Analytical Applications Infrastructure Security Guide
mentioned in the Related Documents section for additional information on securely configuring
your Web Server.
Ensure to enable sticky session/ affinity session configuration on the web server. Refer the
respective product specific Configuration Guide for more details. Additionally, you also need to
enable the sticky session/ affinity session configuration at Load Balancer level if you have
configured a Load Balancer in front of the web server(s).

6.2

Configuring Web Application Server
This step assumes an installation of a web application server exists as per the prerequisites. To
configure the Web Application Server for OFSAA Deployment refer the following sections.
This section includes the following topics:

NOTE:



Configuring WebSphere Application Server for Application Deployment



Configuring WebLogic for Application Deployment



Configuring Apache Tomcat Server for Application Deployment
Make a note of the IP Address/ Hostname and Port of the web application server. This
information is required during the installation process (required if Web Server is not
configured).
Refer OFSAA Secure Configuration Guide/ Security Guide mentioned in the Related
Documents section for additional information on securely configuring your Web Server.
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6.2.1 Configuring WebSphere Application Server for Application Deployment
You can deploy multiple OFSAA applications on different profiles of a WebSphere application
server. To create multiple WebSphere "Profiles" in a stand-alone server, use the command line
option as explained below. A profile is the set of files that define the runtime environment. At least
one profile must exist to run WebSphere Application Server.
This section includes the following topics:

6.2.1.1



Creation of New Profile in WebSphere



Manage Applications in WebSphere



Delete WebSphere Profiles



WebSphere HTTPS Configuration



WebSphere Memory Settings

Creation of New Profile in WebSphere
The Profile is created in WebSphere through command line using the manageprofiles.sh which
resides in <WebSphere Install directory>/AppServer/bin.
The command to create a profile without admin security through command line is as follows:
"manageprofiles.sh -create -profileName <profile> -profilePath
<profile_path> -templatePath <template_path> -nodeName
<node_name> -cellName <cell_name> -hostName <host_name>"
Example:
$usr/home>./manageprofiles.sh -create -profileName mockaix profilePath/websphere/webs64/Appserver/profiles/mockaix templatePath/websphere/webs64/Appserver/profileTemplates/default
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell hostName ipa020dor
The command to create a profile with admin security through command line is as follows:
"manageprofiles.sh -create -profileName <profile> -profilePath
<profile_path> -templatePath <template_path> -nodeName <node_name> cellName <cell_name> -hostName <host_name> -enableAdminSecurity true adminUserName <Admin User Name> -adminPassword < Admin User Password> samplespassword <sample User Password>"
Example:
$usr/home>./manageprofiles.sh -create -profileName mockaix profilePath/websphere/webs64/Appserver/profiles/mockaix templatePath/websphere/webs64/Appserver/profileTemplates/default nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName
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ipa020dor -enableAdminSecurity true -adminUserName ofsaai adminPassword ofsaai -samplespassword ofsaai"
NOTE:

While using the manageprofiles.sh command to create a New Profile in WebSphere, you can
also use "-validatePorts" to validate if the specified ports are not reserved or in use.
Additionally, you can specify new ports with "-startingPort <base port>" which specifies the
starting port number to generate and assign all ports for the profile. For more information on
using these ports, refer WebSphere manageprofiles command.

6.2.1.2

Manage Applications in WebSphere
To manage the installed applications in WebSphere, do the following:
1. Open the administrator console using the following URL:
http://<ipaddress>:<Administrative Console Port>/ibm/console
Example: http://10.111.222.333:9003/ibm/console (https if SSL is enabled)

NOTE:

Administrative Console Port value is available in serverindex.xml file within <WebSphere
Profile Directory>/config/cells/<Node Cell>/nodes/<Node Name> directory.
The Integrated Solutions Console Login window is displayed.

Figure 41: Integrated Solutions Console Login

2. Log on with the User ID provided with the admin rights.
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3. From the LHS menu, expand the Applications > Application Type> WebSphere
Enterprise Applications.
4. The Enterprise Applications screen is displayed.

Figure 42: Enterprise Applications

5.

6.2.1.3

This Enterprise Applications screen helps you to:


Install new application



Uninstall existing applications



Start or Stop the installed applications

Delete WebSphere Profiles
To delete a WebSphere profile, do the following:
1. Select the checkbox adjacent to the required application and click Stop.
2. Stop the WebSphere profile to be deleted.
3. Navigate to WebSphere directory:
4. <WebSphere_Installation_Directory>/AppServer/bin/
5. Execute the command:
manageprofiles.sh -delete -profileName <profile_name>
6. Delete profile folder.
7. Example:
<WebSphere_Installation_Directory>/AppServer/profiles/<profile_name>
8. Execute the command:
manageprofiles.sh –validateAndUpdateRegistry
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6.2.1.4

WebSphere HTTPS Configuration
Following are the steps for configuring an HTTPS Transport on WebSphere:
1. Create a profile using the Profile Creation Wizard in WebSphere.
2. Note down the https port specified during this process and use the same as servlet
port or web server port during OFSAAI installation.
To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in
OFSAAI_InstallConfig.xml for SILENT mode OFSAAI installation.

6.2.1.5

WebSphere Memory Settings
To configure the WebSphere Memory Settings:
1. Navigate to Websphere applications server > Application servers > server1 > Process
definition > Java Virtual Machine.
2. Change the memory setting for Java Heap:
Initial heap size = 512
Maximum heap size = 3072

6.2.2 Configuring WebLogic for Application Deployment
You can deploy multiple Infrastructure applications on different domains of a stand-alone
weblogic application server. To create multiple WebLogic "Domains" in a stand-alone server you
can use the Domain Creation wizard. A domain is the set of files that define the runtime
environment. At least one domain must exist to run WebLogic Application Server.
Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and install
patch 18729264.

This section includes the following topics:

6.2.2.1



Creating Domain in WebLogic Server



Delete Domain in WebLogic



WebLogic Memory Settings

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, do the following:
1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the
command:
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./config.sh
The Welcome window of the Configuration Wizard is displayed.

Figure 43: Welcome

2. Select Create a new WebLogic domain option and click Next.
The Select Domain Source window is displayed.
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Figure 44: Select Domain Source

3.

Select the Generate a domain configured automatically to support the following
products option and click Next.

4. The Specify Domain Name and Location window is displayed.

Figure 45: Specify Domain Name and Location

5. Enter the Domain Name and Location. Click Browse to navigate and specify the
location. Click Next.
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The Configure Administrator Username and Password window is displayed.

Figure 46: Configure Administrator Username and Password

6. Enter the User name and User password to be assigned to the Administrator.
Ensure that the password is of minimum 8 characters in length.
7. Re-enter the password for confirmation and add a brief Description. Click Next.
The Configure Server Start Mode and JDK window is displayed.

Figure 47: Configure Server Start Mode and JDK

8. Select the following options:
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In the WebLogic Domain Startup Mode section, select the required mode (Development
Mode or Production Mode).
In the JDK Selection section, select Other JDK. Click Browse and navigate to the JDK
location. Click Next.
The Select Optional Configuration window is displayed.

Figure 48: Select Optional Configuration

9. Select Administration Server. A WebLogic Server domain must have an
Administration Server. You can also select Manages Servers, Clusters and Machines
and RDBMS Security Store if required. Click Next.
The Configure the Administration Server window is displayed.
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Figure 49Configure the Administration Server

10. Enter Administration Server details such as the Name, Listen address, Listen Port,
SSL listen port, and SSL enabled (for secure login using https) check box. Click Next.
The Configuration Summary window is displayed.
NOTE:

Make a note of the Listen Port or SSL Listen Port value (ex: 7007), since the same has to be
re-entered in the Servlet port field during Infrastructure installation.
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Figure 50: Configure Server Start Mode and JDK

11. Verify the configuration details of the WebLogic domain and click Create.
12. The Creating Domain window is displayed with the status indication of the domain
creation process.
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Figure 51: Configure Server Start Mode and JDK

13. Click Done when complete. The domain server is created enabling the deployment of
multiple Infrastructure applications on a single WebLogic.
Note:

Note down the HTTPS port specified during this process and use the same as servlet port or
web server port during OFSAAI Installation.
To enable https configuration on Infrastructure, assign value 1 to "HTTPS_ENABLE" in
OFSAAI_InstallConfig.xml for SILENT mode OFSAAI installation
14. Add

a

java

option

entry

-DUseSunHttpHandler=true

in

WLS_HOME/bin/

"setDomainEnv.sh" file (Required only if self signed certificate is used).
6.2.2.2

Delete Domain in WebLogic
1. Navigate to the following directory:
2. <WebLogic Installation directory>/user_projects/domains/<domain name>/bin
3. Execute stopWebLogic.sh to stop the Weblogic domain.
4. Delete the Weblogic domain.
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6.2.2.3

WebLogic Memory Settings
To configure the WebLogic Memory Settings:
1. Change the memory setting for Java Heap to -Xms512m –Xmx3072m in
setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in
CommEnv.sh file which resides in the folder common/bin.
2. Edit this file for customizing memory settings and garbage collector settings
depending on the available hardware configuration.
3. Example 1:
if [ "${JAVA_VENDOR}" = "Sun" ] ; then
WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_64BIT
WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_32BIT
else
WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_64BIT
WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"
export WLS_MEM_ARGS_32BIT
Example 2:
JAVA_VM=
MEM_ARGS="-Xms256m -Xmx1024m"

6.2.3 Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web Application Server type is Tomcat.
This section includes the following topics:
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Tomcat User Administration



Configure Tomcat to use JAVA 64 bit Executables



Configure Servlet Port



SSL Port Configuration



Apache Tomcat Memory Settings



Uninstalling WAR Files in Tomcat

A


6.2.3.1

Configuration for Axis API

Tomcat User Administration
The Tomcat administration and manager application does not provide a default login. You are
required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed below.
This file contains an XML tag <user> for each individual user, which will display the username
and password used by admin to log on to Tomcat, and the role names to which the admin user is
associated with. For example, <user name="admin" password="admin"
roles="standard.manager" />
1. Add the manager role to any one of the existing username/password combination as
shown in the example above.
2. Use the same username/password to which the manager role has been assigned to
access the Tomcat Application Manager.
3. If the Tomcat server is already running, it requires a re-start after the above
configuration is done.

6.2.3.2

Configure Tomcat to use JAVA 64 bit Executables
1. Navigate to the "$CATALINA_HOME/bin" folder.
2. Edit the setclasspath.sh as explained below:
3. Replace the following block of text
# Set standard commands for invoking Java.
_RUNJAVA="$JRE_HOME"/bin/java
if [ "$os400" != "true" ]; then
_RUNJDB="$JAVA_HOME"/bin/jdb
With:
# Set standard commands for invoking Java.
_RUNJAVA="$JAVA_BIN"/java
if [ "$os400" != "true" ]; then
_RUNJDB="$JAVA_BIN"/jdb
4. If the Tomcat server is already running, it requires a re-start after the above
configuration is done.

95

A

Note: In case tomcat is installed under different Unix profile, set JAVA_BIN environment
variable

in .profile to include the Java Runtime Environment absolute path. For example:

export JAVA_BIN /usr/java6_64/jre/bin
export JAVA_BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris Sparc
6.2.3.3

Configure Servlet Port
The default servlet port configured for the Tomcat installation is 8080. Ignore this section if you
need to use the default port.
If you need to use a different port number, you must first configure the port in the "server.xml" in
the "conf" directory of Tomcat Installation directory. The following steps guide you through the
configuration process:
1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:
"Define a non-SSL HTTP/1.1 Connector on port 8080 "
2. Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this value
to the new port number that will be used during the installation process.
3. Save your changes in "server.xml".

NOTE:

Make a note of the servlet port configured. This information is required during the installation
of OFSAA Application Pack.

6.2.3.4

SSL Port Configuration
If you need to configure and access your OFSAA setup for HTTPS access, ensure that the
following connect tag under "Define a SSL HTTP/1/1 Connector on port 8443" in
"<Tomcat_installation_folder>/conf/server.xml" file is uncommented for SSL Configuration.
(By default, it is commented).
<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS"

NOTE:

Make a note of the servlet port configured. This information would be required during the
installation of OFSAA Application Pack. To enable https configuration on Infrastructure, assign
value 1 to "HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for SILENT mode OFSAAI
installation.
For more information related to SSL Configuration on Tomcat, refer to
http://tomcat.apache.org/.
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6.2.3.5

Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings:
1. Locate the file catalina.sh which resides in the folder <CATALINA_HOME>/bin.
2. Edit this file for customizing the memory settings and garbage collector settings
depending on the available hardware configuration.
3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.
4. Example:
if [ -z "$LOGGING_MANAGER" ]; then
JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m
-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"
else
JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"
fi

6.2.3.6

Uninstalling W AR Files in Tomcat

To uninstall WAR files in tomcat, refer Uninstalling WAR Files in Tomcat.
6.2.3.7

Configuration for Axis API
This step is optional and required only if the web application server used in Apache Tomcat. If
you use any other web application server, skip and proceed to next step.
Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_4/webapps/axis/WEBINF/lib and place it in under <Tomcat Installation Directory>/lib and restart the Tomcat Server
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7

Appendix B - Configuring Resource Reference in Web
Application Servers
This section covers the following topics:

7.1



Configure Resource Reference in WebSphere Application Server



Configure Resource Reference in WebLogic Application Server



Configure Resource Reference in Tomcat Application Server

Configure Resource Reference in WebSphere Application Server
This section is applicable only when the Web Application Server is WebSphere.
This section includes the following topics:


Create JDBC Provider



Create Data Source



J2C Authentication Details



JDBC Connection Pooling

7.1.1 Create JDBC Provider
1. Open the WebSphere admin console in the browser window:
http://<ipaddress>:<administrative console port>/ibm/console. (https if SSL is
enabled). The Login window is displayed.
2. Login with the user ID that has admin rights.
3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. The
JDBC Providers window is displayed.
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Figure 52: JDBC Providers

4. Select the Scope from the drop-down list. Scope specifies the level at which the resource
definition is visible.
5. Click New to add new JDBC Provider under the Preferences section. The Create new
JDBC provider window is displayed.
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Figure 53: Create a new JDBC Provider

6. Enter the following details:


Database Type - Oracle



Provider Type- Oracle JDBC Driver



Implementation Type- Connection pool data source



Name- The required display name for the resource



Description - The optional description for the resource

7. Click Next.
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Figure 54: Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do not use the
trailing slash file separators.
The Oracle JDBC driver can be downloaded from the following Oracle Download site:


Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers



Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server.
NOTE: Refer Appendix P for identifying the correct ojdbc<version>.jar version to be copied.
9. Click Next. The Summary window is displayed.

Figure 55: Summary

10. Verify the details and click Finish to create the JDBC Provider.
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11. The options to Save and Review are displayed. Click Save.

7.1.2 Create Data Source
These steps are applicable for both CONFIG and ATOMIC data source creation.
1. Open this URL in the browser window: http://<ipaddress>:<administrative console
port>/ibm/console. (https if SSL is enabled). The Login window is displayed.
2. Login with the user id that has admin rights.
3. Expand the Resources option in the LHS menu and click JDBC > Data sources option.
The Data sources page is displayed.

Figure 56: Data Sources

4. Select the Scope from the drop down list. Scope specifies the level at which the resource
definition is visible.
5. Click New. The Create a Data Source window is displayed.
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Figure 57: Create a data source

6. Specify the Data Source name and JNDI name for the new "Data Source".
The JNDI and Data Source name are case sensitive. Ensure that JNDI name is same as
the "Information Domain" name.
7. Click Next. The Select JDBC provider window is displayed.

Figure 58: Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC
provider from the drop-down list. Click Next.
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Figure 59: Enter database specific properties

9. Specify the database connection URL.
For Example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>
10. Select Data Store Helper Class Name from the drop-down list and ensure that the
checkbox Use this data source in container managed persistence (CMP) is selected.
NOTE:

For RAC configuration, provide the RAC URL specified during installation
For Example:
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10
.11.12.13)(port=1521))(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(
LOAD_BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))
11. Click Next.

Figure 60: Setup security aliases
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12. Map the J2C authentication alias, if already created. If not, you can create a new J2C
authentication alias by accessing the link given (Global J2C authentication alias) or you
can continue with the data source creation by clicking Next and then Finish.

Figure 61: Summary

You can also create and map J2C authentication alias after creating the data source.
13. You must create another Data source by following the above procedure with
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of Infrastructure.

7.1.3 J2C Authentication Details
These steps are applicable for creating both config and atomic J2C Authentication.
To create J2C Authentication details:
1. Select the newly created Data Source and click JAAS - J2C authentication data link
under Related Items.
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Figure 62: JAAS- J2C authentication data

2. Click New under the Preferences section.

Figure 63: JAAS- J2C authentication data- New

3. Enter the Alias, User ID, Password, and Description. Ensure the following:


User ID is the Oracle user ID created for the respective CONFIG and ATOMIC
Schema for the “Information Domain”.



Specify the CONFIG database user ID and password information for the
jdbc/FICMASTER data source, and specify the ATOMIC database user ID and
password information for the ATOMIC schema data source that you created earlier.
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4. Click Apply and save the details.

7.1.4 JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider and Data
source to access the data from the database.
1. Expand the Resources option in the LHS menu and click JDBC > Data sources option.
The Data sources page is displayed.
2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data
sources>$DATA_SOURCE$>Connection pools.

Figure 64: Connection Pools

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100
connections, and Minimum connections to 10 connections as shown in the above
figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as
required.

7.2

Configure Resource Reference in WebLogic Application Server
This section is applicable only when the Web Application Server is WebLogic.
This section includes the following topics:
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Create GridLink Data Source



Configure Multi Data Sources



Advanced Settings for Data Source



JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:


For a Non RAC Database instance, Generic Data Source has to be created. See Create
Data Source.



For a RAC Database instance, Gridlink Data Source has to be created. See Create
GridLink Data Source.



When Load Balancing/Fail over is required, Multi Data Source has to be created. See
Configure Multi Data Sources.

7.2.1 Create Data Source
These steps are applicable for both config and atomic data source creation.
1. Open WebLogic Admin Console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Welcome window is displayed.
2. Login with the Administrator Username and Password.

Figure 65: Welcome

3. From the LHS menu (Domain Structure), click Services > Data Sources. The Summary
of JDBC Data Sources window is displayed.
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Figure 66: Summary of JDBC Data Sources

4. Click New and select Generic Data Source option. The Create a New JDBC Data
Source window is displayed.
You can also select GridLink Data Source or Multi Data Source while creating a Data
Source.

Figure 67: Create a New JDBC Data Source

5. Enter JDBC data source Name, JNDI Name, and select the Database Type from the
drop-down list. Click Next.
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Ensure the following:


The JNDI Name field should be in the format "jdbc/informationdomain"



Same steps needs to be followed to create a mandatory data source pointing to the
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name.



JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.



Required "Database Type" and "Database Driver" should be selected.

Figure 68: JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the Database
Driver depending on database setup, that is, with or without RAC. Click Next.

Figure 69: Transaction Options

7. Select the Supports Global Transactions checkbox and the One-Phase Commit option.
8. Click Next. The Connection Properties window is displayed.
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Figure 70: Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle User
Name, and Password.
10. Click Next. The Test Database Connection window is displayed.
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Figure 71: Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.
A confirmation message is displayed stating "Connection test succeeded."
12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.
NOTE:

"User ID" is the Oracle user ID that is created for the respective "Information Domain".
"User ID" to be specified for data source with "FICMASTER" as "JNDI" name should be the
Oracle user ID created for the CONFIG schema.
13. Select the new Data Source and click the Targets tab.
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Figure 72: Select Targets

14. Select the AdminServer option and click Finish.

7.2.2 Create GridLink Data Source
If you have selected the option, New > GridLink Data Source while creating the "Data Source",
you can directly specify the JDBC URL as indicated.

Figure 73: Create a New JDBC GridLinkData Source

1. Enter Data Source Name, and JNDI Name.
Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and the
XA Driver checkbox is not selected. Click Next.
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Figure 74: JDBC GridLinkData Source- Connection Properties

2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. The
created "Data Source" is displayed in the list of Data Sources.

7.2.3 Configure Multi Data Sources
A JDBC multi data source is an abstraction around a group of data sources that provides load
balancing and failover between data sources. As with data sources, multi data sources are also
bound to the JNDI tree. Applications can look up a multi data source on the JNDI tree and then
reserve a database connection from a data source. The multi data source determines from which
data source to provide the connection.
When the database used is Oracle RAC (Real Application Clusters) which allows Oracle
Database to run across a set of clustered servers, then group of data sources can be created for
instances running on a set of clustered servers and a JDBC multi data source can be created so
that applications can look up a multi data source on the JNDI tree to reserve database
connection. If a clustered server fails, Oracle continues running on the remaining servers.
1. Open WebLogic Admin Console in the browser window:
http://<ipaddress>:<administrative console port>/console. (https if SSL is
enabled). The Login window is displayed.
2. Login with the "User ID" that has admin rights.
3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data Sources.
The Summary of JDBC Multi Data Sources window is displayed.
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Figure 75: Summary of JDBC Multi Data Sources

4. Click New. The New JDBC Multi Data Source screen is displayed.
NOTE:

Ensure that the Data Sources which needs to be added to new JDBC Multi Data Source has
been created.

Figure 76: Configure the Multi Data Source

5.

Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from the
drop-down list. Click Next.

Note:


The JNDI Name has to be specified in the format jdbc/infodomname.



JNDI Name of the Data Sources that will be added to new JDBC Multi data source should
be

different

from

the

JNDI

name

specified

during

Multi

Data

Source.

Same steps needs to be followed to create a mandatory data source pointing to the
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name for Data
Source.

115

A



Same steps needs to be followed to create a mandatory data source pointing to the
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name for Data
Source.



JNDI Name provided in multi data source should be the same name that will be mentioned
in the web.xml file of OFSAAI Application.



You can select the Algorithm Type as Load-Balancing.

Figure 77: Select Targets

6. Select the AdminServer check box and click Next.

Figure 78: Select Data Source Type

7.

Select the type of data source which will be added to new JDBC Multi Data Source.
Click Next.

Figure 79: Add Data Sources

8.
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The New JDBC Multi Data Source is created with added data sources.

7.2.4 Advanced Settings for Data Source
1. Click the new Data Source from the Summary of JDBC Data Sources window. The
Settings for <Data Source Name> window is displayed.
2. Select the Connection Pooling tab given under Configuration.
3. Go to the Advanced option at the bottom of the page, and check the Test Connection
of Reserve checkbox (Enables Weblogic Server to test a connection before giving it to a
client).
4. To verify if the data source is valid, select "Data Source name". For example,
FICMASTER.

Figure 80: Settings for <Data Source Name>

5. Select the server and click Test Data Source.
6. A message is displayed indicating that the test was successful.
7.

Once the "Data Source" is created successfully, the following messages are displayed:


All changes have been activated. No restart is necessary.



Settings updated successfully.

If not, follow the steps given above to recreate the data source.

7.2.5 JDBC Connection Pooling
To define the JDBC connection pooling, ensure that you have created JDBC Provider and Data
source to access the data from the database.
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1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Home
>Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC Data Source<INFODDOM_NAME>
2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity Increment
by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.
3.

7.3

Click Save.

Configure Resource Reference in Tomcat Application Server
This section includes the following topics:


Create Data Source



JDBC Connection Pooling



Class loader configuration for Apache Tomcat

Copy the Oracle JDBC driver file, ojdbc<version>.jar from <Oracle Home>/jdbc/lib and
place it in <Tomcat Home>/lib.
Refer Appendix P for identifying the correct ojdbc<version>.jar version to be copied.

7.3.1 Create Data Source
To create "data source" for OFSAA application, navigate to <Tomcat Home>/conf and edit the
following block of text by replacing the actual values in server.xml.

NOTE:

The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on the
value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema
Creator Utility.
For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was
mentioned as ofsaaconf, then the actual schema created in the database would be
DEV_ofsaaconf.
<Context

path

="/<context

Directory>/webapps/<context

name>"
name>"

docBase="<Tomcat
debug="0"

crossContext="true">
<Resource auth="Container"
name="jdbc/FICMASTER"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schema>"
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reloadable="true"
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password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
<Resource auth="Container"
name="jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
</Context>

NOTE:

The

<Resource>

tag

must

be

repeated

for

each

Information

Domain

created.

After the above configuration, the "WAR" file has to be created and deployed in Tomcat.

7.3.2 JDBC Connection Pooling
To define the JDBC connection pooling, do the following:
1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path
$TOMCAT_DIRECTORY/lib/.
Refer Appendix P for identifying the correct “ojdbc<version>.jar” version to be copied.
2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the
following changes, which is required for connection pooling.
<Context path ="/<context name>" docBase="<Tomcat Installation
Directory>/webapps/<context name>" debug="0" reloadable="true"
crossContext="true">
<Resource auth="Container"
name="jdbc/FICMASTER"
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type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the configuration schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
<Resource auth="Container"
name="jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
</Context>
Note the following:


$APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed path.



$INFODOM_NAME$ should be replaced by Infodom Name.



$ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema database user
name.



$ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema database
password.



$JDBC_CONNECTION_URL should be replaced by JDBC connection string
jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, jdbc:oracle:thin
10.80.50.53:1521:soluint



The User-IDs for configuration/ atomic schemas have the prefix of setupinfo depending on
the value set for PREFIX_SCHEMA_NAME in <<APP Pack>>_SCHEMA_IN.XML file of
Schema Creator Utility.
For example: if the value set for PREFIX_SCHEMA_NAME is DEV and the schema name was
mentioned as ofsaaconf, then the actual schema created in the database would be
DEV_ofsaaconf.
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7.3.3 Class loader configuration for Apache Tomcat
Edit the server.xml available in $TOMCAT_HOME/conf/ folder .
Add tag <Loader delegate="true" /> within the <Context> tag, above the <Resource> tag. This is
applicable only when the web application server is Apache Tomcat 8.
NOTE:
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Appendix C - Creating and Deploying EAR/WAR File
This appendix includes the following topics:

8.1



Creating EAR/WAR File



Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:
1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.
2. Execute ./ant.sh to trigger the creation of EAR/ WAR file.
3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time taken"
message is displayed and you will be returned to the prompt.

4. The EAR/ WAR file - <contextname>.ear/ .war - is created.
NOTE:

The <contextname> is the name given during installation.
This process overwrites any existing version of EAR file that exists in the path.
In case of OFSAA configured on Tomcat installation, <contextname>.war will be created.
ANT warning for tools.jar can be ignored while executing ./ant.sh.
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8.2

Deploying EAR/WAR File
This section includes the following topics:

NOTE:



Deploying WebSphere EAR/WAR Files



Deploying WebLogic EAR/WAR Files



Deploying Tomcat WAR Files

Ensure to clear the application cache prior to the deployment of Application Pack Web
Archive. This is applicable to all Web Servers (WebSphere, WebLogic, and Tomcat). For more
information, refer Clearing Application Cache section.

8.2.1 Deploying EAR/WAR Files for WebSphere
To deploy WebSphere EAR/WAR File, follow these steps:
1. Start WebSphere Profile by navigating to the path
"/<Websphere_Installation_Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Na
me>/bin/" and execute the command:
./startServer.sh server1
2. Open the following URL in the browser: http://<ipaddress>:<Administrative
Console Port>/ibm/console. (https if SSL is enabled). The login screen is displayed.
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Figure 81: Login Window

3. Enter the user credentials with admin privileges and click Log In.
4. From the LHS menu, select Applications and click New Application. The New
Application window is displayed.

Figure 82: New Application

5. Click New Enterprise Application. The Preparing for the application installation
window is displayed.
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Figure 83: Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for
OFSAA to upload and install. Click Next.

Figure 84: Installation Options

7. Select the Fast Path option and click Next. The Install New Application window is
displayed.
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Figure 85: Install New Application

8. Enter the required information and click Next. The Map Modules to Servers window is
displayed.
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Figure 86: Map Modules to Servers

9.

Select the Web Application and click Next. The Map Resource References to
Resources window is displayed.

Figure 87: Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined earlier.
11. Click Modify Resource Authentication Method and specify the authentication method
created earlier.

127

A

You can specify "config" for FICMASTER resource or "atomic" for atomic resource as
the authentication method.
12. Select the OFSAAI Web Application check box and click Next. The Map Virtual hosts
for Web Modules window is displayed.

Figure 88: Map Virtual host for Web Modules

13. Select the Web Application check box and click Next. The Summary page is
displayed.
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Figure 89: Summary

14. Click Finish and deploy the Infrastructure Application on WebSphere.
15. On successful installation, a message is displayed. Click Save and save the master file
configuration. The details are displayed in the Master File Configuration window.
Start the Application
1. Expand Applications > Application Type > WebSphere enterprise applications. The
Enterprise Applications window is displayed.
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Figure 90: Enterprise Applications

2. Select the installed application and click Start.
NOTE:

<profile name> is the profile name given while creating the WebSphere profile.
<cell name> is the cell name given during profile creation.
<contextname> is the context name given during installation.
Explode EAR File
To explode EAR, follow these steps:
1. Create the "applications" folder under domain name. For example,
/Bea/user_projects/domains/ <Domain _name>/applications.
2. Create <context_name>.ear folder under "applications" folder.
3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/ap
plications/<context_name>.ear.
4. Explode the <context_name>.ear file by executing the command:
jar -xvf <context_name>.ear
5. Delete the <context>.ear and <context>.war files (recently created)
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/ap
plications/<context_name>.ear.
6. Create a directory <context_name>.war under
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/ap
plications/<context_name>.ear.
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7. Copy <$FIC_WEB_HOME/<context_name>.war file to
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/ap
plications/<context_name>.ear/<context_name>.war.
8. Explode the <context_name>.war file by executing the following command to get the
directory structure:
jar -xvf <context_name>.war

8.2.2 Deploying EAR/WAR File for WebLogic
Following are the steps for deploying Infrastructure application that would be created during
installation:
1. Navigate to the path <WebLogic Installation
directory>/user_projects/domains/<domain name>/bin in the machine in
which WebLogic is installed.
2. Start WebLogic by executing the command:
./startWebLogic.sh -d64 file
3. Open the URL in the browser window: http://<ipaddress>:<admin server
port>/console. (https if SSL is enabled). The Sign in window of the WebLogic Server
Administration Console is displayed.
NOTE:

Ensure that you have started Infrastructure Server by executing “./startofsaai.sh" as
mentioned in Start Infrastructure section
4. Log on to the WebLogic Server by entering the user credentials having privileges to
deploy the EAR file.
5. From the Domain Structure LHS menu, click Deployments. The Summary of
Deployments window is displayed.
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Figure 91: Summary of Deployments

6. Click Install. The Install Application Assistant window is displayed.
7. Select the Exploded EAR directory after browsing to the directory where it is saved and
click Next.
Install Application
To install Application:
1. Open the Install Application Assistant.

Figure 92: Install Application Assistant

2. Click Next.
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Figure 93: Install Application Assistant

3. From the Choose targeting style section, select the Install this deployment as an
application option and click Next. The Optional Settings window is displayed.
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Figure 94: Optional Settings

4. Enter a Name for the deployment if required.
5. Under the Security section, select the DD only option to specify that only roles and
policies that are defined in the deployment descriptors should be used.
6. Select the I will make the deployment available from the following location option
under the Source accessibility section.
7. Click Next to continue. The Deployment Summary window is displayed.

134

A

Figure 95: Deployment Summary

8. Select the Yes, take me to the deployment's configuration screen option and click
Finish. The Settings for <Deployment Name> window is displayed.
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Figure 96: Settings for <Deployment Name>

9. Review the general configuration details of the deployment. You can also update the
configuration of the deployment in this window. In the Overview tab you can view the
complete deployment configuration.
10. Click Save to update the changes, if any.
11. From the LHS menu, click Deployments. The Summary of Deployments window is
displayed.
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Figure 97: Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing all
requests. Ensure that the Infrastructure server is up and running.

Figure 98: Summary of Deployments

13. The State of the deployed application is displayed as Active if started successfully.

8.2.3 Deploying WAR Files on Tomcat
Before deploying the WAR files, ensure that the previously deployed applications of Infrastructure
are uninstalled. See Uninstalling Previously Deployed WAR Files in Tomcat for the procedure to
uninstall the previously deployed Infrastructure war files.
On the machine that hosts Tomcat, follow these steps outlined to deploy Infrastructure
application:
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1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to
<Tomcat Installation Directory>/webapps/ directory.

2. Click Manager App. The Connect to dialog box is displayed.
3. Enter the User Id and Password that has admin rights and click OK. (For user creation
in tomcat, see Tomcat User Administration. The Tomcat Web Application Manager
window is displayed with the list of all the applications deployed.
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4. In the Deploy section, enter the Context Path provided during the installation as
"/<context-name>".
5. Enter the path where the <context-name>.war file resides (by default
"$FIC_WEB_HOME/<context-name.war>") in the WAR or Directory URL field and
click Deploy.
6. On successful application deployment, a confirmation message is displayed. Start the
Tomcat server. Refer Starting Infrastructure Services for more details.
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Appendix D - Start/Stop OFSAA Infrastructure Services
This chapter details on how to start and stop OFSAA Infrastructure services. This chapter
includes the following sections:

9.1



Starting Infrastructure services



Stopping Infrastructure Services

Starting Infrastructure Services
Once the installation of Infrastructure has been completed successfully and the post-installation
steps are completed, the servers must be started. Log on to each machine and run the .profile
file. All servers mentioned must be started from the same shell encoding. Following servers are
dependent on each other. It is mandatory to maintain the order in which the servers are started.
Allow each of the servers to initialize completely before starting the next server.
1. On the machine in which Infrastructure Application components have been installed,
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the following
command to start the Infrastructure Server.
./startofsaai.sh

NOTE:

You can also start the Infrastructure Server by executing the command "nohup ./
startofsaai.sh &". Starting the process using "nohup" and "&" will return the command prompt
without having to wait till the process completes. However, this command cannot be used
when you are starting the server for the first time or starting after changing user password in
the configuration database schema. You can also start the Infrastructure Server by executing
the command "nohup ./ startofsaai.sh &". Starting the process using "nohup" and "&" will
return the command prompt without having to wait till the process completes. However, this
command cannot be used when you are starting the server after changing user password in
the Configuration database schema.
2. Start ICC server:


On the machine in which Infrastructure default Application components have
been installed, navigate to $FIC_HOME/ficapp/icc/bin



Execute the command:
./iccserver.sh
Note: Only Infrastructure Default Application Server would hold ICC component.

3. Stopping Infrastructure Services


On the machine on which Infrastructure Database components have been
installed, navigate to $FIC_DB_HOME/bin and execute the command to start
"Agent server":
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./agentstartup.sh
Or


Start Back-end services using the command:
nohup ./agentstartup.sh &
Note: This agent internally starts the Router, Message Server, OLAP data server
and AM services.

9.1.1 Starting Web Application Servers
Start the Web Application Server depending on the type from the following table.
Start up Option

Description

Starting WebSphere profile

On the machine in which Web sphere is installed, navigate to
[Webshpere_Install_Directory] /AppServer/<profiles>/<profile
name>/bin and execute the command: ./startServer.sh server1.

Starting WebLogic Domain

On the machine in which WebLogic is installed navigate to <WebLogic
Installation directory>/user_projects/domains/<domain
name>/bin and execute the command: startWebLogic.sh -d64.

Note: If WebLogic is already running, access the WebLogic Admin
Console. Stop and start the application <context name>.ear.
Starting Tomcat Application

On the machine in which Tomcat is installed, navigate to
<Tomcat_Install_ Directory>/bin and execute the command:
./catalina.sh run

9.1.2 Starting Web Application Servers
Start the Web Application Server depending on the type from the following table.
Start up Option

Description

Starting WebSphere profile

On the machine in which Web sphere is installed, navigate to
[Webshpere_Install_Directory] /AppServer/<profiles>/<profile
name>/bin and execute the command: ./startServer.sh server1.

Starting WebLogic Domain

On the machine in which WebLogic is installed navigate to <WebLogic
Installation directory>/user_projects/domains/<domain
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Start up Option

Description
name>/bin and execute the command: startWebLogic.sh -d64.

Note: If WebLogic is already running, access the WebLogic Admin
Console. Stop and start the application <context name>.ear.
Starting Tomcat Application

On the machine in which Tomcat is installed, navigate to
<Tomcat_Install_ Directory>/bin and execute the command:
./catalina.sh run

9.2

Stopping Infrastructure Services
To stop Infrastructure services:
1. On the machine in which Infrastructure Application components have been installed,
navigate to $FIC_APP_HOME/common/FICServer/bin and execute the command:
./stopofsaai.sh
2. To stop ICC server, on the machine in which Infrastructure default Application
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and
execute the command:
./iccservershutdown.sh

NOTE:

Only Infrastructure Default Application Server would hold ICC component.
3. To stop Back-end server, on the machine in which Infrastructure database
components have been installed, navigate to $FIC_DB_HOME/bin and execute the
command:
./agentshutdown.sh
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Appendix E - Access the OFSAA Application
This section gives details about the steps to be performed to access OFSAA Application.

10.1 Access the OFSAA Application
1. From a your desktop, open the browser and enter the URL in following format:
<scheme>://<IP address/ hostname>:<port>/<contextname>/login.jsp
For example, https://111.222.333.444:5555/ofsaa/login.jsp
Following OFSAA login window is displayed:

Figure 99: OFSAA Login window

2. With installation of every OFSAA Application Pack, there are two seeded user profiles
configured in the system:
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SYSADMN – System Administrator



SYSAUTH – System Authorizer

Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" in the
SYSADMN login USER ID). Enter the password that was provided during installation.
On the first login, you will be prompted to change the password.
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11 Appendix F - Post Deployment Configuration
This chapter covers the following topics:


Deploying the Application



Logging as System Administrator



Creating Application Users



Mapping Application User(s) to User Group

11.1 Deploying the Application
11.1.1 To deploy the ALM application, follow the steps:
The Oracle Financial Services Analytical Applications Infrastructure Application Server is started using
startofsaai.sh. This file can be edited for setting customized memory settings, garbage collector settings
depending on the available hardware configuration. Please raise an SR in support.Oracle.com if you
have any queries related to EPM applications.
Once the installation of Oracle Financial Services Asset Liability Management Product is completed, you
must perform the following steps.
1. Check the Log file.
2. Add the following entries in excludeURLList.cfg file located in the path
$FIC_WEB_HOME/webroot/conf/. These entries are required for Asset and Liability
Management, Funds Transfer pricing, Profitability Management and Hedge Management / IFRS:

[SQLIA]./fsapps/common/batchCreate.action
[SQLIA]./fsapps/common/batchEdit.action
Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra
care to avoid copying formatting characters into the cfg file.

3. For Administrative Reports (Admin BI) configuration follow the steps mentioned in Oracle
Financial Services Administrative Reports on OBIEE 11g v8.0.0.0.0 - Configuration Note.docx
under $FIC_HOME/adminbi
Note: You can also find the Oracle Financial Services Administrative Reports on OBIEE 11g
v8.0.0.0.0 - Configuration Note on OTN.
4. The web.xml under the path $FIC_WB_HOME \webroot\WEB-INF\ should have Resource tag, if
not present add the tag and replace ORDEMO with the INFODOM name.
<resource-ref>
<description>DB ConnectionORDEMO</description>
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<res-ref-name>jdbc/ORDEMO</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res-auth>Container</res-auth>
</resource-ref>

Note: Copy the above information into notepad, and then copy it from notepad into cfg file. Take extra
care to avoid copying formatting characters into the cfg file.

5. Transfer the ownership of batches to the required User.
 Login to config user.


Execute the Following anonymous pl/sql block to execute procedure
“AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP”.
begin
AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromUser','toUser','infodom');
end;
OR
begin
AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP('fromuser','touser');
end;
Parameter details:
from User: indicates the user who currently owns the batch,
to User: indicated the user to which the ownership has to be transferred.
infodom: optional parameter, if specified the ownership of batches pertaining to that Infodom
will be changed.

6. If the web application server is hosted on a machine other than where pack is installed, then
perform the following step.


Generate RSA key for the machine where Web application server is hosted.



Add the generated RSA key to the authorized keys list of the machine where Pack s
installed

11.1.2 To deploy the ALMBI application, follow the OBIEE configuration steps:
1. Make sure Oracle Business Intelligence (Version 11.1.1.7.0) installation is completed.
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NOTE:

After Installation, patch 16556157 is recommended for all the customers who are using Oracle
Business Intelligence Enterprise Edition 11.1.1.7.0. This patch can be downloaded from Oracle
support site.

2. Set the <Oracle BI Instance Home> directory.
For example, /u01/OBIEE11G/instances/instance1.
3. Start Weblogic AdminServer.
a. Set the < BI Domain Home> directory.
For Example, /u01/OBIEE11G/user_projects/domains/bifoundation_domain.
b. Navigate to < BI Domain Home >/bin and run nohup ./startWebLogic.sh &.
c.

Bringing up this service may take a few minutes depending on your environment. Check
the logs using the command tail –f nohup.out.

4. Start Node Manager.
a. Set the < WebLogic Server Home > directory>.
For example, /u01/OBIEE11G/wlserver_10.3.
b. Navigate to <WebLogic Server Home>/server/bin and execute the command nohup
./startNodeManager.sh &.
5. Start Weblogic Managed Server(bi_server1).
a. Login onto http://localhost:7001/console using your Administrator credentials created
during platform install (Replace the hostname based on your setup).
b. Under Environment, click Servers link.

The bi_server1 line should show as shutdown state at this point.
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c.

Click Control tab.

d. Select the bi_server1 line by clicking on the left tick box.
e. Click Start button at the top of the list and confirm starting this service.

f.

State will update to “RUNNING” mode after a few minutes.

6. Start OBIEE services and login
a. Starting services From EM screen
i. Login to the EM administration screen using the URL: http://localhost:7001/em
(Replace the hostname and port number based on your setup). Use the login you
created in BIEE installation to log in.
ii. Expand 'Business Intelligence' node on the left and choose Coreapplication.

iii. Click Overview Tab.
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iv. Click Restart (or Start) under the Manage System section.
v. Click Yes on dialog box to confirm the move. Wait for message that confirms
successful restart.
b. If starting using EM is not successful and complaining about OPMNCTL not up, follow
starting process with OPMNCTL.
i. Open a command prompt, navigate to <Oracle BI Instance Home>/bin.
ii. Run ./opmnctl status, this will show you status of all the OBIEE core services
iii. run ./opmnctl startall or ./opmnctl stopall depending on your need.
7. Deploy RPD and webcat file(s).
1. Navigate to folder $FIC_HOME/ALMBI/RPD_WEBCATALOG/ which contains both
ALMBI.rpd and archived ALMBI.catalog.Copy both the files to a local folder.
2. Login to
I.

OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em).

II.

Click on coreapplication from ‘Business Intelligence’ tab on left hand side.

III.

Under ‘coreapplication’, select the tab ‘Deployment’ and click ‘Lock and Edit
Configuration’ button located below title ‘coreapplication’.

149

IV.

RPD Deployment:
1. Select Browse button available under Upload BI Server Repository section
and select ALMBI.rpd file from the local folder. Enter Repository password
‘Administrator1’.

V.

Web catalog Deployment:
1. Create a new webcatalog folder for ALM BI application through Enterprise
Manager of OBIEE.
2. Set the Catalog Location available under ‘BI Presentation Catalog’ like:
“$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesCompon
ent/$COMPONENT_NAME/catalog/ALMBI”.
3. Click Apply and then click Activate changes. A pop up will be shown after
successful activation.

4. Click Close and switch to Capacity management tab.
5. Restart the presentation services. Under the System Components
Availability, select Presentation Services and click on Restart Selected
option.

150

VI.
VII.

Once the Presentation Service is restarted, it will give the pop up for successful
restart. Click Close.
Verify that new folder structure is created in the system. It can be found under path :
<Oracle BI Instance Home>
\bifoundation\OracleBIPresentationServicesComponent\coreapplication_obips1\catal
og\ALMBI

VIII.

This ‘ALMBI’ folder will be having a root folder which in turn contains three folders
named ‘shared’, ‘system’ and ‘users’.

3. Open the Catalog Manager
a. Navigate to File menu and open the catalog online (File->Open catalog) by giving the
necessary credentials based on your setup (Type - (online), URL (http://<ipaddress>:<port>/analytics/saw.dll).
b. Once the catalog is opened, it will display a folder structure on left hand side. Select the
shared folder in the LHS tree structure.
c.

Go to ‘File’ menu and select ‘Unarchive’. It will ask for the path for a file.

d. Browse the path of the archived catalog file saved in your local folder using the ‘Browse’
button in the pop up. Click ‘OK’.
e. The catalog will be unarchived in specified location. A pop up for successful operation will
be shown. Restart the presentation services once again.
4. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login with credentials
based on your setup, and verify that catalog is available.
8. Configure tnsnames.ora.
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a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin.
b. Make sure an entry is made in the tnsnames.ora to connect to atomic schema of OFSAA
application.
c.

Save the tnsnames.ora.

9. Configure ODBC data source to connect to Oracle BI Server.
a. Go To Control Panel>Administrative Tools>Data Sources (ODBC).
b. Select the ‘System DSN’ tab and click ‘Add’ Button.
c.

Select a driver specific to (Oracle BI Server 11g) and click ‘Finish’ Button.

d. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of the BI Server
and click ‘Next’).
e. Enter Oracle BI Server login id and password (Enter User Name and Password created
at the time of OBIEE installation). Click ‘Next’.
f.

Click ‘Finish’.

10. Modify connection pool and set the properties.
a. Open the OBI Administration tool.
b. Select Start > Programs > Oracle Business Intelligence > BI Administration.
c.

Select File > Open > Online and select ‘ALMBI.rpd’ file.

d. In the Open dialog box, select and open ‘ALMBI.rpd’ file.
e. Enter Repository password as ‘Administrator1’.
f.

RPD changes:
1) Go to Manage -> Variables edit the Session variable ‘TNS’
For Ex: Change the Default Initializer from ‘TNS ENTRY’ to ‘actual TNS entry’ like
‘(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Data
base IP
address>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<Database
Name>)))’
2) Edit the Initialization Block ‘TNS Init Block’ ->Click Edit Data Source
For Ex: Change the Default Initialization string from “select 'TNS ENTRY' from
dual “ to select
(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<Datab
ase IP address>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<Database
Name>)))’ from dual
3) Edit the Session variable ‘DBUSER’
Change the Default Initializer from ‘'USERNAME'’ to actual Database schema
name.
4) Edit the Initialization Block ‘DBUSER Init Block’ ->Click Edit Data Source
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Replace 'USERNAME' with the actual atomic schema name.
5) Edit the Session variable ‘DBUSERPWD’
Change the Default Initializer from ‘'PASSWORD'’ to actual Database atomic
schema password.
6) Edit the Initialization Block DBUSERPWD Init Block’ ->Click Edit Data Source
Replace 'PASSWORD' with the actual atomic schema password.
Check in the changes and give yes for global consistency check. Make sure No
errors and warnings. Click Save.
7) Close the RPD file (File / Exit).

g. WEBCATALOG changes:
1) Click Open->shared Folders->Change Database Connection-> Prompt For
Sources_TNS
2) Select the Prompt TNS and click on edit.
3) Change the sql statement in default selection.
4) For example: select case when '@{DBNAME}' ='ALMDB' THEN
'(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<IP
ADDRESS>)(PORT=1521)))(CONNECT_DATA=(SERVICE_NAME=<DATBASE
NAME>)))' end from "ALM BI" and Click Save.
11. Login into OFSALMA Application using the URL: http://localhost:9704/analytics.(Replace the port
number based on your setup).


Navigate to FICWEBHOME .



Run ant.sh

12. Once the OBIEE Environment is up and running, the OBIEE URL needs to be updated in the
table 'AAI_MENU_B' for an end user to access the respective Business Intelligence Analytics
Application.

Following update statement needs to be executed in the config schema:
UPDATE AAI_MENU_B
SET V_MENU_URL = '<URL>'
WHERE V_MENU_ID IN (‘<List of enabled BI Analytical Links for a particular Media Pack >’)
/
COMMIT
/
For ALM Media Pack as an example:
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UPDATE AAI_MENU_B
SET V_MENU_URL = 'http://10.1.2.3:9704/analytics'
WHERE V_MENU_ID IN ('OFS_ALM_ABI','OFS_ALMBI_LINK')
/
COMMIT
/
(Replace the IP address and port number based on your setup.)

11.2

Logging as System Administrator
Post installation, the first login into Infrastructure is possible only for a System Administrator
through user id “sysadmn”. This ID is created at the time of installation with the password
provided during installation. Enter login id “sysadmn” and password that was provided during
installation. Click Login.

11.2.1 System Administrator
System Administration refers to a process of managing, configuring, and maintaining confidential
data in a multi-user computing environment. System Administration in Security Management
involves creating functions, roles, and mapping functions to specific roles. System Administration
also involves maintaining segment information, holiday list, and restricted passwords to ensure
security within the Infrastructure system.
You can access System Administrator in LHS menu of Security Management. The options
available under System Administrator are:


Function Maintenance



Role Maintenance



Function - Role Map



Segment Maintenance



Holiday Maintenance



Restricted Passwords

11.2.1.1

Function Maintenance

A function in the Infrastructure system defines the privileges to access modules or components
and to define or modify metadata information associated. Function Maintenance allows you to
create functions for users to ensure only those functions are executed which are specific to the
user's role.
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You can access Function Maintenance by expanding System Administrator section within the tree
structure of LHS menu. The Function Maintenance window displays the function details such as
Function Code, Function Name, Description, and the number of Roles Mapped to the function.
The Function Maintenance window also facilitates you to view, create, modify, and delete
functions within the system.
You can also make use of Search and Pagination options to search for a specific function or view
the list of existing functions within the system.

11.2.1.2

Role Maintenance

A role in the Infrastructure system is a collection of functions defined for a set of users to execute
a specific task. You can create roles based on the group of functions to which users are mapped.
You can access Role Maintenance by expanding System Administrator section within the tree
structure of LHS menu. The Role Maintenance window displays the role details such as Role
Code, Role Name, Role Description, and the number of Users Mapped to the role. The Role
Maintenance window also facilitates you to view, create, modify, and delete roles within the
system.
You can also make use of Search and Pagination options to search for a specific role or view the
list of existing roles within the system.

11.2.1.3

Segment Maintenance

Segment is used to control access rights on a defined list of objects. It is mapped to an
information domain.
Segment Maintenance in the Infrastructure system facilitates you to create segments and assign
access rights. You can have different segments for different Information Domains or same
segments for different Information Domains.
User scope is controlled by segment/ folder types with which the object is associated.


Objects contained in a public folder will be displayed irrespective of any user.



Objects contained in a shared folder will be displayed if user belongs to a user group which is
mapped to an access type role with the corresponding folder.



Objects contained in a private folder will be displayed only to the associated owner.

You can access Segment Maintenance by expanding System Administrator section within the
tree structure of LHS menu. The Segment Maintenance window displays a list of available
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segments with details such Domain, Segment Code, Segment Name, Segment Description,
Segment/Folder Type, Owner Code, and the number of Users Mapped to the segment. You can
view, create, modify, and delete segments within the Segment Maintenance window.
You can also make use of Search and Pagination options to search for a specific role or view the
list of existing roles within the system.

11.2.1.4

Holiday Maintenance

Note: As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication is
configured to SSO Authentication and SMS Authorization.
Holiday Maintenance facilitates you to create and maintain a schedule of holidays or non-working
days within the Infrastructure system. On a holiday, you can provide access to the required users
and restrict all others from accessing the system from the User Maintenance window..
You can access Holiday Maintenance by expanding System Administrator section within the
tree structure of LHS menu. The Holiday Maintenance window displays a list of holidays in
ascending order. In the Holiday Maintenance window you can create and delete holidays.

11.2.1.5
NOTE:

Restricted Passwords
As part of OFSAAI 7.3.3.0.0 release, this feature will not be available if Authentication Type is
selected as SSO Authentication and SMS Authorization from System Configuration>
Configuration.
Restricted Passwords facilitates you to add and store a list of passwords using which users
are not permitted to access the Infrastructure system.
You can access Restricted Passwords by expanding System Administrator section within
the tree structure of LHS menu. The Restricted Passwords window displays a list of restricted
passwords and allows you to add and delete passwords from the list.
You can also make use of Search and Pagination options to search for a specific password or
view the list of existing passwords within the system. For more information, refer Pagination
and Search & Filter.

NOTE:

While searching for any pre defined restricted password, you have to key in the entire
password
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11.3

Creating Application Users
Create the application users in the OFSAA setup prior to use.

NOTE:

This step may not be required if you have already setup users in the OFSAA setup.
For more information refer user creation section from the Oracle Financial Services Analytical
Applications Infrastructure User Guide.

11.4

Mapping Application User(s) to User Group
Starting the OFSAA 8.0 release, with installation of ALM Application Pack, pre-configured
application user groups are seeded. These user groups are unique to every OFSAA Application
Pack and have application roles pre-configured.
For more information on seeded User Groups, refer to Appendix M.

11.5 Change ICC Batch Ownership
All the seeded Batches in OFSDF Applications Pack will be automatically assigned to SYSADMN
user during Installation. If one user who wants to see the Batches in Batch Maintenance Menu, He
needs to execute the following Queries in Config Schema of the Database.
Syntax:
begin
AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('fromUser','toUser','infodom');
end;
OR
begin
AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP ('fromuser','touser');
end;
Where from User indicates the user who currently owns the batch, to User indicated the user to
which the ownership has to be transferred. Infodom is optional parameter, if specified the
ownership of batches pertaining to that Infodom will be changed.
Eg.
begin
AAI_OBJECT_ADMIN.TRANSFER_BATCH_OWNERSHIP
('SYSADMN','FSDFOP','OFSBFNDINFO’);
end;

11.6 Mapping ICC Batch Execution Rights to User
By default all users who are mapped to FSDF Admin and FSDF Operator will have the
permission to execute the seeded Batches in FSDF Application Pack. However if any other userdefined batches or any other application pack batches created during the respective installation
application packs, the user need to map the Batch execution rights for each user/batch in the
Batch Execution Rights menu under Object Administration >> Object Security.
Note: Only SYSADMN user or any user who is mapped under FSDF Admin User Group will have
the access to map the Batch execution rights menu access.
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11.7 Saving Post- Load Change Transformations
After creating users, Login to Infrastructure as any user who is mapped to FSDF Admin or FSDF
Analyst group. Navigate to Data Management Framework >> Post Load Changes.

A New window will be displayed. Click on Each Transformation from Transformations List and
Click on Stored Procedure in the Right Panel, Click on Edit in the Top Right Menu and Click on
Finish Button in Bottom.
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Note: All the Transformation Stored Procedures are required to be edited and saved (Finish
Button) once for getting it is available.
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Appendix G – Cloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing OFSAA instance
for further project developments, that is, setting up OFSAA instances that are exact copies of the current
OFSAA instance. For more information on cloning, refer to OFSAA Cloning Reference Guide.
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Appendix H - OFSAA Landing Page
This appendix includes the following topics:

13.1



OFSAA Landing Page



Enabling a Product within an Application

OFSAA Landing Page for ALM Administrator
On successful authentication, the OFSAA Landing Page is displayed. This is a common landing
page for all users until a preferred application landing page is set by the user in his preferences.
The landing page includes multiple tabs and each tab has specific links to OFSAA Infrastructure
and/or Application modules. The tabs and links are displayed based on the OFSAA Application
accessed and the access roles mapped to the logged in user.
Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules in a tree
structure. The RHS Menu holds link(s) to modules in a navigational panel format.
The following tabs are available in the Landing Page:


Applications tab



Object Administration tab



System Configuration and Identity Management tab

13.1.1 Applications tab
This tab lists the various OFSAA Applications that are installed in the OFSAA setup. The Select
Application drop-down list displays the OFSAA Applications, based on the logged in user and
mapped OFSAA Application User Group(s). Links to related modules within Applications and
Infrastructure are grouped appropriately to maintain a unified experience.

13.1.2 Object Administration tab
This tab lists the various OFSAA Information Domains created in the OFSAA setup. The Select
Information Domain drop-down list displays the OFSAA Information Domains based on the
logged in user and mapped OFSAA Application User Group(s). Links to modules that enable
object traceability and migration of objects are grouped in this tab.

13.1.3 System Configuration and Identity Management tab
This tab lists the OFSAA Infrastructure System Configuration and Identity Management modules.
These modules work across Applications/ Information Domains and hence there are no
Application and Information Domain drop-down lists in this tab. Links to modules that allow the
maintenance of setup installation and identity management tasks are grouped together in this tab.
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NOTE:

The navigation path differs from Application to Application. That is, based on the selected
Application, the navigation varies.
For more details on how to operate on each tab, see OFSAAI User Guide available in OTN.

13.2 Enabling a Product within an Application Pack
You can also enable a product/ application within an application pack post installation at any point
of time.
To enable a product through the application UI, follow these steps:
1. Login to the application as SYSADMN user or any user with System Administrator
privileges.
2. Navigate to System Configurations & Identity Management tab and expand Financial
Services Analytical Applications Infrastructure >> Administration and Configuration >>
System Configuration.
3. Click Manage OFSAA Product License(s)
4. The Manage OFSAA Product License(s) page is displayed.

This page includes the following sections:


INSTALLED APPLICATION PACKS



PRODUCTS IN THE APPLICATION PACK

5. The following fields are displayed in the INSTALLED APPLICATION PACKS section:
Field

162

Description

Field

Description

Displays a unique Application Pack ID related to the application
pack.
Application Pack ID

Select the appropriate Pack id using the radio button. The
Products in the application pack will be displayed in the
PRODUCTS IN THE APPLICATION PACKS section.

Application Pack
Name

Displays the name of the Application Pack.

Description

Displays the description of the Application Pack.

Install Date

Displays the date when the Application Pack was installed.

6. The following fields are displayed in the PRODUCTS IN THE APPLICATION PACK
section:
Field

Description

Enable

Select the checkbox to enable a product within an Application
Pack.

Product ID

Displays a unique product id for the product.

Product Name

Displays the name of the Product

Description

Displays the description of the product.

Enable Date

Displays the date when the product was enabled.

7. Select an Application Pack by clicking the radio button next to the Application Pack ID
field.
8. Selecting an Application Pack will display below the products within the Application Pack.
9. Products which were enabled at the time of installation will have the checkbox “ENABLE”
disabled. You can enable any product within the selected Application Pack by clicking the
“ENABLE” checkbox against the respective Product ID.
10. Click on RESET button to cancel the operation and refresh the screen.
11. Click VIEW LICENSE AGREEMENT button.
12. The License Agreement section is displayed.
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13. Select the option I ACCEPT THE LICENSE AGREEMENT.
14. Click ENABLE.
15. An appropriate pop-up message confirmation is displayed showing that the product is
enabled for the pack.
NOTE:

To use the newly enabled product, you need to map your application users to the appropriate
product specific User_Group(s) and subsequently, authorize the actions by logging in as
System Authorizer.

For more information refer to Mapping/Unmapping Users section in the Oracle Financial Services
Analytical Applications Infrastructure User Guide 8.0.
To identify the newly enabled product specific User Groups/ Application Pack specific
User_Groups, refer to the respective Application Pack specific Installation and Configuration
Guide/ User Manual.
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Appendix I - Additional Configurations
The following sections provide detailed module specific post installation configurations.
This section includes the following topics:


FTP/SFTP Configuration for File Transfer



Configuration for Dimension and Hierarchy Management



Configure Infrastructure Server Memory



Internet Explorer Settings



Retrieving Patch Information



OLAP Data Server Configuration



Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance



OFSAAI Setup Information Fetching Tool



Encryption Changer



Infrastructure LDAP Configuration



Configure OFSAAI Web Services



Deploy OFSAAI Web Services



Configure Message Details in Forms Designer



Clearing Application Cache



Configuring Password changes



Configuring Java Virtual Machine



Configure Internal Service (Document Upload/ Download)

14.1 FTP/SFTP Configuration for File Transfer
In OFSAA, certain modules require transfer of files from the web application server to the OFSAA
server over SSH.
Follow these steps to ensure the OFSAA server recognizes the web application server during file
transfers.
1. Login to the web application server.
2. Type sftp <user>@<OFSAA Server>
3. Specify Yes when prompted for permission.
Are you sure you want to continue connecting (Yes/No)?
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4. This will add an entry into the "known_hosts" file.
5. A confirmation message is displayed:
Permanently added <OFSAA Server> RSA) to the list of known hosts.

14.2 Configuration for Dimension and Hierarchy Management
These configuration changes are applicable when Dimension Management features provided in
OFSAAI are used. You can open AMHMConfig.properties file present in the
$FIC_WEB_HOME/webroot/conf directory to set the properties for the following:
This section includes the following topics:


Member Deletion



Attribute Default Date Format



Members Reverse Population



Hierarchy Reverse Population



Maximum levels allowed in Hierarchies



Node Limit for a Hierarchy Tree

Configuration for Dimension and Hierarchy Management has to be done only after the
application/solution installation is done. The properties specific to Information Domain are:


$INFODOM$=<Name of the Information Domain>



$DIMENSION_ID$=<Dimension ID for which the property to be set>

14.2.1 Configure Member Deletion
This property should be set to allow the user to delete the Members for the Dimension.
Value

Code

Example

# Member Deletion

MEMBER_DEL-

MEMBER_DEL-

Configuration - VALUE-

$INFODOM$-

ORAFUSION-1=Y

Y/N

$DIMENSION_ID$=$V
ALUE$

14.2.2 Configure Attribute Default Date Format
This property should be set to display the Default Date Format for Date type Attribute in Attributes
window.
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Value

Code

Example

# Attribute Default Date

ATTR_DEF_DATE_FO

ATTR_DEF_DATE_FO

Format -

RMAT-

RMAT-

DB_DATE_FORMAT:D

$INFODOM$=$DB_DA

ORAFUSION=DD/MO

D-MON-YYYY

TE_FORMAT$

N/YYYY

14.2.3 Configure Members Reverse Population
This property should be set for reverse population of Members for the Dimensions in required
Information Domains.
Value

Code

Example

# Members Reverse

MEMBER_REVERSE_

MEMBER_REVERSE_

population - VALUE-

POP-$INFODOM$-

POP-ORAFUSION-1=Y

Y/N

$DIMENSION_ID$=$V
ALUE$

14.2.4 Configure Hierarchy Reverse Population
This property should be set for reverse population of Hierarchies for the Dimensions in required
Information Domains.
Value

Code

Example

#Hierarchy Reverse

HIERARCHY_REVERS

HIERARCHY_REVERS

population - VALUE-

E_POP-$INFODOM$-

E_POP-ORAFUSION-

Y/N

$DIMENSION_ID$=$V

1=Y

ALUE$

14.2.5 Configure Maximum Levels allowed in Hierarchies
This property is required to set the maximum levels allowed to build the Hierarchies tree
structure.
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Value

Code

Example

#Hierarchy Maximum

MAX_DEPTH-

MAX_DEPTH-

level allowed for the

$INFODOM$=$VALUE

FUSION=15

hierarchy in particular

$

Information Domain VALUE - Integer
number

Hierarchies greater than 15 levels are not supported within OFSAA EPM applications (ALM, FTP,
PFT, and HM). If the hierarchy data contains more than 15 levels, OFSA_IDT_ROLLUP will not
be populated. The number of hierarchy levels allowed for OFSAA EPM key dimensions must be
less than or equal to 15.


If the Hierarchy Reverse Population setting is set to “Y” and more than 15 levels exist in the
data, then following alert is displayed “The number of levels exceeds the limit”.



If the maximum level allowed setting is set greater than 15 and Hierarchy Reverse Population
is set to “Y”, then following error is displayed “Error occurred in Reverse Populating the
hierarchy”.

14.2.6 Configure Node Limit for a Hierarchy Tree
This property is required to display the Hierarchy as a small or a large hierarchy. If the tree node
limit exceeds the set limit, the Hierarchies are treated as large Hierarchy.
Table 5: Hierarchy Tree node limit

Value

Code

Example

#Tree node limit for the

TREE_NODE_LIMIT=$

TREE_NODE_LIMIT=3

hierarchy - Values is

VALUE$

0

Integer number

14.3 Configure Infrastructure Server Memory
The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and WebLogic
can be edited for customizing memory settings and garbage collector settings depending on the
available hardware configuration as explained below. These settings are base minimum and has
to be incremented considering the deployment metrics into account. The increments are usually
handled in multiples of 128mb for heap and 64mb for stack.
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14.3.1 Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:
1. Locate .profile file.
2. Edit X_ARGS field in this file for customizing memory settings and garbage collector
settings depends on the hardware configuration.
This has a default value X_ARGS_APP ="-Xms200m"
X_ARGS_APP =" "$X_ARGS" $DELIM -Xmx2048m"
NOTE:

You need to modify X_ARGS_APP variable in the .profile file to customize Java Memory
Settings for Model Upload based on the Data Model size.
For Run and Rule executions, the following value is recommended:
X_ARGS_RNEXE="-Xms1g -Xmx1g

-

XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -XX:+UseParallelOldGC XX:+DisableExplicitGC"
X_ARGS_RLEXE="-Xms1g -Xmx1g

-

XX:+UseAdaptiveSizePolicy -XX:MaxPermSize=512M -XX:+UseParallelOldGC XX:+DisableExplicitGC"

14.4 Internet Explorer Settings
NOTE:

OFSAAI supports only default zoom setting in Internet Explorer, that is, 100%.
Cookies should be enabled.

The following browser settings have to be specified at every client machine prior to accessing the
Infrastructure application.
1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options window
is displayed.
2. Click the Settings button. The Settings window is displayed.
3. Select the option Every time I Visit the webpage and click OK.
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4. In the Internet Options window, select the Security tab and select the Internet
option under Select a zone to view or change the security settings.
5. Click Default Level under Security level for this zone.
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Figure 100; Internet Options

6. Click OK to save.
7. Click Internet Explorer >> Tools >> Compatibility View Settings.
8. Enter the OFSAA setup URL in the Add this website field.
9. Click Add.
10. Ensure the URL is listed under Websites you've added to Compatibility View.
11. In the Internet Options window, select the Privacy tab and select the Turn on Pop-up
Blocker option under Pop-up Blocker settings.
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Internet Options- Popup Blocker Settings

12. Click Settings. The Pop-up Blocker Settings window is displayed.
13. Enter the URL of the OFSAA Application in the Address of Website to Allow: field.
14. Click Add. The OFSAA URL is displayed in the Allowed Sites section.
15. Click Close.
16. Click OK in the Internet Options window.

14.5 Retrieving Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:
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1. Login to the OFSAA application as a user with Object AdminAdvanced Role.
2. Navigate to Object Administration tab, expand Utilities and click Patch
Information.
3. The window displays the list of patches installed on the OFSAA setup across
Applications/ Platform.
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14.6 OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAI.
The following parameters must be set to ensure that the system limitations are not exceeded at
any stage. The values for these OS parameters should be specified based on the expected load
at each implementation site.
Example:
Process Memory Limit
Max Thread Stack Size
Max Number of Threads per Process


Sort Buffer settings: This must be set at the Essbase application level appropriate to the
anticipated load.



Shutdown and Restart: During shutdown of OFSAAI Server that has an instance of Data
Services that is communicating with an OLAP Data Server, it is imperative to ensure that
the cleanup of the old instance is completed on the OLAP Data Server before restarting the
OFSAAI Server. Pause for a period of time based on the load the system was subjected to,
before restarting the Data Services subsystem.

14.7 Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
For information on this section, refer OFS Analytical Applications Infrastructure Administration
User Guide in OTN.

14.8 OFSAAI Setup Information Fetching Tool
Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve the related
information about the OFSAAI Set up such as Operating System Name and version, Database
Type and Version, OFSAAI architecture, Log file locations and so on.
To execute SetupInfo.jar in console:
1. Navigate to the path $FIC_HOME.
2. Enter the command:
java -jar SetupInfo.jar
After execution, the output file location is displayed in the console.
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14.9 Encryption Changer
This utility helps you to regenerate the new AESCryptKey.ext file and encrypt all the encrypted
values of the OFSAAI setup according to the new key.
To execute EncryptC.jar in console:
1. Navigate to the path $FIC_HOME.
2. Enter the command:
java -jar EncryptC.jar
A confirmation message is displayed after execution.
Once executed, you need to create and deploy the EAR / WAR file depending on the configured
Web Application Server. For more information, see Create and Deploy EAR/ WAR files.

14.10 Infrastructure LDAP Configuration
For more information on LDAP configuration, see OFSAAI Administration Guide.

14.11 Configure OFSAAI Web Services
Web Services in OFSAAI is meant for exposing a web service to "asynchronously" or
"synchronously" execute requested tasks offered by OFSAAI. Following configuration steps are to
be done only if you are using the Web Services feature of OFSAAI.

14.11.1

Configure DynamicWSConfig.xml File

For each third party web service that needs to be accessed using the OFSAAI Web services
framework and the operations to be invoked, corresponding entries are to be made in the
DynamicWSConfig.xml template file.
The variable <WebServer> denotes any one of the application server, i.e. WebSphere,
WebLogic, or Tomcat.
The

DynamicWSConfig.xml

file

will

be

available

in

the

<OFSAAI

Installation

Directory>/EXEWebService/ <WebServer>/ROOT/conf directory. This file can be
placed in any directory that is accessible by the application and this location must be specified in
the web.xml file, as WSCONFIGFILE parameter.
The DynamicWSConfig.xml template file will be in <WebServer
EXEWebService.ear/EXEWebService.war/conf directory.
Following is template:
<XML>
<WEBSERVICES>
<WEBSERVICE CODE="$CODE"
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Deployment

Path>/

ENDPOINT="$ENDPOINT" TARGETNAMESPACE="$TARGETNAMESPACE"
XMLNS_XSD="$XMLNS_XSD" ENCODINGSTYLE="$ENCODINGSTYLE"
SERVICENAME="$SERVICENAME" PORTTYPENAME="$PORTTYPENAME"
SESSION_MAINTAIN_PROPERTY="$SESSION_MAINTAIN_PROPERTY"
USERNAME="$USERNAME"
PASSWORD="$PASSWORD" STYLE="$WEBSERVICESTYLE"
STUBIMPLEMENTATION="$STUBIMPLEMENTATION">
<OPERATION CODE="$CODE"
NAME="$NAME"
SOAPACTION="$SOAPACTION"
STYLE="$STYLE"
PACKAGENAME="$PACKAGENAME">
<INPUT ORDER="$ORDER"
PARAMNAME="$PARAMNAME"
ARGTYPE="$ARGTYPE"
CLASSNAME="$CLASSNAME"/>
<OUTPUT PARAMNAME="$PARAMNAME"
RETURNTYPE="$RETURNTYPE"
CLASSNAME="$CLASSNAME"/>
</OPERATION>
</WEBSERVICE>
</WEBSERVICES>
</XML>
The DynamicWSConfig.xml has the placeholders as tabulated below. These have to be updated
depending on the web service chosen and the mode of accessing it. For each Web service to be
accessed, the entire webservice tag in the DynamicWSConfig.xml file must be repeated. The
placeholders tabulated below should be set in accordance to the parameters published in the
third party wsdl files (webservices) to be accessed. The stub class specified must implement the
"com.iflex.Oracle Reveleus.execution.webservice.EXEWebIF" interface.
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14.11.2

Attributes for WEBSERVICE tag
Table 6: WEBSERVICE tag

Placeholder

$CODE

Description

Unique number within the xml file and cannot be 999
or 0.

$ENDPOINT

soap: address location in the wsdl: service name tag
of the wsdl file.

$TARGETNAMESPACE

The attribute value for the targetNamespace of the
wsdl: definitions tag.

$XMLNS_XSD

The attribute value for the xmlns:s of the
wsdl:definitions tag

$ENCODINGSTYLE

The attribute value for the xmlns:soapenc of the
wsdl:definitions tag.

$SERVICENAME

Name of the service found under the wsdl:service
name tag of the wsdl file.

$PORTTYPENAME

wsdl port type name as mentioned in the wsdl file.

$SESSION_MAINTAIN_P

This could be given as "" also.

ROPERTY
$USERNAME

User name to access the web services. Enter "" if no
user name is required.

$PASSWORD

Password to access the web services. Enter "" if no
password is required.

$WEBSERVICESTYLE

This can take either "rpc" in case of DII mode of
invoking web services or "stub" in case of static mode.
This is a mandatory parameter.
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$STUBIMPLEMENTATIO

Fully qualified class name (package

N

name.classname).

14.11.3

Attributes for OPERATION tag

Ensure that the "operation tag attributes" are repeated for each of the operation tags.
Table 7: OPERSTION tag
Placeholder

Description

$CODE

Should be unique within the Webservice tag.

$NAME

The name of the Function that is to be called
by the wsdl file.

$SOAPACTION

The URL for the Operation to access. This is
associated with the Operation tag of the wsdl
file.

$STYLE

This can take "rpc" if the web services
invoking is in DII mode or "stub" if it is in
static mode. This is a mandatory parameter.

$PACKAGENAME

Represents the JAXB package of input
object.

14.11.4

Attributes for INPUT tag
Table 8: INPUT tag
Placeholder

$ORDER

Description

The sequential number of the INPUT tag.
Should start from 0. This is in line with the
input order of the arguments that the API
accepts which is called by this operation.

$PARAMNAME

Input parameter name to be called by the
wsdl file.

$ARGTYPE

Input Parameter Data Type. If the input
argument type is complex object, specify
$ARGTYPE as "xmlstring".

$CLASSNAME

Represents class name of input object
parameter.
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14.11.5

Attributes for OUTPUT tag
Table 9: OUTPUT tag
Placeholder

$PARAMNAME

Description

Output parameter name to be returned by the
web service.

$RETURNTYPE

Output parameter Data Type. If the web
service response is a complex object, then
specify $RETURNTYPE as "object".

$CLASSNAME

Represents class name of output object
parameter.

14.11.6

web.xml Entries
1. This step is optional and required only if the web application server used is Tomcat.
In case of any other application server, skip and proceed with next step.
Navigate to $FIC_HOME/webroot/WEB-INF/ and edit the web.xml file. Set parameter
value DOCSERVICEAPP to EXEWebServiceAXIS.
2. Navigate to <OFSAAI Installation
Directory>/EXEWebService/<WebServer>/ROOT/WEB-INF/ and edit
following web.xml file.

NOTE:

In case of Java 7 when WebLogic is used as web application server replace following line of
<OFSAAI Installation Directory>/EXEWebService/Weblogic/ROOT/WEBINF/web.xml file that is
<?xml version='1.0' encoding='UTF-8'?>
<web-app id="WebApp_ID" version="3.0"
xmlns="http://java.sun.com/xml/ns/javaee"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd" metadatacomplete="true">
with
<?xml version='1.0' encoding='UTF-8'?>
<web-app xmlns="http://java.sun.com/xml/ns/j2ee"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
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Entry for W SConfig File
The WSCONFIG file (DynamicWSConfig.xml) is available in the <WebServer Deployment
Path>/ EXEWebService.ear/EXEWebService.war/conf directory. This file can be placed
in any directory that is accessible by the application.
The path where the WSCONFIG file is placed must be specified in place of
$WSCONFIGFILELOCATION$ in the following block of text in web.xml.
<context-param>
<description>WebServices Configuration File</description>
<param-name>WSCONFIGFILE</param-name>
<param-value>$WSCONFIGFILELOCATION$</param-value>
<!--Specify the Location of DynamicWSConFig.xml-->
</context-param>

14.11.7

Proxy Settings

Replace the following <param-value> given in bold in the following block of text in web.xml
file, with appropriate values.
If no values are required, leave the <param-value> blank.
<context-param>
<description>http Proxy Host</description>
<param-name>http.proxyHost</param-name>
<param-value>$PROXYHOST$</param-value>
<!-- Specify the IP address or hostname of the http proxy server-->
</context-param>
<context-param>
<description>http Proxy Port</description>
<param-name>http.proxyPort</param-name>
<param-value>$PROXYPORT$</param-value>
<!--Port Number for the Proxy Server-->
</context-param>
<context-param>
<description>http proxy UserName</description>
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<param-name>http.proxyUserName</param-name>
<param-value>$PROXYUSERNAME$</param-value>
<!-- User ID To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http proxy Password</description>
<param-name>http.proxyPassword</param-name>
<param-value>$PROXYPASSWORD$</param-value>
<!-- User Password To get authenticated by proxy server-->
</context-param>
<context-param>
<description>http non-ProxyHosts</description>
<param-name>http.nonProxyHosts</param-name>
<param-value>$NONPROXYHOST$</param-value>
<!--Hosts

for

which

the

proxy

settings

should

get

by-passed

(Note:

Separate them by "|" symbol) -->
</context-param>

14.11.8

OFSAAI Home Entry

This entry should point to the Application layer / Web layer of the OFSAAI installation and should
be accessible.
Replace $FIC_HOME$ in the following block of text in web.xml with
Deployment Path>/EXEWebService.ear/EXEWebService.war.
<context-param>
<description>OFSAAI Web Home</description>
<param-name>FIC_HOME</param-name>
<param-value>$FIC_HOME$</param-value>
<!--OFSAAI Installation Folder-->
</context-param>
<context-param>
<description>OFSAAI Web Home</description>
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<WebServer

<param-name>FIC_PHYSICAL_HOME</param-name>
<param-value>$FIC_HOME$</param-value>
<!--OFSAAI Installation Folder-->
</context-param>

14.11.9

DynamicW SConfig.xml

For each third party web service that needs to be accessed using the OFSAAI Web services
framework, and the operation to be invoked, make corresponding entries into this file. This file is
to be placed in the location that is specified in the web.xml, as WSCONFIGFILE parameter.

14.12 Deploy OFSAAI Web Services
You can deploy OFSAAI Web Services separately if you had not configured OFSAAI Web
Services as part of the installation.
1. Complete the manual configuration of OFSAAI Web Services.
2. Navigate to <OFSAAI Installation Directory>/EXEWebService/<WebServer> and
execute the command:
./ant.sh
3. This will trigger the EAR/WAR file creation, which is required for the deployment.
4. Deploy the generated EXEWebService.EAR/EXEWebService.WAR file into the
WebServer.
If you have already configured OFSAAI Web Services as part of the installation, deploy the
generated EXEWebService.EAR/ EXEWebService.WAR file into the OFSAAI Deployment area in
WebServer profile.

14.13 Configuration to Enable Parallel Execution of DML statements
A configuration file, OracleDB.conf has been introduced to accommodate any configurable
parameter related to operations on oracle database. If you do not want to set a parameter to a
specific value, then the respective parameter entry can be removed/commented off form the
OracleDB.conf file which resides in the path $FIC_DB_HOME/conf.
As

of

now,

the

OracleDB.conf

file

has

only

one

parameter

namely

CNF_DEGREE_OF_PARALLELISM. This parameter indicates the degree of parallelism to be used
for a DML operation if parallel DML is explicitly enabled in the session with the ENABLE
PARALLEL DML clause of the ALTER SESSION statement. The default mode of a session is
DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not set, then the default
degree, as decided by Oracle will be used.
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14.14 Configure Message Details in Forms Designer
You can configure the Message Details in Forms Designer under Data Entry Forms and Queries
module by updating the details of mail server in the "NotificationConfig.cfg" file which resides in
the path $FIC_APP_HOME/common/FICServer/conf.
Ensure that the "authorized User details" for whom you need to configure the Message details are
included in Administration > Security Management > User Administrator > User Maintenance
window.
Update the following parameters in the "NotificationConfig.cfg" file:
Table 10: NotificationConfig.cfg File

Parameter

SMTP_SERVER_IP

Description

Specify the hostname or IP address of SMTP
Server.

SMTP_DEBUG_MODE

To run SMTP service in Debug mode, set
value to 'true', otherwise set value to 'false'.

SMTP_AUTHORIZATIO

Set to 'true' if SMTP server requires the client

N

to be authenticated, otherwise set to 'false'.

SMTP_USERNAME

Username required for logging into SMTP
server, if authentication is not required use a
dummy value.

SMTP_PASSWORD

Password required for logging into SMTP
server, if authentication is not required use a
dummy value.

SMTP_MAILID

If the Messages has to go from a Particular ID
that ID need to be added. Exchange server
forces you set a valid ID that is there in the
exchange server. (Based on Security
settings)

Ensure that the authorized User details are included in Administration > Security Management >
User Administrator > User Maintenance window.
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14.15 Clearing Application Cache
This is applicable to all Web Servers (i.e. WebSphere, WebLogic, and Tomcat).
Prior to the deployment of Infrastructure or Application Service Packs / One-off patches, navigate
to the following path depending on the WebServer configured and clear the cache:


Tomcat: <Tomcat installation
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp



WebLogic: <Weblogic installation location>/domains/<Domain
name>/servers/<Server name>/tmp/_WL_user/<Application
name>/qaelce/jsp_servlet



WebSphere: <Websphere installation
directory>/AppServer/profiles/<Profile name>/temp/<Node
name>/server1/<Application name>/<.war file name>

14.16 Configuring Password changes
This section explains about how to modify the OFSAA Infrastructure Config Schema and Atomic
Schema passwords.

14.16.1

OFSAA Infrastructure Config Schema password modification

To change the Config Schema password, perform the following steps:
1. Change the Config schema User Password in the database.
2. Delete the $FIC_HOME/conf/Reveleus.SEC file.
3. Shutdown the OFSAAI App service:
cd $FIC_APP_HOME/common/FICServer/bin
./stopofsaai.sh
4. Start the Infrastructure Server in foreground directly on the server or through XWindows software using the command:
./startofsaai.sh
At the prompt, enter System Password. Enter the "new Config schema" password. The
service will start and initialize itself if it is able to successfully connect to the DB.
5. Post successful startup of the service, if required, the Infrastructure server may be
shut down and restarted in the background using nohup mode.

14.16.2

OFSAA Infrastructure Atomic Schema password modification

To change the Atomic Schema password, perform the following steps:
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1. Change the Atomic schema User Password in the database.
2. Login to the application from the browser using SYSADMN account or any user id,
which has System Administrator role mapped.
3. Navigate to System Configuration > Database Details window. Select the appropriate
connection and edit the password.
4. Navigate to Data Management Tools >Data Sources> Source Designer window.
Update the password of the appropriate Source.
5. If you are using Apache Tomcat as Web server, update the <Context> -> Resource
tag details in Server.xml file from the $CATALINA_HOME/conf folder. (In case of
Tomcat only Atomic <Resource> will exist).
6. If you are using WebSphere as Web server:
a. Login to the WebSphere Administration Console, from the left side menu.
b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be
populated on the right side.
c.

Select the appropriate Data Source and edit the connection details. (In this
case, both Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:
a. Login to the WebLogic Administration Console, from the left side menu
b. Under Domain Structure list box, expand the appropriate Domain and navigate
to Services > JDBC >Data Sources. A list of data sources will be populated on
the right side.
c.

Select the appropriate Data Source and edit the connection details. (In this
case, both Config and Atomic data sources need to be modified).

7. Restart the OFSAAI services.

14.17 Configuring Java Virtual Machine
While running several database intensive tasks in parallel, fetching the database connection from
connection pool may face an error. To ensure no such error is encountered, add the line
securerandom.source=file:/dev/./urandom in the java.security configuration file
available in $JAVA_HOME/jre/lib/security/ path.
This needs to be configured on all the machines or virtual machines where the OFSAAI database
components (ficdb layer) are installed.
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14.18 Configure Internal Service (Document Upload/ Download)
This step can be ignored if it has already been configured as part of any previous IR /ML
installation.
The Document Upload /Download feature has undergone a change and can now be configured to
use Internal service for document upload / download instead of the earlier ExeWebService.
To facilitate Internal service for document upload/ download, perform the following configurations:
1. Create the folders download, upload, TempDocument and Temp in the local path of
Web application server and provide Read/Write permission.


To find the exact location, execute the following query in CONFIG schema:
select localpath from web_server_info



To create folders with Read/Write permission, execute the command:
mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide
Read/Write permission.


To find the exact location, execute the query in CONFIG schema:
select ftpdrive from app_server_info



To create folder with Read/Write permission, execute the command:
mkdir -m 777 DocStorage

By default, the parameter DOCUMENT_SERVICE_TYPE_EXTERNAL value is set to FALSE in
the Configuration table in CONFIG schema and hence the application “ExeWebService” will not
be used. It is recommended that the value to be set to FALSE and use the Internal service for
document upload/ downloads. If you intend to continue using the External ExeWebService, set
the value to TRUE.
Navigate to $FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier and type
./ant.sh. This triggers the creation of EAR/WAR file EXEWebService.ear/.war. The EAR/WAR file
EXEWebService.ear/.war will be created in
$FIC_HOME/EXEWebService/<WEBSERVER_TYPE> directory of WEB tier. Redeploy the
generated EAR/WAR file onto your configured web application server.
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15 Appendix J - Patching Your OFS ALM Pack Installation
15.1 Patching Your OFS ALM Pack Installation
Oracle strongly recommends installing the latest available patch set so as to be up to date with
the various releases of the OFSAA Infrastructure product.
Refer http://support.oracle.com for more information on latest releases.

187

16

Appendix K - Grants for Atomic/ Config Schema
This Appendix includes the following sections:


Grants for Atomic Schema



Grants for Config Schema



Grants for Config Schema Entities for Atomic Users

16.1 Grants for Atomic Schema
Atomic Schema creation requires certain grants for object creation. This can be located in
$FIC_HOME/privileges_atomic_user.sql file
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
NOTE:

create SESSION to &database_username
create PROCEDURE to &database_username
create SEQUENCE to &database_username
create TABLE to &database_username
create TRIGGER to &database_username
create VIEW to &database_username
create MATERIALIZED VIEW to &database_username
olap_user to &database_username
select on SYS.V_$PARAMETER to &database_username
create SYNONYM to &database_username

If you intend to use Oracle OLAP feature, execute the following grant on all ATOMIC
schema(s): grant olap_user to &database_username

16.2 Grants for Config Schema
Config Schema creation requires certain grants for object creation. This can be located in
$FIC_HOME/privileges_config_user.sql file
The following are the Grants for Config Schema:
grant create SESSION to &database_username
/
grant create PROCEDURE to &database_username
/
grant create SEQUENCE to &database_username
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/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant

create TABLE to &database_username
create TRIGGER to &database_username
create VIEW to &database_username
create MATERIALIZED VIEW to &database_username
olap_user to &database_username
select on SYS.V_$PARAMETER to &database_username
create SYNONYM to &database_username

/

16.3 Grants on Config Schema Entities for Atomic Users
Atomic Schema creation requires certain grants for config schema object access. This can be
located in $FIC_HOME/config_table_privileges_for_atomic_user.sql file.
The following are the Grants for Config Schema entities for Atomic Users:
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
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select on CSSMS_USR_PROFILE to &database_username
select on CSSMS_ROLE_MAST to &database_username
select on CSSMS_GROUP_MAST to &database_username
select on CSSMS_FUNCTION_MAST to &database_username
select on CSSMS_USR_GROUP_MAP to &database_username
select on CSSMS_USR_GROUP_DSN_SEG_MAP to &database_username
select on CSSMS_ROLE_FUNCTION_MAP to &database_username
select on CSSMS_GROUP_ROLE_MAP to &database_username
select on CSSMS_SEGMENT_MAST to &database_username
select on BATCH_TASK to &database_username
select on CSSMS_USR_DSN_SEG_MAP to &database_username
select on CSSMS_USR_ROLE_MAP to &database_username
select on CSSMS_METADATA_SEGMENT_MAP to &database_username
select on BATCH_RUN to &database_username
select on PR2_FILTERS to &database_username
select on PR2_TASK_FILTER to &database_username

/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
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select on PR2_TASK_FILTER_DETAIL to &database_username
select on ST_STRESS_MASTER to &database_username
select on ST_SCENARIO_MASTER to &database_username
select on ST_SHOCK_MASTER to &database_username
select on BATCH_MASTER to &database_username
select on ICC_MESSAGELOG to &database_username
select on PR2_MASTER to &database_username
select on PR2_RUN_REQUEST to &database_username
select on MF_MODEL_SCRIPT_MASTER to &database_username
select on MF_INPUT_VALUES to &database_username
select on MF_MODEL_OUTPUT_VALUES to &database_username
select on DB_MASTER to &database_username
select on DSNMASTER to &database_username
select on pr2_rule_map to &database_username
delete on pr2_rule_map_pr to &database_username
insert on pr2_rule_map_pr to &database_username
update on pr2_rule_map_pr to &database_username
select on pr2_rule_map_pr to &database_username
delete on pr2_rule_map_pr_tmp to &database_username
insert on pr2_rule_map_pr_tmp to &database_username
update on pr2_rule_map_pr_tmp to &database_username
select on pr2_rule_map_pr_tmp to &database_username
select on pr2_rule_map_exclude to &database_username
delete on pr2_rule_map_exclude_pr to &database_username
insert on pr2_rule_map_exclude_pr to &database_username
update on pr2_rule_map_exclude_pr to &database_username
select on pr2_rule_map_exclude_pr to &database_username

grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
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delete on pr2_rule_map_exclude_pr_tmp to &database_username
insert on pr2_rule_map_exclude_pr_tmp to &database_username
update on pr2_rule_map_exclude_pr_tmp to &database_username
select on pr2_rule_map_exclude_pr_tmp to &database_username
select on pr2_run_object to &database_username
select on pr2_run_object_member to &database_username
select on pr2_run_map to &database_username
select on pr2_run_execution_b to &database_username
select on pr2_run_execution_filter to &database_username
select on pr2_firerun_filter to &database_username
select on pr2_filters to &database_username
select on configuration to &database_username
select on batch_parameter to &database_username
select on component_master to &database_username
select on MDB_OBJECT_TYPE_ATT_LAYOUT to &database_username
select on REV_OBJECT_ATTRIBUTE_DTL to &database_username
select on FORMS_LOCALE_MASTER to &database_username
select on mdb_object_dependencies to &database_username
select on mdb_execution_details to &database_username
select on REV_STAT_DATA to &database_username
select on REV_OBJECT_REPOSITORY_B to &database_username
select on REV_OBJECT_REPOSITORY_TL to &database_username
select on REV_OBJECT_ATTRIBUTE_DTL_MLS to &database_username
select on REV_OBJECT_APPLICATION_MAP to &database_username
select on MDB_OBJ_EXPR_DETAILS to &database_username
select on MDB_EXECUTION_DETAILS to &database_username
select on REV_OBJECT_TYPES_CD to &database_username
select on REV_OBJECT_TYPES_MLS to &database_username

/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
grant
/
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select on REV_APPLICATIONS_CD to &database_username
select on REV_APPLICATIONS_MLS to &database_username
select on METADATA_BROWSER_LOCALE to &database_username
select on MDB_STAT_DATA to &database_username
select on MDB_OBJECT_TYPE_LAYOUT to &database_username
select on ofsa_md_id_ref to &database_username
select on MDB_ETL_MAPPING to &database_username
select on setupinfo to &database_username
select on LOCALEREPOSITORY to &database_username
select on MF_MODEL_MASTER to &database_username
select on MF_SANDBOX_MASTER to &database_username
select on MF_VARIABLE_MASTER to &database_username
select on MF_TECHNIQUE_MASTER to &database_username
select on MDB_RULE_SOURCE_HEADER to &database_username
select on MDB_RULE_TARGET_HEADER to &database_username
select on MDB_RULE_TARGET_MEMBER_HEADER to &database_username
select on MDB_RULE_GRID_DATA to &database_username
select on MDB_MODEL_MAPPING to &database_username
delete on AAI_MAP_MAPPER to &database_username
insert on AAI_MAP_MAPPER to &database_username
update on AAI_MAP_MAPPER to &database_username
select on AAI_MAP_MAPPER to &database_username
select on RTI_UI_EXCLUDE_PDM_LIST
select on RTI_VIR_PHY_TBL_NAME

to &database_username

to &database_username

select on infodom_patches to &database_username

17 Appendix L - Configuring Application Pack XML Files
17.1 OFS_ALM_PACK.xml
The OFS_ALM_PACK.xml file holds details on the various products that are packaged together in
ALM Application Pack.
This section details the various tags/ parameters available in the file and the values that need to
be updated. Prior to installing the ALM Application Pack in SILENT mode, it is mandatory to
update this file.
Note: If you are installing in the GUI mode, then this file need not be updated.

Tag Name/ Attribute Name

APP_PACK_ID

Description

Unique

Mandatory

Default

(Y/ N)

Permissible Value

Y

Application

Value/

Comments

Unique Seeded

DO NOT modify

Value

this value.

Unique Seeded

DO NOT modify

Value

this value.

Unique Seeded

DO NOT modify

Value

this value.

Pack Identifier
APP_PACK_NAME

Unique

Y

Application
Pack Name
APP_PACK_DESCRIPTION

Unique
Application
Pack
Description
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Y

Tag Name/ Attribute Name

VERSION

Description

Unique release

Mandatory

Default

(Y/ N)

Permissible Value

Y

version
APP

Unique

Y

Application

Value/

Unique Seeded

DO NOT modify

Value

this value.

Unique Seeded

DO NOT

Value

remove these

Entries
APP_ID

Unique

Comments

tags.
Y

Application

Unique Seeded

DO NOT modify

Value

this value.

Unique Seeded

For most

Value

applications

Identifier
APP_ID/ PREREQ

Prerequisite

Y

Application/
Product

Infrastructure
would be the
prerequisite set.
For certain
other
applications, an
appropriate
Application ID
would be set.
DO NOT modify
this value.

APP_ID/ DEF_SEL_FLAG

Default

Y

Default - YES

Selected Flag

In all
Application
Packs,
Infrastructure
would have this
value set to
“YES”. DO NOT
modify this
value.

APP_ID/ ENABLE
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Enable

YES if

Default –

Set this

Application/

installing

YES for

attribute-value

Product

in

Infrastructure

to YES against

SILENT

NO for Others

every APP_ID

mode.

Permissible - YES

which is

or NO

licensed and

Tag Name/ Attribute Name

Description

Mandatory

Default

Value/

(Y/ N)

Permissible Value

Comments

should be
enabled for use.
Note:
Application/
Product once
enabled cannot
be disabled.
However,
Application/
Product not
enabled during
installation can
be enabled later
through the
Administration
UI.
APP_NAME

Unique

Y

Application/

Unique Seeded

DO NOT modify

Value

this value.

Unique Seeded

DO NOT modify

Value

this value.

Unique Seeded

DO NOT modify

Value

this value.

Product Name
APP_DESCRIPTION

Unique

Y

Application/
Product Name
VERSION

Unique release

Y

version

17.2 Configuring OFS_ALM_SCHEMA_IN.xml
Creating database schemas, objects within schemas and assigning appropriate grants are the
primary

steps

in

the

installation

process

of

OFSAA

Applications.

The

OFS_ALM_SCHEMA_IN.xml file contains details on the various application schemas that should
be created prior to the Application Pack installation.
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The following table gives details about the various tags/ parameters available in the file and the
values that need to be updated. Prior to executing the schema creator utility, it is mandatory to
update this file.
Tag

Name/

Description

Attribute Name

<APP_PACK_ID>

Seeded unique

Mandatory/

Default

Optional

Permissible Value

Y

Value/

Seeded

ID for the OFSAA

Comments

DO NOT modify
this value.

Application Pack
<JDBC_URL>

Enter the JDBC

Example,

Ensure to add an

URL.

jdbc:oracle:thin:@<HOS

entry (with SID/

Note: You can

T/IP>:<PORT>:<SID>

SERVICE

enter RAC and

or

NON-RAC
enabled database
connectivity URL.

Y

jdbc:oracle:thin:@//[HOS
T][:PORT]/SERVICE

tnsnames.ora file
on the OFSAA
server. The entry

or

should match

jdbc:oracle:thin:@(DESC

with the SID/

RIPTION=(ADDRESS_L

SERVICE NAME

IST=(ADDRESS=(PROT

used in the

OCOL=TCP)(HOST=[H

JDBC URL.

OST])(port=[PORT]))(AD
DRESS=(PROTOCOL=
TCP)(HOST=[HOST])(P
ORT=[PORT]))(LOAD_B
ALANCE=yes)(FAILOVE
R=yes))(CONNECT_DA
TA=(SERVICE_NAME=[
SERVICE])))
For example,
jdbc:oracle:thin:@//dbho
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NAME) in the

Tag

Name/

Description

Attribute Name

Mandatory/

Default

Optional

Permissible Value

Value/

Comments

st.server.com:1521/servi
ce1
or
jdbc:oracle:thin:@//dbsh
ost.server.com:1521/sca
n-1
or
jdbc:oracle:thin:@(DESC
RIPTION=(ADDRESS_L
IST=(ADDRESS=(PROT
OCOL=TCP)(HOST=dbh
ost1.server.com)(port=1
521))(ADDRESS=(PRO
TOCOL=TCP)(HOST=d
bhost2.server.com)(POR
T=1521))(LOAD_BALAN
CE=yes)(FAILOVER=ye
s))(CONNECT_DATA=(
SERVICE_NAME=servic
e1)))
<JDBC_DRIVER

By

>

driver

default

this

name

Y

is

seeded.

Example,

Only JDBC Thin

oracle.jdbc.driver.Oracle

Driver is

Driver

supported.

Note: Do not edit

DO NOT modify

this attribute

this value.

value.
<HOST>

Enter the

Y

Hostname/ IP

Host Name/ IP Address

Address of the
system on which
you are installing
the OFSAA
components.
<SETUPINFO>/

Identifies

PREFIX_SCHEM

value specified in

A_NAME

<SETUPINFO>/
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if

the

N

YES or NO

Default value is
YES

Tag

Name/

Description

Attribute Name

NAME

Mandatory/

Default

Value/

Optional

Permissible Value

Comments

attribute

should be prefixed
to

the

schema

name.
<SETUPINFO>/

Enter the acronym

NAME

for

Accepts strings with a

This name would

minimum length of two

appear in the

implementation.

and maximum of four.

OFSAA Landing

This

Example,

Page as

the

type

Y

of

information

will be displayed in

“Connected To:

DEV, SIT, PROD

the OFSAA Home

xxxx”

Page.

The schemas

Note: On

being created

executing the

would get this

schema creator

prefix. For E.g.

utility, this value

dev_ofsaaconf,

will be prefixed

uat_ofsaaconf

with each

etc.

schema name.
For example:
dev_ofsaaconf,
uat_ofsaaatm.
<PASSWORD>/

Enter

the

DEFAULT*

password if

you

want

to

default

set

N

The

maximum

length

allowed is 30 characters.

a

Special

password

characters

are

not allowed.

for all schemas.
Note:

You

also

need

to

set

APPLYSAMEFOR
ALL attribute as Y
to

apply

default
for

the

password
all

the

schemas.
<PASSWORD>/

Enter as Y if you

APPLYSAMEFO

want to apply the

RALL

password
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Y

Default – N

Note: Setting

Permissible – Y or N

this attribute
value is

Tag

Name/

Description

Attribute Name

Mandatory/

Default

Optional

Permissible Value

Value/

Comments

specified in

mandatory, If

DEFAULT

DEFAULT

attribute for all

attribute is set.

the schemas.
If you enter as N,
you need to
provide individual
passwords for all
schemas.

Note: In case you
have entered Y in
APPLYSAMEFO
RALL attribute
and also have
specified
individual
passwords for all
the schemas,
then the specified
individual
passwords will
take precedence.
<SCHEMA>/

The different

TYPE

types of schemas

Y

ATOMIC/CONFIG/SAND

Only One

BOX/ADDON

CONFIG

that are
supported in this
release are
ATOMIC,
CONFIG,
SANDBOX, and
ADDON.
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schema can
Note:
SANDBOX AND
ADDON schemas are
not applicable for OFS
AAAI Application Pack.

exist in the file.
This schema
identifies as the
CONFIGURATI
ON schema that
holds the

By default, the

OFSAA setup

schemas types

details and other

are seeded

metadata

based on the

information.

Application Pack.

Multiple

Tag

Name/

Description

Attribute Name

Mandatory/

Default

Optional

Permissible Value

Value/

Comments

Note: Do not edit

ATOMIC/

this attribute

SANDBOX/

value.

ADDON
schemas can
exist in the file.
ATOMIC
schema refers to
the Information
Domain schema.
SANDBOX
schema refers to
the SANDBOX
schema.
ADDON schema
refers to other
miscellaneous
schema (not
applicable for
this Application
Pack).
Note: The ALM
application Pack
supports only one
Atomic Schema.

<SCHEMA.>/

By default, the

The permissible length is

SETUPINFO/

NAME

schemas names

15 characters and only

NAME attribute

are seeded based

alphanumeric characters

value would be

on the Application

allowed. No special

prefixed to the

Pack.

characters allowed

schema name

You can edit the

except underscore ‘_’.

being created.

schema names if

For E.g. if name

required.

is set as

Note:
The Schema
Name will have a
prefix of the
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Y

‘ofsaaatm’ and
setupinfo as ‘uat’
then schema
being created
would be

Tag

Name/

Description

Attribute Name

Mandatory/

Default

Optional

Permissible Value

Value/

Comments

SETUPINFO/

‘uat_ofsaaatm’.

NAME attribute.

NAME should be

SCHEMA NAME

same where

must be same for

APP_GRP=1 for

all the ATOMIC

all SCHEMA

Schemas of

tags (Not

applications within

applicable for

an Application

this Application

Pack.

Pack).
The maximum length

Note: You need

password of the

allowed is 30 characters.

to mandatorily

schema to be

Special characters are

enter the

created.

not allowed.

password if you

<SCHEMA>/

Enter the

PASSWORD*

N

have set the

Note:

<PASSWORD>/

If this attribute is

APPLYSAMEFO

left blank, then

RALL attribute

the password

as N.

specified in the
<PASSWORD>/
DEFAULT
attribute is
applied as the
Schema
Password.

<SCHEMA>/

By

default,

the

Y

Unique Seeded Value

APP_ID

Application ID is

Application/

seeded based on

Product for

the

which the

Application

Pack.

schema is being

Note: Do not edit

created.

this attribute

DO NOT modify

value.

this value.

<SCHEMA>/

Enter the

DEFAULTTABLE
SPACE
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Identifies the

N

Default - USERS

Modify this value

available default

Permissible - Any

to associate any

tablespace for DB

existing valid tablespace

valid tablespace

Tag

Name/

Description

Attribute Name

Mandatory/

Default

Optional

Permissible Value

User.

Value/

Comments

name.

with the schema.

Default - TEMP

Modify this value

Note:
If this attribute is
left blank, then
USERS is set as
the default
tablespace.
<SCHEMA>/

Enter the

N

TEMPTABLESPA

available

Permissible - Any

to associate any

CE

temporary

existing valid temporary

valid tablespace

tablespace for the

tablespace name.

with the schema.

Example,

Modify this value

600M/m

to grant the

DB User.
Note:
If this attribute is
left blank, then
TEMP is set as
the default
tablespace.
<SCHEMA>/

Enter the quota to

QUOTA

be set on

N

DEFAULTTABLE

20G/g

SPACE attribute

UNLIMITED/unlimited

for the schema/

on the
mentioned

user. By default,

tablespace to the

the quota size is

user.

set to
500M.Minimum:
500M or
Unlimited on
default
Tablespace
<SCHEMA>/

Enter the name of

INFODOM

the Information

characters and only

Domain to

alphanumeric characters

associate this

allowed. No special

schema.

characters allowed.
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specified quota

N

Permissible length is 16

Tag

Name/

Description

Attribute Name

The schema
creator utility
automatically
derives an
Information
Domain Name
based on the
Application Pack
if no value is
specified for this
attribute.
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Mandatory/

Default

Optional

Permissible Value

Value/

Comments
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Appendix M - Configuring OFSAAI_InstallConfig.xml File

18.1 Configuring OFSAAI_InstallConfig.xml file
1. Navigate to OFS_ALM_PACK/OFS_AAI/conf/
2. Open the file OFSAAI_InstallConfig.xml in text editor.
3. Configure the OFSAAI_InstallConfig.xml:
4. You need to manually set the InteractionVariable parameter values as mentioned in the
table. If a value is not applicable, enter NA and ensure that the value is not entered as
NULL.
InteractionVariable
Name

Significance and Expected Value
<Layer name="GENERAL">

WEBAPPSERVERT

Identifies the web application server on which the OFSAA

YPE

Infrastructure web components would be deployed.

Mandatory

Yes

Following numeric value should be set depending on the
type:
Apache Tomcat = 1
IBM WebSphere Application Server = 2
Oracle WebLogic Server = 3
For example, <InteractionVariable
DBSERVER_IP

name="WEBAPPSERVERTYPE">3</InteractionVari able>
Identifies the hostname or IP address of the system on which

Yes

the Database Engine is hosted.
Note: For RAC Database , the value should be NA.
For example, <InteractionVariable name="DBSERVER_
IP">14.15.16.17</InteractionVariable> or
<InteractionVariable name="DBSERVER_
IP">dbhost.server.com</InteractionVariable
>
ORACLE_SID/SERVI

Identifies the Oracle DB Instance SID or SERVICE_NAME

CE_ NAME

Note: The Oracle_SID value should be exactly the same as it
is mentioned in JDBC_URL.
For example, <InteractionVariable
name="ORACLE_SID/SERVICE_
NAME">ofsaser</InteractionVariable>
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Yes

InteractionVariable
Name

ABS_DRIVER_PATH

Significance
Expected
Value
Identifies theand
directory
where
the JDBC driver

Mandatory
Yes

(ojdbc<version>.jar) exists. This would typically be the
$ORACLE_HOME/jdbc/lib
For example, <InteractionVariable name="ABS_DRIVER_
PATH">">/oradata6/revwb7/oracle
</InteractionVariable>
Note:

Refer

Appendix

P

for

identifying

the

correct

“ojdbc<version>.jar” version to be copied.
OLAP_SERVER_

Identifies if the OFSAA Infrastructure OLAP component needs

IMPLEMENTATION

to be configured depending on whether you intend to use the

No

OLAP feature. Following numeric value should be set
depending on the choice:
YES - 1
NO - 0
Note: If value for OLAP_SERVER_IMPLEMENTATIONis set to 1, it checks for following environment
variables are set in .profile:
ARBORPATH, HYPERION_HOME and ESSBASEPATH.
SFTP_ENABLE
Identifies if the SFTP (Secure File Transfer Protocol) feature

Yes

is to be enabled. Following numeric value should be set
depending on the choice:
SFTP - 1
FTP - 0
Note: The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle
recommends using SFTP instead of FTP because SFTP is considered more secure. However, a client
may choose to ignore this recommendation and to use FTP by setting SFTP_ENABLE to 0. This
selection may be changed later by using the OFSAAI administration interface.
FILE_TRANSFER_P

Identifies the port used for the file transfer service. The default

ORT

value specified is 22 (SFTP). Specify value as 21 or any other
PORT value if value for SFTP_ENABLE is 0.
For example, <InteractionVariable name="FILE_TRANSFER_
PORT">21</InteractionVariable>
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Yes

InteractionVariable
Name

LOCALE

Significance
Expected
Value to be used during the
Identifies theand
locale
information

Mandatory
Yes

installation. This release of the OFSAA Infrastructure supports
only US English.
For example, <InteractionVariable
name="LOCALE">en_US</InteractionVariable>
Note: Following ports are used internally by the various OFSAA Infrastructure services. Following
default values are set in the installation. If you intend to specify a different value, update the parameter
value accordingly and ensure this port value is in the range of 1025 to 65535and the respective port is
enabled.

JAVAPORT

9999

Yes

NATIVEPORT

6666

Yes

AGENTPORT

6510

Yes

ICCPORT

6507

Yes

ICCNATIVEPORT

6509

Yes

OLAPPORT

10101

Yes

MSGPORT

6501

Yes

ROUTERPORT

6500

Yes

AMPORT

6505

Yes

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted
CA and the same is configured on your web application server. For more details on configuring your
setup for HTTPS.
HTTPS_ENABLE

Identifies if the UI should be accessed using HTTP or HTTPS
scheme. The default value set is 0. Following numeric value
should be set depending on the choice:
YES - 1
NO - 0
For example, <InteractionVariable
name="HTTPS_ENABLE">0</InteractionVariable>
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Yes

InteractionVariable
Name

WEB_SERVER_IP

Significance
Expected
Identifies theand
HTTP
ServerValue
IP/ Hostname or Web Application

Mandatory
No

Server IP/ Hostname, to be used for accessing the UI. This IP
would typically be the HTTP Server IP.
If no separate HTTP Server is available, the value should be
Web Application Server IP/Hostname.
For example, <InteractionVariable name="WEB_SERVER_
IP">10.11.12.13</InteractionVariable>
or
<InteractionVariable name="WEB_SERVER_
IP">myweb.server.com</InteractionVariable>

WEB_SERVER_POR

Identifies the Web Server Port. This would typically be 80 for

T

non SSL and 443 for SSL. If no separate HTTP Server exists,

No

the value should be the port configured for Web Server.
Note: The port value will not be accepted as 80 if
HTTPS_ENABLE is 1 and as 443, if HTTPS_ENABLE is 0.
For example, <InteractionVariable name="WEB_
SERVER_PORT">80</InteractionVariable>
CONTEXT_NAME

Identifies the web application context name which will be used
to built the URL to access the OFSAA applications. Following
context name can be identified from a URL:
<scheme>://<host>:<port>/<context-name>/lo
gin.jsp
Sample URL:
https://myweb:443/ofsaadev/login.jsp
For example, <InteractionVariable name="CONTEXT_
NAME">ofsaadev</InteractionVariable>
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Yes

InteractionVariable
Name

WEBAPP_CONTEXT
_PATH

Significance
Expected
Value
Identifies theand
absolute
path
of the exploded .ear file on the

Mandatory
Yes

web application server.
For Tomcat, specify the Tomcat directory path till
/webapps, such as
/oradata6/revwb7/tomcat/webapps/.
For WebSphere, enter the WebSphere path as
<WebSphere profile directory>/installedApps/
<NodeCellName>. For example,
/data2/test//WebSphere/AppServer/profiles/
<Profile_
Name>/installedApps/aix-imfNode01Cell. Where aix-imf is
Host name.
For WebLogic, provide the WebLogic home directory path as
/<WebLogic home directory path>/bea/wlserver_10.3
Note: For WebLogic, value specified for this attribute is
ignored and value provided against attribute
WEBLOGIC_DOMAIN_HOME is considered.

WEB_LOCAL_PATH

Identifies the absolute path to any directory on the web

Yes

application server that can hold temporary files being
uploaded as part of the applications usage.
Note: In case of a clustered deployment, ensure this path and
directory is same on all the nodes.
WEBLOGIC_DOMAI

Identifies the WebLogic Domain Home. Specify the value only

Yes Specify

N_HOME

if WEBSERVERTYPE is set as 3 (WebLogic).

the value only

For example, <InteractionVariable

if

name="WEBLOGIC_DOMAIN_

WEBSERVER

HOME">/home/weblogic/bea/user_
projects/domains/mydomain
</InteractionVariable>
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TYPE is set
as 3
(WebLogic)

InteractionVariable
Name

OFSAAI_FTPSHARE
_PATH

Significance
Expected
Value
Identifies theand
absolute
path
to the directory identified as file

Mandatory
Yes

system stage area.
Note:
The directory should exist on the same system on which the
OFSAA Infrastructure is being installed (can be on a separate
mount).
The user mentioned in APP_SFTP_USER_ID parameter
below should have RWX permission on the directory.
For example, <InteractionVariable
name="APP_FTPSHARE_PATH">">/oradata6/revwb7/ftpshar
e</InteractionVariable>

OFSAAI_SFTP_USE

Identifies the user who has RWX permissions on the directory

R_ID

identified under parameter APP_FTPSHARE_PATH above.
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Yes

19 Appendix N – User Group Mapping
Application specific User Group mappings:
ALM:


ALM Administrator



ALMBI BI Analyst



ALMBI Data Analyst

ALM Administrator: The ALM Admin has following access to following screens and modules:
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ADCO Prepayments for ALM



ALM Access code for AAI



Application Preference: ALM Application Preference Admin, ALM Application Preference View



Rate Management: Add Currency, Add Currency Rate, Add Economic Indicator, Add Interest
Rate Copy Economic Indicator, Copy Interest Rate, Delete Currency, Delete Currency Rate,
Delete Economic Indicator, Delete Interest Rate, Edit Currency, Edit Currency Rate, Edit
Economic Indicator, Edit Interest Rate, Execute Economic Indicator Loader, Launch Currency
Rate Validation, Launch Interest Rate Loader, View Currency, View Currency Rate, View
Economic Indicator , View Interest Rate



Process Tuning: Add, Delete, Edit, View



Adjustment Rules: Add, Delete, Edit, SaveAs/Copy, View



Admin BI



Batch Maintenance: Add, Copy, Delete, Edit, Run, View, Batch Processing, Execute Batch



Behavior Pattern: Add, Delete, Edit, SaveAs/Copy, View



Migration Execution: Execute/Run, Cancel



Cash Flow: Add, Delete, Edit, Run, SaveAs/Copy, View



Authorize Map(s), Create Map, Delete Map, Modify Map



Defi Administrator



Detail Cash Flows: Add All Records/Products



Discount Methods: Add, Delete, Edit, SaveAs/Copy, View



Dynamic Deterministic : Add, Delete, Edit, Run, SaveAs/Copy, View



Dynamic Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View
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FSAPPS Home Page Link



Forecast Balances: Add, Delete, Edit, SaveAs/Copy, View



Forecast Rates: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Formula Results: Add, Delete, Edit, SaveAs/Copy, View



Fusion Attributes: Add, Delete, Edit, View, View Dependent Data



Fusion Expressions: Add, Delete, Edit, View, View Dependent Data



Fusion Filters: Add, Delete, Edit, View, View Dependent Data



Fusion Hierarchies: Add, Delete, Edit, View, View Dependent Data



Fusion Members: Add, Delete, Edit, View, View Dependent Data



Global Preferences: View



Holiday Maintenance Screen: Add, Delete, Edit, Run, Save As, View



MDB Screen, Metadata Publish



Maturity Mix: Add, Delete, Edit, SaveAs/Copy, View



Moody Integration for ALM



Object Migration: Copy Migration Ruleset, Create Migration Ruleset, Delete Migration Ruleset,
Edit Migration Ruleset, Home Page, Source Configuration, View Migration Ruleset



Operator Console



Payment Pattern: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Prepayment Models: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Prepayments: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Pricing Margin: Add, Delete, Edit, SaveAs/Copy, View



Product Characteristics: Add, Delete, Edit, SaveAs/Copy, View



Product Profiles: Add, Delete, Edit, SaveAs/Copy, View



Rate Dependency Patterns: Add, Delete, Edit, SaveAs/Copy, View



Repricing Pattern: Add, Delete, Edit, SaveAs/Copy, View



Static Deterministic Process: Add, Delete, Edit, Run, SaveAs/Copy, View



Static Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View



Stochastic Rate Index: Add, Delete, Edit, SaveAs/Copy, View



System Administrator



Time Buckets: Add, Delete, Edit, SaveAs/Copy, View



Transaction Strategy: Add, Delete, Edit, Run, SaveAs/Copy, View



Transfer Pricing: Add, Delete, Edit, Run, SaveAs/Copy, View



View ALM Tasks

ALM Analyst: The ALM Analyst has following access to following screens and modules:
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ALM Access code for AAI



ALM Application Preference: View



Adjustments: Add, Delete, Edit, SaveAs/Copy, View



Batch Maintenance: Add, Copy, Delete, Edit, Run, View



Behavior Pattern: View



Cash Flow Edits: Add, Delete, Edit, SaveAs/Copy, View



Defi Administrator



Discount Methods: Add, Delete, Edit, SaveAs/Copy, View



Dynamic Deterministic Process: Add, Delete, Edit, Run, SaveAs/Copy, View



Dynamic Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View



FSAPPS Home Page Link



Forecast Balances: Add, Delete, Edit, SaveAs/Copy, View



Forecast Rates: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Formula Results: Add, Delete, Edit, SaveAs/Copy, View



Fusion Attributes: View Dependent Data, View Attributes



Fusion Filters: View Dependent Data, View Filters



Fusion Hierarchies: View Dependent Data, View Hierarchies



Fusion Members: View Dependent Data, Fusion View Members



Fusion Expressions: View Dependency Expressions, View Expressions



Global Preferences: View



Maturity Mix: Add, Delete, Edit, SaveAs/Copy, View



Moody Integration for ALM



Payment Pattern: View



Prepayment Models: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Prepayments: Add, Delete, Edit, SaveAs/Copy, Seeded Loader, View



Prepayments: Add, Delete, Edit, SaveAs/Copy, View



Pricing Margin: Add, Delete, Edit, SaveAs/Copy, View



Product Characteristics: Add, Delete, Edit, SaveAs/Copy, View



Product Profiles: View



Rate Dependency Patterns: Add, Delete, Edit, SaveAs/Copy, View



Repricing Pattern: View



Static Deterministic Process: Add, Delete, Edit, Run, SaveAs/Copy, View



Static Stochastic Process: Add, Delete, Edit, Run, SaveAs/Copy, View



Stochastic Rate Index: Add, Delete, Edit, SaveAs/Copy, View



System Administrator



Time Buckets: Edit , View



Transaction Strategy: Add, Delete, Edit, SaveAs/Copy, View



Transfer Pricing: Add, Delete, Edit, SaveAs/Copy, View



View ALM Tasks



View CFE Tasks



Rate Management: View Currency, View Currency Rate, View Economic Indicator, View Interest
Rate



Process Tuning: View

ALM Auditor: The ALM Auditor has following access to following screens and modules:
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ALM Access code for AAI



ALM Application Preference View



Adjustments: View
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Batch Maintenance: Copy, View



Behavior Pattern: View



Cash Flow Edits: View



Defi Administrator



Discount Methods: View



Dynamic Deterministic Process: View



Dynamic Stochastic Process: View



FSAPPS Home Page Link



Forecast Balances: View



Forecast Rates: View



Formula Results: View



Fusion Attributes: View Dependent Data, View Attributes



Fusion Filters: View Dependent Data, View Filters



Fusion Hierarchies: View Dependent Data, View Hierarchies



Fusion Members: View Dependent Data, View Members



Fusion Expressions: View Dependency Expressions, View Expressions



Global Preferences: View



Maturity Mix: View



Object Migration: View Migration Ruleset



Payment Pattern: View



Prepayment Models: View



Prepayments: View



Pricing Margin: View



Product Characteristics: View



Product Profiles: View



Rate Dependency Patterns: View



Static Deterministic Process: View



Static Stochastic Process: View



Stochastic Rate Index: View



System Administrator



Time Buckets: Edit, view



Transaction Strategy: View



Transfer Pricing: View



View ALM Tasks



Rate Management: View Currency, View Currency Rate, View Economic Indicator, View Interest
Rate



Process Tuning: View

Note: For more information on user group mapping, refer to Security Management section of OFAAI User
Guide.

ALMBI:
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ALMBI Administrator



ALMBI BI Analyst



ALMBI Data Analyst
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Appendix O - Migration for Excel Upload
This appendix provides detailed instructions to migrate for excel upload.

20.1.1 Prerequisites
The following are the prerequisites for migration:


Data model in ATOMIC schemas should be same on the source and target setups.



OFS AAI (platform) patch level version should be same on the source and target setups.



PL/SQL Developer to connect and query the database.



WinSCP to connect and access server file system.

20.1.2 Migration for Excel Upload
To migrate, follow these steps:
1. Open PL/SQL Developer and logon to the source setup’s configuration (CONFIG)
schema by entering the appropriate username and password.
2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER.
3. Open a new session in PL/SQL developer and logon to the target setup’s configuration
(CONFIG) schema by entering the appropriate username and password.
4. Insert the records from Step 1 above in to this table.
5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name
with the target infodom name.
NOTE:

If all the mappings can work out of the single target Infodom, update same Infodom value
across all rows. If only few mappings will work out of the target infodom, update the infodom
value for selective records. Excel upload mappings will work only if the target infodom has
same data model entities as used in the mappings defined on source setup.
6. Update V_CREATED_BY column with the name of any user present in the target setup
that has appropriate roles to perform Excel Upload tasks.

NOTE:

It is mandatory to update values for V_INFODOM and V_CREATED_BY columns.
7. Open WinSCP and login a new session by entering the host name, port number, user
name and password to access the source setup.
8. Navigate to the folder referred as FTPSHARE.
9. Copy the excel-entity mapping xml file(s) which are located in this folder according to
their folder structure on to your desktop. For example: /ftpshare
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml
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NOTE:

Actual file name of Excel Sheet is mentioned in the V_EXCEL_NAME column of
EXCEL_MAPPING_MASTER table.
10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder according to
their folder structure on to your desktop. For example:
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

NOTE:

.xls/.xlsx files should be copied to the path as per the local path given in your webserverinfo
table of config schema. Ignore this step if files are not present at the location.
11. Login a new session in WinSCP by entering the host name, port number, user name
and password to access the target setup.
12. Copy the xml file(s) from Step3 to the following location in the target setup. For
example:
/ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_NAME
.xml

NOTE:

$TARGET_INFODOM_NAME should be target setup infodom in which you have uploaded the
appropriate data model and the name should be same as the V_INFODOM column value
updated in EXCEL_MAPPING_MASTER table.
13. Copy the xls/ xlsx file(s) from Step 3 to the following location in target setup. For
example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

NOTE:
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Ignore this step if files are not present at the location.
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Appendix P - JDBC Jar Files
The ojdbc<version>.jar file should be copied based on Database & Java version. Refer to
the following table for details.

Oracle

Database

JDK/JRE Version

JDBC

version

Jar

files

specific

release

12.1 or 12cR1

JDK 8, JDK 7 and JDK 8

ojdbc7.jar for JDK 7/JDK 8

11.2 or 11gR2

JDK 7 supported in 11.2.0.3 and

ojdbc6.jar for JDK 7

11.2.0.4
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to

the
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Appendix Q - Upgrading an Existing OFSAA 8.0.x Java 7
Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x Java 7 instance to
Java 8. It consists of the following topics:


Prerequisites



Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8



Web Application Server Configurations



OFSAA Generic Configurations



OFSAA Configurations for New Web Application Server Installation

22.1 Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 8:


Java 8 should be installed on the OFSAA server and Web Application Server.



Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 18729264 from
http://support.oracle.com/

Note: IBM WebSphere 8.5.x (Full Profile) on Java 8 is not available.

22.2 Steps for upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:
1. Configure Web Application Server to Java 8. For more information, refer Web Application Server
Configurations.
2. Configure the OFSAA instance to Java 8. For more information, refer OFSAA Generic
Configurations. For a newly installed Web Application Server, refer OFSAA Configurations for
New Web Application Server Installation
3. Restart the OFSAA services. For more information, refer the Start/Stop Infrastructure Services
section in Appendix D
4. Generate the application EAR/WAR file and redeploy the application onto your configured web
application server. For more information on generating and deploying EAR / WAR file, refer
Appendix C.

22.3 Web Application Server Configurations
This section describes the changes to be made in the Web Application Server. Following are the two
options to perform Web Application Server Configurations which are listed as follows:


Upgrade the existing Web Application Server installation to Java 8



Install a new instance of the Web Application Server with Java 8
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This section consists of the following topics:


Oracle WebLogic Server Updates



Apache Tomcat Server Updates

22.3.1 Oracle WebLogic Server Updates
Perform the following configurations to upgrade the existing WebLogic server instance to Java 8:
1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.
2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, JAVAHOME properties to
the new Java path and java.vm.version to the new Java version. For example,
JAVA_HOME=/usr/java/jre1.8.0_45
WLS_JAVA_HOME=/usr/java/jre1.8.0_45
JAVAHOME=/usr/java/jrel1.8.0_45
java.vm.version=1.8.0_45

3. Navigate

to

<WLS_HOME>/Middleware/Oracle_Home/user_projects/domains/<domain>/bin.

Update SUN_JAVA_HOME, DEFAULT_JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file
to point to the new Java path. For example,
SUN_JAVA_HOME="/usr/java/jre1.8.0_45"
DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45"
JAVA_HOME="/usr/java/jre1.8.0_45"
4. Clear the Application cache. Navigate to the following path and delete the files:
<Weblogic

installation

location>/domains/<Domain

name>/servers/<Server

name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:
1. Install Oracle WebLogic Server 12.1.3.x on Java 8.
2. Perform the configurations for the newly installed WebLogic server. For more information refer
Configuring Resource Reference in Weblogic Application Server.
Note: While creating WebLogic Domain, the Listen Port should be set same as that of the existing
Domain.
Note down the new Domain path to perform OFSAA Configurations.

22.3.2 Apache Tomcat Server Updates
Perform the following configurations to upgrade the existing Apache Tomcat Server from Java 7 to Java
8:
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1.
2.

Login to the Apache Tomcat Server as a non-root user.
Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. For
Example,
JAVA_HOME=/usr/java/jre1.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:
<Tomcat installation folder>/work/Catalina/localhost/<Application
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:
1. Install Apache Tomcat Server 8 with Java 8.
2. Perform the configurations for the newly installed Tomcat server. For more information refer
Configuring Resource Reference in Tomcat Application Server.
Note: Update the Connector Port in /apache-tomcat-8.0.21/conf/server.xml file to that of the existing
Tomcat instance. Note down the new deployment path to perform OFSAA Configurations.

22.4 OFSAA Generic Configurations
This section consists of the following topics:


User .profile Settings



Configurations for Java 8

22.4.1 User .profile Settings
Perform the following configurations:
1. Login to the OFSAA Server as a non-root user.
2. Edit the user .profile. Update the value for PATH variable from JRE 1.7 to JRE 1.8. For
Example,
PATH=/usr/java/jre1.8.0_45/jre
JAVA_BIN=/usr/java/jre1.8.0_45/jre/bin
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre1.8.0_45/jre/lib/amd64/se
rver

22.4.2 Configurations for Java 8
Perform the configurations explained in the section Configurations for Java 8

22.5 OFSAA Configurations for New Web Application Server Installation
This configuration is required only if you have freshly installed Oracle WebLogic 12.1.3 or Apache Tomcat
Server 8.0. Follow these steps:
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1. Modify the following parameters in the Configuration table present in the Config Schema with the
new Domain Path in case of WebLogic or with the new deployment path in case of Tomcat:
 DeFiHome


REV_IMG_PATH



EMBEDDED_JSP_JS_PATH

2. Login to the OFSAA Server as a non-root user.
3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following parameters in
the web.xml file with the new Domain path in case of WebLogic or with the new deployment
path in case of Tomcat:
 FIC_PHYSICAL_HOME_LOC


FIC_HOME



ICC_SERVLET_LOG_FILE

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path in case of
WebLogic or with the new deployment path in case of Tomcat:
 OFSAALogger.xml


MDBLogger.xml



RevLog4jConfig.xml



RFDLogger.xml



ExportLog4jConfig.xml



RFDLogger.xml



PR2Logger.xml
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Appendix R - Removing OFSAA
This chapter includes the following sections:


Uninstalling OFSAA Infrastructure



Uninstalling EAR Files in WebSphere



Uninstalling EAR Files in WebLogic



Uninstalling WAR Files in Tomcat

23.1 Uninstalling OFSAA Infrastructure
This section will guide you through the necessary steps to uninstall the OFSAA Infrastructure product.
Before you start the uninstallation process, ensure that no open connections exist to the OFSAA
Infrastructure Config and Atomic Schemas and Infrastructure services are brought down.
To uninstall OFSAA Infrastructure:
1. Log in to the system as non-root user.
2. Navigate to the $FIC_HOME directory and execute the command:
./Uninstall.sh
3. Enter the password for OFSAAI Configuration Schema when prompted as shown in the following
figure.

Figure 101: Uninstalling OFSAA Infrastructure

Note:


Uninstallation does not remove the Infrastructure application from the Web Application Server.
This has to be done manually.
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The entries in the .profile file will have to be removed manually.



The files/ folders under the file system staging area (ftpshare) have to be deleted manually.



All the Database objects from Atomic Schemas have to be dropped manually.

23.2 Uninstalling EAR Files in WebSphere
Following are the steps to uninstall any previously deployed application:
1. Open the URL in the browser window: http://<ipaddress>:<Administrative Console
Port>/ibm/console (https if SSL is enabled). The Login window is displayed.
2. Login with the user id that has admin rights.
3. Expand Applications > Application Types > WebSphere enterprise applications from the LHS.
The Enterprise Applications window is displayed with all the deployed applications.

Figure 102: Enterprise Applications

4. Select the checkbox adjacent to the application to be uninstalled and click Stop.
5. Click Uninstall. The Uninstall Application window is displayed.
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Figure 103: Uninstall Application

6. Click OK to confirm.
7. Click Save to save the master file configuration.

23.3 Uninstalling EAR Files in WebLogic
On the machine that hosts WebLogic, perform the following steps to uninstall any previously deployed
application:
1. Open

the

URL

in

the

browser

window:

http://<ipaddress>:<admin

server

port>/console (https if SSL is enabled). The Login window of the WebLogic Server
Administration Console is displayed.
2. Login with the WebLogic user credentials having administrator privileges.
3. From the Domain Structure LHS menu, click Deployments. The Summary of Deployments
screen is displayed.

Figure 104: Summary of Deployments
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4. Select the checkbox adjacent to the application to be uninstalled and click Stop> Force Stop
Now.
5. Click Yes in the confirmation dialog to stop the selected deployment.

Figure 105: Summary of Deployments- Messages

6. Select the checkbox adjacent to the application and click Delete to delete the selected
deployment.
7. Click Yes in the confirmation dialog to remove the selected deployment from the domain
configuration.

23.4 Uninstalling WAR Files in Tomcat
On the machine that hosts Tomcat, perform the following steps to uninstall any previously deployed
application:
1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf directory
to avoid conflict during undeploy and re-deploy of the WAR file.
Place comment <!-- --> in between the context path section. For example:
<!-<Context

path

="/<context

Directory>/webapps/<context

name>"
name>"

docBase="<Tomcat
debug="0"

crossContext="true">
<Resource auth="Container"
name="jdbc/FICMASTER"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
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reloadable="true"

username="<user id for the configuration schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
<Resource auth="Container"
name="jdbc/< INFORMATION DOMAIN NAME >"
type="javax.sql.DataSource"
driverClassName="oracle.jdbc.driver.OracleDriver"
username="<user id for the atomic schema>"
password="<password for the above user id>"
url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"
maxTotal="100"
maxIdle="30"
maxWaitMillis="10000"/>
</Context>
-->
Restart the Tomcat service by doing the following:
a. Login to the "Unix server" through a terminal emulator.
b. Navigate to $catalina_home/bin directory.
c.

Stop the tomcat services using the command ./shutdown.sh

d. Start the tomcat services using the command ./startup.sh
2. Open the URL in a browser window: http://<IP address>:<Tomcat server port>.
(https if SSL is enabled). The Tomcat home window is displayed.
3. Click the Manager App. The Connect to window is displayed.
4. Login with the user credentials having admin rights. The Tomcat Web Application Manager
window is displayed with the list of all applications deployed in Tomcat.
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Figure 106: Tomcat Web Application Manager

5. Click the Undeploy link against the deployed Infrastructure application. A confirmation message
is displayed on the application /Infrastructure being uninstalled.
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Appendix S - FAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions and error codes
noticed during OFSAAI installation.


Frequently Asked Questions



Forms Framework FAQs



Error Dictionary

OFSAAI installer performs all the prerequisite validation check during installation. Any errors encountered
in the process is displayed with an appropriate Error Code. You can refer to the Error Dictionary to find
the exact cause and resolution to rectify the error.

24.1 Frequently Asked Questions
You can refer to the Frequently Asked Questions which has been developed with the interest to help you
resolve some of the OFSAAI Installation and configuration issues. This intends to share the knowledge of
problem resolution to a few of the known issues. This is not an official support document and just
attempts to share the knowledge of problem resolution to a few of the known issues.
This section includes the following topics:


OFSAAI FAQs



Application Pack 8.0.0.0.0 FAQs

24.1.1 OFSAAI FAQs
What are the different components that get installed during OFSAAI?
The different components of OFSAAI are illustrated in Figure 1–2, "Components of OFSAAI".
What are the different modes of OFSAAI installation?
OFSAAI can be installed in two modes, Silent Mode, and GUI mode.
Can the OFSAA Infrastructure components be installed on multi-tier?
No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on multi-tier. By default,
they will be installed on single-tier. However, OFSAA Infrastructure can be deployed within the n-Tier
architecture where the Database, Web Server and Web Application Server is installed on separate tiers.
Is JDK (Java Development Kit) required during installation of OFSAA? Can it be uninstalled after
OFSAA installation?
JDK is not required during installation of OFSAA and only a run time is needed. For details, refer to
Hardware and Software Requirements, Java Runtime Environment section.
Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI installation?
Only JRE (Java Runtime Environment) is required during installation of OFSAA and cannot be uninstalled
as the JRE is used by the OFSAA system to work.
How do I know what are the Operating system, webservers and other software versions that
OFSAA supports?
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Refer to OFSAA Technology Stack Matrices.
What are the different files required to install OFSAAI?
The following files are required:













setup.sh.
envCheck.sh
preinstallcheck.sh
VerInfo.txt
OFSAAInfrastructure.bin
validatedXMLinputs.jar
MyResources_en_US.properties
log4j.xml
OFSAAI_PostInstallConfig.xml
OFSAAI_InstallConfig.xml
privileges_config_user.sql
privileges_atomic_user.sql

What should I do if I get the following error message during installation:
"Execute Permission denied"?
Check whether all the files provided for OFSAAI installation have execute permissions.
To give execute permissions,
Navigate to the path OFSAAI_80000 and execute the command
chmod 755
"Graphical installers are not.."
If error resembles "Graphical installers are not supported by the VM. The console mode will be used
instead..." then check whether any of the X-windows software has been installed.
Example: Hummingbird Exceed is started and configured to Graphical mode installation.
Note:
Type 'xclock' from prompt and this should display clock in graphical mode.
"No Java virtual machine could be…"
If the error message reads "No Java virtual machine could be found from your PATH environment
variable. You must install a VM prior to running this program", then




Check whether "java path" is set in PATH variable. See the Table 3–1, "Prerequisite
Information" section in this document.
Check whether sufficient temporary space is available.
Ensure that the movement of OFSAAI Installer text files to the target system is done in the
Text mode so that setup.sh file does not contain control line feed characters (^M).

What should I do if I get the following error message during installation, "OracleDriver Files
Not Found, Please Choose the Right Path To Continue"?
Check whether the provided path for Oracle Driver files is correct and whether the user has
permissions to access the files.
What should I do if I get the following error message during installation, "User must have
CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, CREATE SEQUENCE,
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CREATE PROCEDURE" even though the oracle schema user created has the mentioned
privileges?
OFSAAI installer validates the database details provided during installation, so ensure:



Whether the oracle schema user has the required set of privileges for successful
installation.
Whether the oracle schema user has been created with quota privileges on tablespace to
create database objects.

See the Table 3–1, " Prerequisite Information" section in this document.
Installation of OFSAAI was completed successfully! What next?
Post the successful completion of OFSAAI installation, one has to perform the Post Installation
steps. See Chapter 5, "Post Installation Configuration".
What is to be done when OFSAAI Installation is unsuccessful?
OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the Infrastructure
installation directory. There is also another log file created in the path configured in Log4j.xml. If
the logs of any of these reported, Warnings, Non Fatal Errors, Fatal Errors or Exceptions, they
should be brought to the notice of the OFSAAI Oracle Support Services. It is recommended not to
proceed, until the reported problems are adequately addressed.
How do I completely uninstall OFSAAI?
OFSAAI can be completely uninstalled by performing the steps provided in Uninstalling OFSAA
Installation section in this guide.
Can OFSAAI config and atomic schemas be on different databases?
OFSAAI requires both config and atomic schemas to be present on the same database instance.
How do I grant privileges if a new information domain is created?
If you are creating a new information domain, provide a set of privileges (database permissions) to
the new Atomic schema.




Log into the database as sys and connect as sysdba user.
Execute the file privileges_config_user.sql available under $FIC_HOME directory
Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?
See the Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide
available on OTN.
Does OFSAAI support Oracle Linux versions other than 5.5?
OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 and above.
What should I do if I get the following error message on the UNIX System terminal while
executing ./setup.sh, "Insert New Media. Please insert Disk1 or type its location"?
1. Login as root user on the Unix machine where OFSAAI is getting installed.
2. Navigate to the path /etc/security/.
3. Edit the file limits.conf to add/edit a row for the unix user installing OFSAA:
<Unix User> soft nofile 9216
4. After saving the changes, log in as unix user with which OFSAAI is getting installed and
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execute the command:
ulimit -n
The command should return the value 9216.
How does one verify if the system environment is ready for OFSAAI installation?
To verify the system environment meets the minimum requirements for the installation, a PreInstall Check utility is available within the Install Kit archive file. This utility can also be obtained
separately by contacting Oracle Support.
See Verifying System Environment section for additional information.
How do I know if the installation is completed successfully?
The OFSAA Infrastructure installation performs a post install health check automatically on
successful installation of the product. To rerun the post install verification at a later time, perform
the following steps:
1. Navigate to the path $FIC_HOME (Product Installation Directory).
2. Execute the command:
./piverify.sh
What should one do if the installation in GUI mode is not invoked?
There are set of configuration steps required to be performed during the installation in GUI mode.
Verify whether the steps mentioned under Configuration for GUI Mode Installation section are
done correctly.
What should one do if there are any exceptions or errors in installation and how to
proceed?
1. Please backup the installation logs.
2. Share the backup logs with Oracle Support Services.
What should I do if I get the following error message during OFSAAI installation on Solaris
11 system?:
"Error: OFSAAI-1108
ORA-00604: error occurred at recursive SQL level 1
ORA-01882: timezone region not found"
Or
"Time zone cannot be set as null or 'localtime' "
This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set the environment
variable TZ to a valid time zone region in the .profile file. For example,
TZ=Asia/Calcutta
export TZ
What should I do if the installation process is abruptly terminated or aborted?
If the installation process is abruptly terminated, then the installation will be incomplete. To recover
from this, follow these steps:
1. Drop the DB objects in the config schema created by OFSAAI installation.
2. Open the .profile and remove the entries made by the OFSAAI installation which are
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made between the comment statements, #Beginning of entries by OFSAA Infrastructure
installation and #End of entries by OFSAA Infrastructure installation.
3. Delete the OFSAA install directory created by the OFSAAI installer.
4. Perform the OFSAAI installation again.
Does OFSAA support any other web server types, other than the ones stated in Tech Matrix
and Installation Guide?
No, all the supported softwares and versions are stated in the OFSAA Technology Stack Matrices.
What should one do if the database connection from connection pool throws an error
"java.sql.SQLRecoverableException: IO Error: Connection reset"?
This happens while running several database intensive tasks in parallel. To correct this error, add
the line securerandom.source=file:/dev/./urandom in the java.security configuration file available in
$JAVA_HOME/jre/lib/security/ path.
Note: This needs to be configured on all the machines or VMs where the OFSAAI components are
installed.
If the issue is not resolved even with the above settings, check the MTU(Maximum Transmission
Unit) settings on the linux box. For details on MTU settings and updating them, contact your
system Administrator.
What should I do when I get syntax errors/file not found error messages while invoking
setup.sh file from my install archive?
This could mostly happen:
When installer was not unzipped rightly or corrupted during unzip.
setup.sh file which resides within the install archive was not transferred in ASCII or text mode,
which could have corrupted the file.
To correct this, follow the steps:
A. Copy the installer (in BINARY mode) to the system on which the OFSAA Infrastructure
components will be installed.
B. Unzip the installer using the command:
unzip <OFSAAI_Installer>.zip
C. The corrupted setup.sh file would have introduced certain ^M characters into the file. You
can remove ^M characters from setup.sh file by following these steps:
a. Login to the server where the installer is copied.
b. Navigate to the directory OFSAAI_80000.
c. Open the setup.sh file in the vi editor using the command: vi setup.sh.
d. Inside vi editor in Esc mode, type: %s/^M//g
Note:
To enter ^M, hold the CTRL key then press V and M in succession.

e. Save the setup.sh file by typing: wq!
Does OFSAA support Oracle DB 11g Standard edition?
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The OCI client and the jdbc driver does not change depending on whether it is a standard or enterprise
edition. So, OFSAAI will work with standard edition as well.
We do not recommend standard edition because it will not scale and does not support partition pack,
database security vault, or advanced analytics.
What should I do if I get the following error message while executing ./startofsaai.sh file on the
UNIX System terminal “./startofsaai.sh: /java: Execute permission denied"?


Ensure JAVA_BIN environment variable path is set on the "unix user" terminal from where the
startofsaai.sh file is invoked.



Ensure the .profile where the environment/ path settings are made has been executed
successfully.

What should I do if the OFSAAI Application Server does not proceed even after providing the
system password?
Ensure that the System Password provided when prompted should match with the "Oracle Configuration
password" provided during installation. Also check whether the connection to the "configuration schema"
can be established through sqlplus.
Although the OFSAAI installation has completed successfully, when OFSAAI servers are started,
and the application URL is accessed, it gives an error message "the page cannot be found or
displayed" or "Could not retrieve list of languages from Server. Please contact the system
administrator". What should one do?
Ensure OFSAAI servers have been started and are running successfully. For details on start up
parameters options, refer to Starting Infrastructure Services section.
For more details on the issue, refer to the Revappserver log in $FIC_APP_
HOME/common/FICServer/logs directory or the Web Server log files.
Is it necessary to provide the specified grants to the Oracle schema user before installation? If
yes, can it be revoked after completion of installation?
The "Oracle schema" user requires the necessary grants specified before, during, and after the
installation process. Grants provided should never be revoked as the application makes use of these
grants all the time.
Can we have distributed OFSAAI Application Server for load balancing?
OFSAAI Application server can be scaled out/distributed across different JVM's (machines) based on the
various services and Information Domains, in other words, Load balancing can be achieved with
distribution of services.
Why do we need FTPSHARE? Why is it needed on all the layers? Can we have ftpshare on another
machine other than the machines where OFSAAI is installed?
FTPSHARE is a Metadata Repository directory. All the metadata related files used in Infrastructure are
stored in the ftpshare directory. The FTPSHARE contains folders for each Information Domain, with each
Information Domain folders holding Erwin, log, and scripts folder. The transfer of data among the Web,
Application, and Database servers in Infrastructure takes place through FTP/SFTP.
You need to configure FTP/SFTP and enable communication between the servers by providing App
server's FTP/SFTP credentials to the Web server and DB server users.
Yes, we can have FTPSHARE on another machine other than the machines where OFSAAI is installed.
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Is it mandatory to provide the FTP/SFTP password?
Yes, OFSAAI needs credentials of the user who has complete permissions on ftpshare directory, and the
user should be able to independently login to the unix server.
What are the permissions required for FTPSHARE and when should I give them?
It is recommended to provide permissions on FTPSHARE in case of installations done across different
machines or VMs (multitier installation ).
In case of single tier installation, 770 permissions can be provided if the Unix users of OFSAAI and web
server belong to the same Unix group.
Additionally any new file that is created in the FTPSHARE folder of any installation layer should be
granted specific/explicit permission.
Port Change utility can be used to have the Port number modified, which are currently being used by the
Infrastructure application. For more information, refer to Changing IP/ Hostname, Ports, Deployed Paths
of the OFSAA Instance section in OFS Analytical Applications Infrastructure Administration User Guide in
OTN.
Are there any in-built system administration users within OFSAAI Application?
The three in-built system administration users are provided to configure and setup OFSAAI.




SYSADMN
SYSAUTH
GUEST

Does OFSAAI Application support both FTP and SFTP?
OFSAAI supports both FTP and SFTP configuration.
Is it necessary to enable the FTP/SFTP services to use the OFSAAI?
Yes, enabling of FTP/SFTP services and its ports is a prerequisite step towards using the OFSAAI.
OFSAAI Configuration: Unable to save the server details?
Ensure the input User ID, Password, and Share Name are correct.



Ensure FTP/SFTP services are enabled.
Have a test FTP/SFTP connection made and confirm if they are successful.

What should I do if I get the following message message while creating Information Domain,
"Please create a database and then create the information domain"?
Information Domain is mapped to only one Database; and thus before the creation of Information Domain,
at least one database details should exist.
What should I do if I get the following message during startup of backend engine message server,
"ConnectToDatabase: FatalError, could not connect to the DB server"?





Verify whether connection to the "Configuration Schema" can be established through SQL*Plus.
Verify "Configuration Schema" password is modified post installation.
Ensure Oracle Database Alias Name created for oracle instance and Oracle Service Name are
same.
On a multi tier Installation mode, ensure TNSNAME and SID are same in both the Application
and Database Layers.

What should I do if I get the following message during the startup of backend engine message
server, "Fatal Error, failed to get user ID from LibSmsConnect"?
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Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the Database components
are installed.
Does OFSAAI Application support LDAP authentication?
OFSAAI supports LDAP configuration and authentication.
Does OFSAAI support multiple languages?
Yes, OFSAAI supports multiple languages.
Does OFSAAI provide any data back-up features?
OFSAAI does not have built-in back up facility. External Storage Infrastructure is recommended for backup.
What kind of security features does the OFSAAI provides?
OFSAAI provides security at:



Segment Level - Users can access only the segment they are mapped to.
Application Level - Users can perform an operation only if mapped to appropriate role and
functions.

Does OFSAAI have the ability to enforce periodic password change?
OFSAAI provides configurable parameters to define number of days after which the user password would
expire and then the user is forced to change the password after expiration period.
What is the password policy followed in OFSAAI?
OFSAAI enforces a minimum password length with a combination of Upper and Lower case characters
and alpha-numeric strings.
Which version of Erwin Data Modeller does OFSAAI support?
OFSAAI now supports ERwin version 9.2 and 9.5 generated XMLs in addition to ERwin 4.1, ERwin 7.1,
ERwin 7.3 and ERwin 9.0 formats.
Does OFSAAI provide the mechanism to upload Business Data model?
OFSAAI provides two mechanisms for business data model upload:



Easy to use GUI based Model upload mechanism to upload the Business Data Model through
Data Model Management  Data Model MaintenanceImport Model.
OFSAAI also provides a model upload utility "upload.sh" for uploading the business data model
through the command line parameter by executing this shell script file under the path
<FIC_HOME>/ficapp/common/FICServer/bin.

For more details, refer to Configuration for Model Upload Utility section of the Oracle Financial Services
Analytical Applications Infrastructure User Guide on OTN.
How do I apply incremental change to the existing model when the Business Data model
undergoes a change?
Modified data model can be uploaded into the system and OFSAAI has the ability to compare the
changes within the data model with respect to the one already present in the system and enables
propagation of incremental changes in a consistent manner.
What are the different types of uploading a business data Model?
OFSAAI supports uploading of business data model from client desktop and also by picking up the data
model from the server location.
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Can the OFSAAI "Configuration Schema" password be modified post installation?
The OFSAAI "Configuration Schema" password can be modified post installation. OFSAAI application
stores the password in the database and few configuration files, thus any changes to the "Configuration
Schema" password will require updating in those files. Contact Oracle Support Services for more details.
Can the OFSAAI Atomic Schema password be modified?
The OFSAAI Atomic Schema password can be modified. OFSAAI application stores the atomic schema
password in the database and few configuration files, thus any change to the atomic schema password
will require updating those files.
To change the Atomic Schema password, follow the steps:
1. Login to OFSAA.
2. Navigate to System Configuration > Database Details window. Select the appropriate connection,
provide the modified password and save.
3. Navigate to Unified Metadata Manager > Technical Metadata> Data Integrator > Define Sources
window.
4. Based on the Web Server installed, follow the steps:
If you are using Apache Tomcat as Web server:
*Update the <Context> -> Resource tag details in server.xml file from the $CATALINA_HOME/conf folder.
(In case of Tomcat only Atomic <Resource> will exist).
*Login to the WebSphere Administration Console from the left side menu.
*Navigate to Resources >JDBC >Data Sources. A list of data sources will be populated on the right side.
Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic
data sources need to be modified).
If you are using WebLogic as Web server:
*Login to the WebLogic Administration Console from the left side menu.
*Under Domain Structure list box, expand the appropriate Domain and navigate to Services > JDBC
>Data Sources. A list of data sources will be populated on the right side.
*Select the appropriate Data Source and edit the connection details. (In this case, both Config and Atomic
data sources need to be modified).
Restart the OFSAAI services
Note: If the modified passwords are not updated, OFSAAI logs display the message ORA-28000:
the account is locked.
Does the upload of Business Data model depend on Java Memory?
Business data model upload through OFSAAI depends on the Java memory settings on the client and
server machines. Java memory setting varies with the data model size and the available RAM. Contact
Oracle Support Services for more details.
Why do the Business Metadata Management screens (Business Processors screen) in User
Interface, takes longer time to load than other screens?
The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is continuously being
updated/refreshed to cache metadata. This can be observed when you are starting startofsaai.sh
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and if any of the log file (Ex: SMSService.log) in DynamicServices.xml is being continuously refreshed for
longer time.
By default, the Metadata Log file cache size is set to 1000. If in case the log is being updated beyond this
limit, retrospectively the preceding entries are overwritten. For example, the 1001th entry is overwritten by
deleting the first entry. This results in the application screen taking a longer time to load.
Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, depending on the
currently logged count for the specific metadata.
1. Generate the Log report by executing the following query in config schema.
select count(1), t.metadata_name, m.dsn_id
from metadata_master m, metadata_type_master t
where m.metadata_type = t.metadata_type
group by t.metadata_name, m.dsn_id
2. The above query returns a list of codes with their respective metadata count. You can refer to
"metadata_type_master" table to identify the metadata name.
3. View the log report to identify the metadata which is being updated/refreshed beyond the
specified cache size limit. Accordingly increase the cache size limit in Dynamicservices.xml
depending on the currently logged count for the specific metadata.
For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total measure reported in log
is 1022, increase the limit to 2000 (approximately).
4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.
What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere application
server?
The Java memory needs to be increased in ejbdeploy.sh file which is present under <WebSphere
Install directory>/AppServer/deploytool/itp. For example,
$JAVA_CMD \
-Xbootclasspath/a:$ejbd_bootpath \
Xms256m -Xmx1024m \
What configurations should I ensure if my data model size is greater than 2GB?
In order to upload data model of size greater than 2GB in OFSAAI Data Model Management -> Data
Model Maintenance-> Import Model, you need to configure the required model size in struts.xml file
available in the path $FIC_WEB_HOME/webroot/WEB-INF/classes.
Note:
The size requirements have to be always specified in bytes.
For example, if you need to configure for model size of 2.5GB, then you can approximately set the max
size to 3GB (3221225472 bytes) as indicated below, in order to avoid size constraints during model
upload.
<constant name="struts.multipart.maxSize" value="3221225472"/>
After configuring struts.xml file, generate the application EAR/WAR file and redeploy the application onto
your configured web application server. For more information on generating and deploying EAR / WAR
file, refer Appendix C.
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What should I do if my Hierarchy filter is not reflecting correctly after I make changes to the
underlying Hierarchy?
In some cases, the Hierarchy Filters do not save the edits correctly if the underlying Hierarchy has been
changed. This can occur in hierarchy maintenance, where you have moved a member to another
hierarchy branch, and that member was explicitly selected in the Filter and is now a child of a node which
is already selected in the Filter.
Refer to Support Note for the workaround.
How do you turn off unused information domains (infodoms) from cache?
Follow these steps to turn off unused infodoms from cache:
Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.
1. In the DynamicServices.xml file, identify the section for <Service code="20">.
2. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).
3. Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the
application onto your configured web application server. For more information on generating and
deploying EAR / WAR file, see Configuring Web Application Servers.
4. Restart the OFSAAI Services (APP and WEB). For more information, see Appendix D.
Note: This setting will cache the Infodom metadata only for the infodoms that get
accessed upon user login. Infodoms which do not get accessed, will not be cached.
Sample code is pasted follows:
<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>
<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />
<PARAMETER NAME="BACKUP_XML" VALUE="1" />
<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />
<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />
<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />
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<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />
<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />
</PARAMETERS>
</SERVICE>
Can I install an Application Pack on an existing Atomic schema/ Information Domain created
manually?
No, you cannot install an Application Pack on existing Atomic schema/Information Domain created
manually. Application Packs can be installed only on Atomic Schemas/Information Domain created using
schema creator utility and/ or the Application Pack installer.
What should I do if I get the following exception while trying to view the model outputs in Model
Outputs screen, "Exception ->Local Path/STAGE/Output file name (No such file or directory)"?
Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" in the web server
details screen. This folder needs to be created under the local path on every node ,in case of web
application server clustering.
What should I do if I get the following exception during OFSAA services startup, "Exception in
thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)"?
Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to point to a physical
JRE installed.
What is the optimized memory settings required for "New" model upload?
The following table lists the optimized memory settings required for "New" model upload.
Upload Options

Size of Data Model
XML File

X_ARGS_APP ENV
Variable in OFSAAI
APP Layer

Pick from Server

106 MB

"-Xms1024m Xmx1024m

36 MB

"-Xms2048m Xmx2048m

815 MB

"-Xms4096m Xmx4096m

1243 MB

"-Xms6144m Xmx6144m

106 MB

"-Xms1024m Xmx1024m"Xms2048m Xmx2048m

336 MB

"-Xms4096m Xmx4096m

815 MB

"-Xms4096m Xmx4096m

Model Upload Utility
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Save New Erwin File In
Server

1243 MB

"-Xms6144m Xmx6144m

106 MB

"-Xms1024m Xmx1024m

336 MB

"-Xms2048m Xmx2048m
"-Xms4096m Xmx4096m
"-Xms6144m Xmx6144m

What is the resolution if I get the error - ORA 01792 maximum number of columns in a table or
view is 1000 during T2T execution?
You should apply the following patch set from Oracle. Applicable only for 12c.
https://support.oracle.com/epmos/faces/DocumentDisplay?id=1937782.1
I did not enable OFS Inline Processing Engine Application license during the installation.
However, I have enabled it post installation, using the Manage OFSAA Product License(s) in the
Admin UI. Are there any other additional configurations that I need to do?
Yes. Follow the instructions explained in the OFS Inline Processing Engine Configuration Guide available
on OTN.
I get an error when I try to build an Oracle OLAP cube. What should I do?
Execute the following grant on the appropriate ATOMIC schema
grant olap_user to &database_username
How do you turn off unused Information Domains (Infodoms) from caching?
Follow these steps to turn off unused infodoms from caching:
1.
2.
3.
4.

Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.
In the DynamicServices.xml file, identify the section for <Service code="20">.
Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1).
Repeat the same in the WEB layer too. Generate the application EAR/WAR file and redeploy the
application onto your configured web application server. For more information on generating and
deploying EAR / WAR file, refer Appendix C.
5. Restart the OFSAAI Services (APP and WEB). For more information, refer to the Start OFSAA
Infrastructure Services section.
Note:
This setting will cache the Infodom metadata only for the infodoms that get accessed upon user
login. Infodoms which do not get accessed, will not be cached.
Sample code is pasted follows:
<SERVICE CODE="20"
CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD"
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SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10">
<PARAMETERS>
<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" />
<PARAMETER NAME="BACKUP_XML" VALUE="1" />
<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" />
<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" />
<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" />
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" />
<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" />
<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" />
<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" />
</PARAMETERS>
</SERVICE>
"While creating an Excel Mapping, after specifying the excel worksheet, the target table, and
mapping each column in the worksheet to a target table, I click Save and nothing happens. But
when I click Cancel, a message pops up informing me that all changes will be discarded", what is
to be done?
Check if the version of Internet Explorer 8 with JRE 1.4 Plug-in is enabled on machine. If so, upgrade the
JRE plug in to 1.7+.
Can multiple OFSAA Infrastructure instances share the same Config Schema?
No, only one OFSAA environment can be installed using one Config Schema.
Can Atomic schema be shared?
Yes, it can be shared between two OFSAA instances.
While setting a firewall, which ports should be opened for communication between the Web
Server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the Web Application
Server (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate properly?
The OFSAA Servlet port which is same as Web server port should be open. Also the web application port
should be open.
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Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database where older
versions of OFSAA is Installed?
Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not intending to use
multi language support.
Can I install already installed application in a different infodom?
No, it is not possible to install the same application in two different infodoms.
How can I configure the OFSAA application for High Availability?
OFSAA can have active-passive high availability. For more details, refer Configuration for High
Availability- Best Practices Guide.
I want to configure OFSAA for High Availability that is weblogic cluster on which OFSAA.ear is
deployed and cluster OFSAAI processes (such as Reveleus etc) are running. Is this a supported
configuration?
High Availability is available for WebLogic cluster and DB level as active-active, but is not available on the
application side. OFSAA can have active-passive high availability. For more details, refer Configuring
OFSAA in Clustered Environment Guide.
During OFSAA installation should I provide web application server's IP /Hostname and port or
web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP
Server are configured?
In case the web server is configured, you should enter the Web Server IP Address/Hostname and Port
details during OFSAA installation. Here the Servlet port should be same as the Web Server port.
If Web Server is not configured, the Web Application Server's IP Address/ Hostname and Port is required
during the installation process. Here the Servlet port should be same as the Web application Server port.
Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher versions?
No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. There is a change in the
way agentservers are managed through AGENTSTARTUP.SH & AGENTSHUTDOWN.SH.
What should I do when the message server process does not open and I get the following error
message, "CI18NProvider::CI18NProvider, Error, unable to connect to the config database"?
This error is displayed due to the following reasons:




The Config Schema password is already expired.
If the Config Schema password is going to expire soon and the message like "ORA-28002: the
password will expire within 6 days" displays while connecting to config schema through SQLPlus.
The Config Schema password is modified.

To resolve the error, re-set the Config Schema password to the old password. Else, if the Config Schema
password is modified to something else then follow these steps:
1. Delete the $FIC_HOME/conf/Reveleus.SEC file.
2. Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin
./stopofsaai.sh
3. Shutdown the OFSAAI App service: cd $FIC_APP_HOME/common/FICServer/bin
./stopofsaai.sh
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4. Start the Infrastructure Server in foreground directly on the server or through XWindows
software using the command: ./startofsaai.sh
5. Enter System Password.
6. Enter the new Config schema password. The service starts and initializes if it is able to
successfully connect to the DB and generates the Reveleus.SEC file.
7. Post successful startup of the service, if required, the Infrastructure server may be shut down
and restarted in the background using nohup mode.
What is the mechanism of Log File sizing and backup?
OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs &
<OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in RevLog4jConfig.xml.
The default size of the log files (MaxFileSize) is set to 5000kb and number of max backup log files
(MaxBackupIndex) retained is set to 5, both of which are configurable. Increasing these parameters to a
higher value should depend on the server Hardware configurations and may reduce the performance.
To configure the Logs file size on OFSAA Application server, follow these steps:
1. Navigate to $FIC_HOME/conf where OFSAA is installed.
2. Edit the following parameters in the file RevLog4jConfig.xml




param name="file" : Enter the path where the Logs are to be generated.
param name="MaxFileSize" : Provide the required file size.
param name="MaxBackupIndex" : Provide the required number of backup files to be created.

Example:
<appender name="REVSERVERAPPENDER"
class="org.apache.log4j.RollingFileAppender">
<param name="file"
value="$FIC_HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>
<param name="Append" value="true" />
<param name="MaxFileSize" value="5000kb" />
<param name="MaxBackupIndex" value="5" />
<layout class="org.apache.log4j.PatternLayout">
<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>
</layout>
</appender>
To configure the Deployed area logs file, follow these steps:
1. Navigate to <EAR/WAR Deploy area>/conf folder.
2. Repeat step 2 from the above section.
Can we modify the Log file path?
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Yes, Log file path is configurable, it can be configured in RevLog4jConfig.xml file. The default log file path
(file) is set by the installer . This can be configured to another path.
Can I point the environment with HTTP enabled to HTTPS after installation and vice versa?
Follow these steps:
1. Create SSL related certificates and import to respective servers.
2. Enable SSL on a desired Port ( example 9443 ) on your existing and already deployed web
application servers.
3. Replace the protocol as https and new ssl port (FIC_SERVLET_PORT) configured and in all
the URLs specified on following files:











$FIC_HOME/ficapp/common/FICServer/conf/FICWeb.cfg and
$FIC_HOME/ficweb/webroot/conf/FICWeb.cfg
$FIC_HOME/ficapp/icc/conf/WSMREService.properties
$FIC_HOME/ficweb/webroot/conf/ModelExecution.properties
$FIC_HOME/ficdb/conf/MDBPublishExecution.properties
$FIC_HOME/ficdb/conf/ObjAppMap.properties
$FIC_HOME/utility/Migration/conf/WSMigration.properties
$FIC_HOME/utility/WSExecution/conf/WSExecution.properties
$FIC_HOME/EXEWebService/WebSphere/ROOT/WEBINF/wsdl/EXEWebServiceImpl.wsdl
$FIC_HOME/EXEWebService/Tomcat/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl
$FIC_HOME/EXEWebService/weblogic/ROOT/WEB-INF/wsdl/EXEWebServiceImpl.wsdl

4. Replace XML attribute/Node values as specified on following files:




$FIC_HOME/ficweb/webroot/WEB-INF/web.xml
FIC_WEBSERVER_PORT=9443
FIC_WEBPROTOCOL=https

$FIC_HOME/conf/LookUpServices.xml and
$FIC_HOME/ficweb/webroot/conf/LookUpServices.xml
PORT="9443" PROTOCOL="https:"
5. Login to config schema and execute following SQL command to replace protocol and SSL port.
SQL> update configuration cn set cn.paramvalue='9443' where
cn.paramname='SERVLET_ENGINE_PORT';
SQL> update configuration cn set
cn.paramvalue=replace(cn.paramvalue,'http:','https:') where
cn.paramname='FormsManagerCacheReload';
SQL> update web_server_info ws set
ws.servletport='9443',ws.servletprotocol='https';
6. Create EAR/WAR file and Re-Deploy.
What should I do if the sliced data model upload takes a long time to complete?

245

If the metadata cache size is set to a lower value than the actual count of each metadata type ( hierarchy,
dataset, dimension etc), then it gets into performance degrade issues. We have to increase the cache
size for each metadata type according to the count in the environment.
Following are the parameters in DynamicServices.xml to be configured depends on the metadata count in
your environment.
<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/>
<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/>
<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="3000"/>
<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/>
<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000"/>
<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000"/>
Metadata count can be derived based on the following queries:
select count(1) from metadata_master where metadata_version=0 --- for all metadata
select count(1) from metadata_master where metadata_version=0 and metadata_type=1 --- for
measure
select count(1) from metadata_master where metadata_version=0 and metadata_type=2 --- for
Dimension
select count(1) from metadata_master where metadata_version=0 and metadata_type=3 --- for
HCY
select count(1) from metadata_master where metadata_version=0 and metadata_type=4 --- for
DATASET
select count(1) from metadata_master where metadata_version=0 and metadata_type=59 --- for
BP's
select count(1) from metadata_master where metadata_version=0 and metadata_type=54 --- for
Alias
select count(1) from metadata_master where metadata_version=0 and metadata_type=5 --- for
CUBES
select count(1) from metadata_master where metadata_version=0 and metadata_type=856 --- for
Derived Entity
For LDAP authentication , which server connects with the LDAP server, the Application server
(where ofsaai is installed), or Web Application server (where EAR is deployed)?
For LDAP authentication, the Application server (ficapp) connects with the LDAP server.
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The LDAP server in the setup listens on secure protocol ldaps ( port 636). I have the root
certificate of the LDAP server for SSL, and would like to know where to offload this certificate?
You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp layer.
How to relocate FTPSHARE folder?
You can run the PortC.jar utility. For more details, refer Changing IP/ Hostname, Ports, Deployed Paths of
the OFSAA Instance section in the OFSAAI Admin Guide available on OTN.
How do we identify the list of ports that are used by/configured in an OFSAA environment?
1. Navigate to $FIC_HOME folder on Target.
2. Run the PortC.jar utility using the command:
java -jarPortC.jar DMP
A file with the name DefaultPorts.properties will be created under $FIC_HOME directory which will
contain the ports. For more information, refer Changing IP/ Hostname, Ports, Deployed Paths of the
OFSAA Instance section in the OFSAAI Admin Guide available on OTN.
Note: This feature is available only after applying 7.3.5.2.0 Minor Release patch.
What should I do if I get the following error message, "Error while fetching open cursor value
Status : FAIL"?
This error occurs while executing envCheck.sh because the user does not have access to
V$parameter. This error does not occur due to sysdba or non sysdba privileges provided they have
access/grants to V$parameter.
What should I do if I get the following error message when I try to start the OLAP server:
./olapdataserver: error while loading shared libraries: libessapinu.so:
cannot open shared object file: No such file or directory
FATAL ERROR :- OLAP DATA SERVER start up failed.
This error occurs when OLAP component is not configured and OLAP feature in OFSAA is not used.
However, this error can be ignored.

24.1.2 Application Pack 8.0.0.0.0 FAQs
What is an Application pack?
An Application Pack is suite of products. For more information, refer About Oracle Financial Services
Advanced Analytical Applications (OFSAA) Application Packs.
Can I get a standalone installer for OFSAAI 8.0?
No. AAI is part of every application pack and installs automatically.
How does OFSAA 8.0 Application pack relate to OFSAA 7.x series?
8.0 is a new major release consolidating all products from OFSAA product suite.
Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Application Pack?
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There is no upgrade path available. However, we will have migration kit / path for every product to 8.0
application pack. Further details will be available with Oracle Support.
Does OFSAA 8.0 Application pack UPGRADE automatically to existing environments?
No. OFSAA 8.0 application pack has to be installed in an new environment and subsequently migration
path / migration kit needs to be run to migrate from 7.x to 8.0. Please note we will have migration path
only from the previously released version of OFSAA products.
Where can I download OFSAA 8.0 Application Pack?
You can download the OFSAAI 8.0 Application Pack from Oracle Software Delivery Cloud (OSDC).
What are the minimum system and software requirements for OFSAA 8.0 Application Pack?
Refer installation guide section Hardware and Software Requirements section.
Is my environment compatible with OFSAA 8.0 Application Pack?
Environment Check utility performs the task. It is part of install and can also be run separately.
Does OFSAA 8.0 Application Pack is support all Operating systems?
LINUX, AIX, SOLARIS 10, 11. Refer to Technology Matrix for the technology matrix that OFSAA suite
products are/ will be qualified on.
How can I install OFSAA 8.0 Application Pack?
Refer to Oracle Financial Services Advanced Analytical Infrastructure Installation and Configuration
Guide published in OTN for the application pack installers.
Does this installation require any Third party Software's?
Oracle Financial Services Advanced Analytical Infrastructure Installation And Configuration Guide
published in OTN lists the third party software that needs to be installed.
What languages are supported during OFSAA 8.0 Application Pack installation?
US English is the language supported.
What mode of installations OFSAA Application Pack supports? [that is, Silent or GUI]
OFSAA Application Packs supports both, GUI and Silent Mode.
Does OFSAA 8.0 Application Pack support Multi tier Installations?
OFSAA 8.0 does single tier installation. For more information refer to OFSAAI FAQs section.
Does this Application Pack validate all prerequisites required for this installation like, Memory,
Disk Space and so on
Yes. The prerequisite checks are done by the respective application pack installer.
What happens if it aborts during installation of any application/product with-in an Application
pack?
You must restore the system and retrigger the installation.
Does this Application pack 'Rolls Back' if any of application installation fails due to errors?
Rollback of installation is not supported.
Does the Application pack installs all applications bundled?
All application pack file system files are installed but there is an option to enable the licensed products.
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How can I re-install any of the Application Pack?
You can retrigger in case of failure.
Does Application pack allow enabling / disabling any of the applications installed?
Yes. You can enable; but you cannot disable once the product is enabled in an environment.
I have installed one application in a Application pack and can I install any of new applications
within the Application pack later point of time?
No, installation of additional applications is not required. If you wish to add an application later, you can
enable the application at that time.
How many OFSAA Infrastructures can be installed in a single server?
There is no issue in installing separate OFSAAI installations, each with their own PFT/FTP installations
and separate associated database instances and separate Web Server installations on the same server
as long as adequate memory is allocated for each instance and as long as each OFSAAI installation is
installed using a separate UNIX user and profile. Care should be taken if running multiple OFSAAI
installations on a single server. Adequate memory will be required for each installation as several
OFSAAI processes (model upload, DEFQ services, etc) take significant amounts of memory. So it
depends on your server memory.
Is it possible to install OFSAA 8.0 Application pack on any one of the existing 'Infodom' where
another OFSAA 8.0 application is installed?
Yes. However, the Behavioral Detection Application Pack, and Compliance Regulatory Reporting
Application Pack are the exceptions. They need to be installed in a different Infodom.
Can I select an Infodom for Application pack during installation?
Yes. You can select or change the required infodom.
Can I install all Application Packs in a 'Single Infodom'?
Yes. But Behavioral Detection Application Pack and Compliance Regulatory Reporting Application Pack
are the exceptions. They need to be installed in a different Infodom.
Is it possible to install applications on different Infodom within the Application pack? (That is if
you want to install LRM & MR in two infodoms)
Applications within application pack have to be installed in the same information domain in the same
environment.
How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.1.0.0?
You can install only one infodom during installation. But after installation, you can create multiple
infodoms.
Does 'Data Model' bundled is Application pack Specific or Specific to individual application?
A merged data model for all applications within the application pack is bundled and uploaded.
Is it possible to install OFS Enterprise Modeling in later point of time?
OFS Enterprise Modeling is a separate product and can be enabled as an option later from any
application pack that bundles Enterprise Modeling.
Does Application pack create sandbox automatically for the required applications?
Yes, Sandbox creation is part of application install process.
Are upgrade Kits available for individual applications or the complete Application Pack?
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Maintenance Level (ML) Release / Minor Release upgrades are available across all applications.
Can I upgrade AAI only?
Yes, you can upgrade AAI alone.
Can I upgrade one application within the Application Pack? (For example, I want to upgrade LRM
in the Treasury Application pack, but not MR.)
No. Not possible Upgrade is applied across packs.
Is it possible to uninstall any Application from the Application pack?
No, it is not possible to uninstall any Application from the Application Pack.
Can I uninstall entire Application Pack?
No, you cannot uninstall the Application Pack.
Is it possible to uninstall only application and retain AAI in the installed environment?
No, you cannot uninstall only the application and retain AAI in the installed environment.
Can I uninstall entire Application Pack?
No, you cannot uninstall the Application Pack.
Is it possible to uninstall only application and retain AAI in the installed environment?
No, you cannot uninstall only the application and retain AAI in the installed environment.
Does Application Pack contain all Language Packs supported?
Language Packs need to be installed on 8.0 application packs.
Can I install an Application Pack over another Application Pack (that is same infodom or different
infodom)?
Yes, you can install an Application Pack over another Application Pack in the same information domain or
different information domain. But Behavioral Detection Application Pack and Compliance Regulatory
Reporting Application Pack, Asset Liability Management Application Pack and Profitability Application
Pack are the exceptions. They need to be installed in a different INFODOM.
Can I use an existing manually created schema as information domain for application pack
installation?
No. Schemas required by OFSAA applications have to be created using Schema Creator Utility.
Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?
Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 supports oracle 12c
with some additional configurations. Refer the link
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional
configurations.
What should I do if I get the following error message while running the schema creator utility,
"HostName in input xml is not matching with the local hostname"?
One possible reason could be the machine is configured for zonal partitioning. Ensure all the known IP
Addresses of the machine are present in the /etc/hosts file.
What are the Java versions supported in OFS ALM Application Pack version 8.0.0.0.0?
OFS ALM Application Pack supports 1.7.x and 1.8.x.

250

What is the required disk space for ALM Application Pack installation?
The required free disk space for ALM installation is Current disk space of $FIC_HOME + Installer size.

Is this release of the OFS ALM Application Pack version 8.0.0.0.0 supported on Java 8?
Yes. To install this release of the OFS ALM Application Pack version 8.0.0.0.0 on Java 8. For more
information, refer to specific notes mentioned in the sections Installer and Installation Prerequisites
Configurations supported for Java 8. Configuring the Schema Creator Utility, GUI Mode Installation,
SILENT Mode Installation.
What should I do if I get following error during schema creation in ALM 8.0.0.0.0 installation on
OEL7.
UPPER(TABLE_NAME) = 'DBA_USERS' and UPPER(PRIVILEGE) = 'SELECT'
[SCHEMAUTILITY] [ INFO] - Connection URL successfully validated...
[SCHEMAUTILITY] [DEBUG] - Executing ...SELECT VALUE FROM v$option WHERE parameter =
'Partitioning'
[SCHEMAUTILITY] [ERROR] - Error while validating host name 10.184.157.139
[SCHEMAUTILITY] [ERROR] java.net.UnknownHostException: online: Name or service not known
Modify the following line from osc.sh
machineIP=`/sbin/ifconfig | grep "inet addr"|head -1|tr -s '\t' ' '|cut -d ' ' -f3|cut -d ':' -f2`
to
machineIP=`/sbin/ifconfig | grep "inet"|head -1|tr -s '\t' ' '|cut -d ' ' -f3|cut -d ':' -f2`

24.2 Forms Framework FAQs
What should I do when I have large volume of data to be exported?
It is recommended to use BIP reports or OBIEE reports if you have to export large volume of data.
How do I export the columns added to the grid by Field Chooser option?
Perform Grid Export operation to export the columns added to the grid by Field Chooser option.
'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. What should I
do?
Expand All/ Collapse All button is disabled if the number of hierarchy nodes is more than 50 and if it is a
non-custom hierarchy. Hierarchy with more than 50 nodes is considered as large hierarchy and the data
will be fetched dynamically when you expand the parent node.
What is the difference between the two Searches available in the Hierarchy Browser window?
In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 search options
available as highlighted in the following figure:
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DB Search (Top search container): It will search the required node in database and displays the
result as shown below. This search is performed on full hierarchy nodes.



UI search (Below the hierarchy): This search will find the required node in the UI and will show in
tree structure.

Note:
In case hierarchy nodes are more than 50 and if it is a non-custom hierarchy, then the UI search will not
show the required node in tree structure, until all the nodes are expanded and loaded manually in the UI.
What is a Custom Hierarchy?
Custom hierarchies will be having the parameter configuration customQuery as shown below and the
customized query will be taken from the HIERARCHY_FILTER_MASTER table.
Configuration in xml:
<CONTROL ID="1003" TYPE="41">
<CONTROLPROPS>
<EXTRAPARAMETERS>
<PARAMETER NAME="customQuery" VALUE="Yes"/>

252

</EXTRAPARAMETERS>
</CONTROLPROPS>
</CONTROL>
For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit.
So, even if the hierarchy nodes are more than 50, the UI search will show the required node in tree
structure and ExpandAll and ExpandBranch images will be enabled.

24.3 Error Dictionary
This contents of this section has been created with the interest to help you resolve the installation issues
if any. There is a compilation of all the possible errors that might arise during the installation process with
the possible cause and the resolution to quickly fix the issue and proceed further with the installation.
This section includes the following topics:


Accessing Error Dictionary



Error Code Dictionary

24.3.1 Accessing Error Dictionary
Instead of scrolling through the document to find the error code, you can use the pdf search functionality.
In the "Find" dialog available in any of the Adobe Acrobat version that you are using to view the pdf
document, follow these instructions to quickly find the error resolution.
1.
2.
3.
4.

With the Installation pdf open, press Ctrl+F or select Edit > Find.
The Find dialog is displayed as indicated.
Enter the error code that is displayed on screen during Infrastructure installation.
Press Enter. The search results are displayed and highlighted as indicated below.

View the details of the issues, its cause, and resolution specific to the error code. Repeat the step to find
an answer to any other errors that you notice during installation. If you are not able to resolve the issue
even after following the steps provided in resolution, you can contact support.oracle.com along with log
files and appropriate screen shots.

24.3.2 Error Code Dictionary
Error code - OFSAAI-1001
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Cause

Unix shell is not "korn" shell.

Resolution

Change the shell type to "korn". Use chsh unix command to
change SHELL type.
Shell type can also be changed by specifying shell path for
the Unix user in /etc/passwd file.
Note: chsh command is not available in Solaris OS.

Error code - OFSAAI-1002
Cause

No proper arguments are available.

Resolution

Provide proper arguments. Invoke Setup.sh using either
SILENT or GUI mode.
Example: ./Setup.sh SILENT or ./Setup.sh GUI

Error code - OFSAAI-1004
Cause

File .profile is not present in $HOME.

Resolution

Create .profile in $HOME, i.e. in the home directory of user.

Error code - OFSAAI-1005
Cause

File OFSAAInfrastructure.bin is not present in current folder.

Resolution

Copy OFSAAInfrastructure.bin into installation kit directory.

Error code - OFSAAI-1006
Cause

File CustReg.DAT is not present in current folder.

Resolution

Copy CustReg.DAT into installation kit directory

Error code - OFSAAI-1007
Cause

File OFSAAI_InstallConfig.xml is not present in current
folder.

Resolution

Copy OFSAAI_InstallConfig.xml into installation kit directory.

5 Error code - OFSAAI-1008
Cause

File validateXMLInputs.jar is not present in current folder.

Resolution

Copy validateXMLInputs.jar into installation kit directory.
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Error code - OFSAAI-1009
Cause

File log4j.xml is not present in current folder.

Resolution

Copy log4j.xml into installation kit directory.

Error code - OFSAAI-1010
Cause

Unknown error occurred.

Resolution

Make sure to provide proper argument (SILENT or GUI) to
the Setup.sh file.

Error code - OFSAAI-1011
Cause

XML validation failed.

Resolution

Check InfrastructurePreValidations.Log for more details.

Error code - OFSAAI-1012
Cause

Property file with locale name does not exist.

Resolution

Copy MyResources_en_US.properties to the setup kit
directory and keep en_US in LOCALE tag of
OFSAAI_InstallConfig.xml.

Error code - OFSAAI-1013
Cause

File
OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml not
found.

Resolution

Copy
OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml to
the setup kit directory.

Error code - OFSAAI-1014
Cause

XML node value is blank.

Resolution

Make sure all node values except SMTPSERVER,
PROXYHOST, PROXYPORT, PROXYUSERNAME,
PROXYPASSWORD, NONPROXYHOST, or RAC_URL are
not blank.

Error code - OFSAAI-1015
Cause

XML is not well formed.
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Resolution

Execute the command dos2unix OFSAAI_InstallConfig.xml
to convert plain text file from DOS/MAC format to UNIX
format.
OR
Make sure that OFSAAI_InstallConfig.xml is valid. Try to
open the file through Internet Explorer for a quick way to
check validity. If it is not getting opened, create new
OFSAAI_InstallConfig.xml using the XML_Utility.jar.

Error code - OFSAAI-1016
Cause

User installation directory contain blank spaces.

Resolution

Provide an installation path that does not contain spaces.
Check the tag USER_INSTALL_DIR in
OFSAAI_InstallConfig.xml file. This path should not contain
any spaces.

Error code - OFSAAI-1017
Cause

User installation directory is invalid.

Resolution

Provide a valid installation path. Check if you are able to
create the directory mentioned in USER_INSTALL_DIR tag
value of OFSAAI_InstallConfig.xml file.
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